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It’s annoying, offensive and expensive, apart from being a complete waste
of bandwidth. Yes, we all hate spam and wish that someone would do some-
thing to prevent spammers from clogging our mailboxes. 

But the sad truth is that there are no clear-cut laws for regulating unsolicit-
ed bulk e-mail. Plus the economics of spamming are just too good to ignore:
sending out vast amounts of e-mail is very cheap and even a small per cent of
replies are enough for the spammers to make money. With entry barriers being
so low and potential profits so enticing, the problem of spam is likely to get
worse before it improves. 

Experts predict that in the next few years, we’ll all receive upwards of 10 junk
e-mails a day. That’s probably more than the official e-mails that most of us send
or receive on any given day.

So who is to blame for this mess?
We are. We’ve dug this hole ourselves and now are living with the conse-

quences.
The Internet is a revolutionary communication tool that allows us to keep

in touch with anyone who is connected to it. But as with all technological
advancements, it also has the potential to be exploited. 

We’ve been taught right from our childhood to never talk to strangers and
to be very careful while giving away personal information. Surely none of us
roam the city streets wearing a T-shit claiming: “Hi I’m Joe Simpleton. This is
where I live and you can call me anytime on this number.” But for no apparent
reason, this common sense wisdom deserts us when we’re online.

Sure, for some of us, it might be a job requirement to make available our 
e-mail addresses on company Web sites and other open forums. Unfortunately
for these poor souls, there’s no path to redemption other than to simply shrug
off spam as a necessary evil. 

But for the rest of us, it’s simply a matter of making a small shift in our
online habits—that we will not make available our e-mail address to any and
every person or Web site that asks for it. 

The real challenge however is to find a permanent solution for this wide-
spread digital epidemic of the 21st century. 

Our best hope to eradicate spam is to, well, simply ignore it. Yes, that’s right.
Spam wouldn’t exist if it wasn’t so successful. 

Because all it takes is one sucker in every 10,000 junk e-mails sent out to
make a spam operation worthwhile. 

vinit_aggarwal@jasubhai.com

“With entry
barriers being so
low and potential
profits so enticing,
the problem of
spam is likely to
get worse before
it improves”

Simply hit delete!

Vinit Aggarwal
Assistant Editor
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■ ASUS V8170 magic
GeForce4MX 440
■ ASUS V8420  Deluxe

GeForce4 Ti4200
■ ASUS V8420 GeForce4

Ti4200
■ ASUS V9180 Magic

GeForce4MX 440-8X
■ ASUS V9180TD

GeForce4MX 440-8X
■ ASUS V9280 GeForce4

Ti4200
■ ASUS V9280S GeForce4

Ti4200
■ COMPRO VideoMate

Cinema
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GeForce4 Ti4200
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Ti4800se
■ Hercules 3D PROPHET
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■ XSERVE RADEON 9700

128M
Gamepads  . . . . . . . . . .56
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Audacity
Size: 1.55  MB      Type: Free
Mindware\Software\Multimedia

Black Hawk Down 
Size:  124 MB  Type: Trial 
Playware\Arena\Games

Chain Reaction
Size: 3.75  MB     Type: Trial 
Playware \Arena\Funzone\ 

Eudora 5.2
Size 6.13 MB      Type: Free
Mindware\Software\Internet

Isobuster 1.2
Size: 2.20  MB      Type: Free
Mindware\Software\Multimedia

MySQL 3.23
Size:  13.3  MB      Type: Free
Mindware\Software\Developer Tools

NATATA eBook Compiler
Size: 1.23 MB      Type: Free
Mindware\Software\Home

PGP 8.0
Size:   8.44  MB      Type: Free
Mindware\Software\System

Praetorians
Size: 73.8 MB   Type: Trial 
Playware\Arena\Games 

SequoiaView 1.3
Size: .553  MB      Type: Free
Mindware\Software\System

VirtualDub 1.4.11
Size: .748 MB      Type: Free
Mindware\Software\Multimedia

HIGHLIGHTS

BloodRayne
BloodRayne introduces the sexy, supernat-
ural agent BloodRayne. An unholy union
of human and vampire gave rise to the
Dhamphir and agent BloodRayne was
raised and trained by a secret governmen-
tal agency to
hunt down
and eliminate
global evil
forces. Now
she must take
on an occult
faction of pre-Nazis and their army of vile,
unearthly ghouls to prevent them from
unleashing creatures of unfathomable ter-
ror onto the world. Agent BloodRayne’s
lethal repertoire includes inhuman
strength, spectacular leaping and acrobatic
skills, night vision, zoom vision and slow-
motion perception that enables her to
weave in and out of bullets. 
Size: 168 MB, Type: Trial
Playware\Arena\Games

OpenOffice.org 1.0.2
OpenOffice.org is a free, high-quality office
suite. The product is a multi-platform
office productivity suite, which can hold
its own against any commercial product.
It includes the key desktop applications,
such as a word processor, spreadsheet, pres-
entation manager, and drawing program,
and has a user interface and feature set that
makes it very similar to other office suites.

Sophisticated and flexible, OpenOffice.org
also works
transparently
with a variety
of file formats,
including those
of Microsoft
Office. Users of
other office suites should find it easy to
work with OpenOffice.org.
Size: 49.6   MB, Type: Free
Mindware\Software\Office

Opera 7
Opera is a fast, user-friendly, versatile
Internet/intranet browser that also
includes a newsreader. You can run mul-
tiple windows
even at start-
up, and special
features are
included for users with disabilities.  Opera
also features integrated search and instant
messaging; updated e-mail support;
improvements in memory usage; and
accessibility to different Web sites. 

Opera 7 features a bright blue-and-
white interface and some very slick user
friendly enchancements, that include
recovering from a crashed session and
mouse and keyboard gestures which play
an integral role in surfing which can make
navigating the Web quick and painless.
Size: 12.6 MB , Type Free
Mindware\Software\Internet

ON THE CD

10

The Developer Tools section in your
Digit Mindware CD brings
you tools that you can use
for developing software
applications. The Devel-
oper Tools that we feature
this month are the best
free tools that you can
find that will aid you in
your work. On the Mind-
ware CD this month is the official Java
JDK, v1.41 that you will need to compile

and execute Java programs; JCreator, a
high quality IDE for Java;
Bloodshed Dev-C++, a ver-
satile C/C++ IDE that
comes built in with the
Windows MinGW port of
GCC, the acclaimed  C/C++
compiler as well as several
other tools for other lan-
guages. We also feature the

MySQL RDBMS package, which is a
robust and scaleable RDBMS. 

KNOW YOUR CD

MUST TRY SOFTWARE

MARCH 2003

MINDWARE\SOFTWARE\DEVELOPER TOOLS

India's Premier Software Provider
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Want to subscribe to Digit? Or is it 
time to renew your subscription? You
can now subscribe online! 

One For The Road
You don’t need to
get your hands
greasy any more—
the smart
technology that
goes into your
automobile will help

you derive the most from your vehicle, and even
stands by to give you a safer ride. Find out what
today’s power machines have under the hood.

WEB SPECIAL SUBSCRIBE

WEB SPECIAL

taste technology at http://www.thinkdigit.com

BY DEMAND
You get to choose what goes on Digit Interactive. This
month you have chosen 
Merriam Webster’s Concise Dictionary 2.07 (1.57 MB) 
IGI 2: Covert Strike single-player (138 MB)
You voted for these and you can get them next month!

Picture Perfect
PIM, the technology behind
today’s printers can
reproduce images on paper,
just the way you see it when
you shoot that one-in-a-
million scene. Find out how
you get to see on paper what you see in the 
viewfinder—photographic prints that are clear, bright, 
crisp and real to life.

MARCH 2003
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The Internet is being used for
what some now dub as

‘cyberbegging’. This trend is
catching on abroad with
struggling single moth-
ers and recent college
graduates who
are saddled
with unpaid
credit card
bills and stu-
dent loans.
While the list of
woes differs from site to site,
they all ask for money via their
home pages.

Christine Kent, for
instance, has featured her cat at
SaveBuster.com. She claims that
her site actually raises money
not for herself or Buster, but for
a San Francisco non-profit
organisation that helps people
with AIDS and other illnesses
keep their pets.

Observers, though, are
skeptical that this is a genuine
trend and are asking cyber-
surfers to be wary of such sites.

Cyberbegging started gain-
ing momentum late last year
after US-based Karyn Bosnak
asked for money to pay off his
over $20,000 debt.
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SongPro
■ What is it?
The idea of Ronald L. Jones,
this is a Game Boy Advance
(GBA) add-on that looks like
a GBA cartridge. It can be
used to download music that
can be played on the GBA,
and flash digital images of
the CD covers corresponding
to each song.

■ How does it work?
The SongPro fits into the
game cartridge and comes
with a USB link with which it
can be connected to any
Internet-connected PC for
digital music downloads. The
songs, song lyrics and CD
covers, etc, can be down-
loaded from the homepage
at www.songpro.com. It also
comes with music manage-
ment software. It utlises the
GBA’s 3-inch colour screen to
display the digital images. It
comes with a 32 MB Com-
pact Flash card that provides
the required memory for
storage, and earphones.

■ What does it do?
The SongPro turns the Nin-
tendo Game Boy Advance
into an audio player. You can
hear both MP3s and WMAs.
The technology prevents
unauthorised copying of
copyrighted music. Future
models  of the SongPro will
allow downloading and
viewing multimedia files such
as music videos and movie 
trailers. 

hypethesis

■ Microsoft to integrate a bug-catcher plugin with Visual Studio .NET ■ Sixth annual Classic Gaming Expo to be held in Las Vegas, August 9-10

Routers can be ‘selfish’

A16-year-old Irish student,
Osmani, has created a new

Web browser that may be able
to boost browsing times by up
to 600 per cent. The browser
claims to have 120 search
engines, all the major media
players, a DVD player, and an
HTML and WAP editor built in.
It is called the Xwebs Mega
Browser.

Osmani said he has devel-
oped an algorithm that speeds
up the way information is han-
dled inside the browser. The

technique takes advantage of
the features of a particular type
of server used widely on the
Internet. 

The browser handles mul-
tiple requests for information,
he said. So, instead of a single
stream of information, several
streams are processed simulta-
neously. In general, the task of
bringing over a Web page is
divided into a set of smaller
tasks, cutting the time it takes
to reassemble a Web page on
the computer screen. 

Two Cornell University com-
puter scientists have con-

cluded that computer networks
tend to be ‘selfish’ when they
try to route traffic by the fastest
pathway, leading to a congest-
ed and slow pathway.
Researchers constructed a
mathematical analysis of how
routers direct packets and
found that the
average time of
travel could
be increased
by up to
1.33 times
compared
with a reg-
ular system.
Addition of
more interconnec-
tions in the network could
also be counterproductive
because of an effect called
Braess’ paradox, the
researchers said.

According to the paradox,

the packets of information
would simply hop from one
path to another—much like
drivers switching lanes in a
traffic jam—actually slowing
down all the other packets
traveling on those pathways.

To improve how routers
direct traffic, they suggested
that they consider not only

which route is least con-
gested, but also how

sending packets in
that direction
would affect that

path. 
Being more

imaginative,
a router

in some
cases may

end up choosing pathways
that are not necessarily the
fastest for delivering the pack-
ets, but which could still result
in lower average times for all
the transmitted data.

At any given

moment, 4 million

users use KaZaA
to share over 800
million files

Source: CNN

snapshot

➜

New browser to rev up
Internet experience

Now ‘begging’ in
cyberspace too
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Unreal security risk
PivX Solutions has
announced that there are
major flaws in the Unreal
gaming engine, that could
make your game server and
client vulnerable to several
fatal network attacks, includ-
ing local and remote DoS
attacks, execution of mali-
cious code without size limi-
tations, and more. Windows,
Linux and Mac OS are
equally vulnerable and play-
ing a game on these plat-
forms makes the user vulner-
able to attack. Moreover,
since the flaw is in the Unre-
al engine, all the games util-
ising the Unreal core are at
risk. These include Unreal
Tournament, UT 2003, Ameri-
ca’s Army,  Deus Ex and as
yet unreleased games such
as Navy Seals and Hired
Guns. PivX has posted a free
tool that checks for mali-
cious code within a system
(www.pivx.com/luigi/mytoolz/
unrcheck.zip). 

Java and a virus
hoax
Beware of an e-mail virus
hoax that claims the exe-
cutable file, jdbgmgr.exe,
may be present on your
hard drive. If it is, you are
asked to delete it. The file
jdbgmgr.exe is the Microsoft
Debugger Registrar for Java,
and it may or may not be
present on your computer.
Deleting this file may impair
your system’s normal func-
tioning. So delete this e-mail
hoax if you have received it,
and do not open any .exe
attachments that come with
it. If you’ve already deleted
your jdbgmgr.exe file, you
can reinstall it from
www.microsoft.com.

redalert

■ Intel’s Banias notebook chip (Pentium-M) due for release ■ Quake III Arena rumoured to be dropped from final list of World Cyber Games, Korea

Games of today are
considered to be

no-brainers with lots of
shoot-em’ up action
involved. Everything
that moves is shot at
with an arsenal of
weapons which would
even put an army to
shame. But this
thought is in for some
restructuring. 

Studies of players
and teams are showing that
these games are much more
complex and intriguing than
most expectations. Scientific
studies reveal the complex
culture surrounding the
games, as well as some reasons
why people find them appeal-
ing. Professor Talmadge
Wright and colleagues at Loy-
ola University, Chicago, have
spent hours studying Counter-
Strike (a very popular Half-Life
Mod) culture by taking part in
games, interviewing players

and reviewing the text files of
in-game text conversations. 

Wright said the research
shows that Counter-Strike is
much more than gun-toting
gameplay and raking up kills.
He said the strategy and tac-
tics used by many regular
players and teams often
makes it seem like a game of
chess. The importance of 
the social side of Counter-
Strike was revealed in the
constant banter, in-game
jokes and insults that people

exchanged during
play. 

Players tended to
bring their offline cul-
ture with them when
they play, with the
most common emo-
tion being laughter.
The only reason that
people could get away
with insulting friends
and foes was because
they knew them so

well, he said. People could
live their fantasy roles which
otherwise would not be pos-
sible. For this reason, and
others, Wright believes that
gaming is undoubtedly good
for players.

Playing PC games is good for you

statattack

Mobile chips get
broadband-
friendly

Australian researchers
unveiled a chip that lets

cellphone users receive high-
quality face-to-face video and
other streaming media at
rates faster than a home
broadband connection. The
chip, developed by Bell Labs
in Australia, works on a next-
generation cellphone net-
work and can run programs
at up to 24 Megabits per sec-
ond—almost 20 times faster
than a traditional T1 line.

It lets users with wireless
devices on a 3G network con-
duct video teleconferences,
get corporate data, send and
receive multimedia applica-
tions such as MP3 tones,
video clips and slide show
presentations. Analysts say
that the chip could compete
head-on with other WiFi
wireless Internet networks,
which have, of late, become
hugely popular.
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In the mid-1990s, two pro-
grammers, Arlo Rose and

Greg Landweber, launched
an interface revolution with
Kaleidoscope, a tool that
allowed everyone to cus-
tomise the look of their 
computer. It became very
popular since many users
designed their own funky
interfaces  which they shared
freely with others over the
Internet. 

Rose has now teamed up
with engineer Perry Clarke 
to release a new piece of 
software to help people create

little custom applications to
do almost anything they can
think of—from automatically
gathering news headlines 
to ordering items over the
Internet. 

Called Konfabulator, it 
is a JavaScript runtime appli-
cation for Mac OS X that
runs little custom programs
called Widgets. These 
Widgets can be almost any-
thing, from games to system
monitors, stock tickers, utili-
ties or Web services. Konfab-
ulator is extremely slick and
uses Apple’s Quartz render-
ing engine to give the Wid-
gets beautiful, detailed
graphics and silky-smooth
animation.

It is priced at around 
Rs 1,250 and includes a digi-
tal clock, a To Do list, a cal-
endar and an application 
for viewing the current
weather.
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Floppy Drives
The demise of the floppy
drives seems imminent
after Dell announced
that it will stop shipping
them as standard
accessories on high-end
Dimension computers
from next month,
instead offering a 16 MB
portable USB drive as a
replacement.

Cyber Warfare
US President George
Bush has signed secret
orders that authorise the
right to wage cyber
warfare should America
be attacked, and invade
foreign networks to shut
down all essential
services including power
supply and phones.

zeroes

Kon-fabulous Mac tool

In recent weeks, Bernard
Leach, a computer enthusi-

ast has managed to get
Apple’s iPod to run parts
of a version of
Linux—but at the cost
of some of the device’s
key features. He was
able to get Apple’s dig-
ital music player to
run basic parts of the
uClinux version of the
Linux operating sys-
tem. 

H o w e v e r ,
several of iPod’s
key features were
sacrificed in running
Linux. Leach’s Linux-
equipped iPod could play
audio or display simple

graphics, but it could not use
the iPod’s scroll wheel,
remote control, or the

FireWire port—the
iPod’s only means
of exchanging
data with other
devices. And
although the
Linux-equipped
iPod could play
audio, even its
MP3 playback did
not live up to

expectations.
H o w e v e r ,
Leach is very

excited about the whole proj-
ect and has high hopes for a
penguin-powered version of
the iPod.

Running Linux on
iPod?

CPUs mounted on
paper

Ayoung Swedish company
is printing really cheap

chips. The company, Cypak,
has technology to mount a
very small microprocessor,
which it created, on paper (or
inside a credit card), as well as
a technique to print sensors,
switches, and very short-
range antennae on the same
paper, using special conduc-
tive inks. 

Cypak’s CPU is designed
to take input from a variety of
sensors. Cypak’s technology
currently costs a dollar or
more per unit. That’s pretty
cheap for a computer, but still
too expensive for everyday
products.

Gateway connects
gadgets to the 
laptop 

Gateway has launched a
laptop that is bundled

with a memory card reader.
This helps in using several
Flash Memory cards which are
used by MP3 players and digi-
tal cameras. The reader forms a
part of the revamped version
of Gateway 400L model laptop
computer, which includes a
1.8 GHz Intel Celeron Proces-
sor, 256 MB DDR RAM, 30 GB
hard drive and a 15-inch XGA
display panel. 

The laptop is set to sell for
a promotional price of $999
after a $100 rebate. The Mem-
ory Card reader can read sev-
eral popular Memory Card for-
mats such as Memory Stick,
Secure Digital (SD), IBM
Microdrive, Compact Flash,
Multimedia Card Memory and
SmartMedia. Future models
will carry the memory card
reader as an optional $50
upgrade from a floppy drive.

■  Motorola to begin selling its first Linux-powered mobile phones this year ■  Microsoft slashes Xbox game prices ■  Microsoft to release Office 11 beta 

HP: Recycling Ahoy!
Hewlett-Packard has
launched a new program
that will give consumers up
to $50 towards the pur-
chase of new products in
exchange for recycling their
old equipment, from any
manufacturer, through HP’s
recycling service. HP may
either donate or recycle the
old computers.

GNOME and KDE
With the launch of the new
edition of GNOME, Linux
desktop managers GNOME
and KDE are looking at
common specifications to
give increased interoperabil-
ity, thus benefiting Linux
users on the whole, and
encouraging the trend of
Linux desktop adoption by
businesses and govern-
ments.

Worldwide sales 
of PCs will touch
147.5 million 
units in 2003

snapshot

Source: IDC
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The DVD forum just got
better and stronger.

Hitachi, LG Electronics, Mat-
sushita Electric Industrial, Pio-
neer, Royal Philips Electron-
ics, Samsung Electronics,
Sharp, Sony and Thomson
have announced the arrival of
a new format—Blu-ray Disc
technology, a next-generation
recordable DVD format using
blue-violet lasers. Here, data is
read off a blue-violet laser
beam as opposed to red laser
beams used in today’s optical
drives. 

The blue-violet laser beam

has a shorter wavelength than
a red laser beam,
enabling data to be
packed with a
higher density.
This new technol-
ogy enables storage
of 27 GB of data per
layer as opposed to
conventional DVDs
which enable storage
of 4.7 GB of data per
side. It is seen as a large
step towards enabling
the recording of high-defi-
nition television broadcasts
on a DVD platter. 

The licensing agreements
are 10-year renewable

contracts. They will
include the right to
use the Blu-ray for-
mat and logo
along with the
content protec-
tion specifica-
tions. Licenses
for the format

and logo will
range from

around Rs 10 lakh to 
Rs 30 lakh depending on the
products manufacturers
want to develop. The protec-

tion specifications range in
price annually from Rs 2 lakh
to Rs 6 lakh. 

Companies are already
manufacturing products
based on the new technology.
Philips demonstrated a proto-
type Blu-ray disc drive. It uses
a 3 cm disc and stores up to 
1 GB of data. Typical CDs,
measuring 12 cm in diameter,
can hold up to 650 MB of
data. The prototype drive
demonstrated can be used in
portable devices such as digi-
tal cameras, handhelds and
cellphones.

Blu-ray Disc technology gets the go-ahead

AMD has announced the
launch of a new core for

their Athlon processors
named Barton. It features a
total of 640 KB of on-die
cache, up from 384 KB on the
older Thoroughbred core. The
new core features the same
333 MHz front-side bus.
While the size of the L1 cache
on the processor remains
unchanged, the L2 cache has
been upped from the earlier

256 KB to a good 512 KB. 
The 2800+ with the Bar-

ton core runs with a slower
clock speed than the 2800+
with the Thoroughbred core,
thus allowing AMD to keep
the same processor rating
despite the increased cache.
AMD’s rating system is offi-
cially based on the perform-
ance of current processors rel-
ative to AMD’s original
Athlon core, but the numbers

mirror the clock speeds of
competing processors from
Intel. 

The new Barton 2800+
runs at 2.083 GHz, compared
with the older 2800+ clock
speed of 2.25 GHz. The Bar-
ton 3000+ runs at 2.167 GHz.
It is made by a 0.13-micron
process. The increased cache
memory increases the die
size from 84 mm2 to about
101 mm2.

Barton doubles L2 cache, slows
clock speed

Chipmaker Rambus has
readied a technology

called Redwood that lets semi-
conductors exchange data at
very fast rates. It performs the
same functions as other stan-
dards, such as AMD’s Hyper-
Transport. It transfers data at
6.4 GHz. The jump in speed
comes from an innovative cir-
cuit board design. Existing

parallel buses can shift data
rapidly, and they generally
require that the data is syn-
chronised while it travels
from one chip to another. 

This leads to a design
requirement which keeps all
the interconnects between
various chips equal, depend-
ing on how the chips sit on
the circuit board. Redwood

gets around this drawback by
incorporating a technology
called FlexPhase that allows
data to travel asynchronously.
It will be compatible with
chips rigged for various other
input-output standards. The
company will charge fees for
the engineering design servic-
es, from the company imple-
menting Redwood.

For people residing in the far
suburbs of the UK, broad-

band services from Fast Net, a
UK-based company, could soon
be available via electricity lines.
Trials of this technology have
already been run in the small
Scottish towns of Campbeltown
and Crief. They were a huge

boost for the company with
speeds up to 2 MB per second—
faster than most broadband
services on offer in the UK. 

The price for the service
could be very affordable. The
speed and price of the com-
mercial service has yet to be
decided but the firm says it will
be competitive.

Broadband
through your
electric switches

■ US Navy warships to use 802.11b wireless systems ■ NEC demonstrates 50 GFLOPs facial-recognition chip ■ Sony launches all-format DVD-burning Vaio laptops

Rambus develops technology to
make chip connections faster

ILLUSTRATIONS: Farzana Cooper
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In what may be the most
advanced project of its

kind, researchers at Infineron
Technologies (www.infineon.
com) and the Max Planck
Institute (http://www.mpi.nl/
world/index.html) have suc-
ceeded in getting actual com-
munication between live
brain cells and a tiny solid
state semiconductor. 

Here is where the neuro-
logical monitoring of tomor-
row comes in: a tiny 1 square

millimeter chip containing
some 16,364 sensors that
detect the faint pulses given
out by neurons. 

The weak electrical
impulses emitted by neurons
are amplified and transferred
over to a computer for pro-
cessing.  With highly sensitive
sensors in place, neurobiolo-
gists can analyse how associ-
ated groups of neurons or
individual cells respond to
electrical stimulation or spe-

cific substances over a defined
period of time. The tissue and
the chip are dipped into an
electrolytic nutrient fluid that
keeps the cells alive. 

The neuro-chip lets scien-
tists understand the neurobi-
ological and neurochemical
functioning of nerve tissue
over a sustained period of
time. It is mainly used in the
research of cures for diseases
of the brain, such as
Alzheimer’s disease. 

“We still strongly
believe that digital
copyrights should
be protected, but
mandating a tax 
is not the right 
solution”
Chuck Mulloy, spokesman
for Intel, on the recent pro-
posal in Germany that PC
makers pay copyright hold-
ers a ‘copyright tax’ of 
12 Euros for every system
sold to compensate for the
unauthorised copying of
digital movies and other
copyrighted material.

“I had one item on
my agenda: not to
lose. I decided it
would be wiser to
stop playing”
Garry Kasparov, international
chess grandmaster, after he
accepted a draw in a six-
game chess contest against
Deep Junior, the supercom-
puter that won last year’s
world computer chess cham-
pionship. Deep Junior can
process 3 million moves in a
second and chooses strategy
over just capturing pieces.

Acomputer security expert
at A&T Labs in New Jersey,

US, Matt Blaze, has detailed
how to make a master key for
an entire office building or
apartment block using only
one sample key and a simple
process of trial and error. The
applied technique is known as
an ‘oracle attack’. This is used
to quickly shortlist the solu-
tions to a cryptography prob-
lem, when some knowledge of
the key has been
gained. 

The technique
works with pin-
and-tumbler locks
for which a master
key can be designed
to open many differ-
ent doors. This is the
most commonly used
type of lock for large
buildings. An attacker needs
only one sample key, access to
its lock and a bag of blank keys
ready for cutting. Pin-and-tum-
bler locks only open when a
key has elevated all the pins
inside the mechanism to their
correct positions. 

A normal lock with five

pins can have around a million
different pin configurations.
However, locks for which there
is a master key have two sets of
correct pin positions. The first
is unique to each individual
lock; the second works with
the master key and is the same
for every lock. In a document
submitted to the journal IEEE
Security and Privacy, Blaze
shows that it is possible to
work out the master key posi-

tions in a relatively
short amount of
time using the
method of trial and
error. 

Locksmiths say
that they are well
aware of the trick.
But Blaze says he is
the first to set out a
mathematical the-

ory underpinning it in detail.
Even though it is technically
simple and could be used by
criminals, he argues it is nec-
essary to publicise the loop-
hole. Blaze says many profes-
sional security consultants are
unaware of the exploit and
need to be told.

Master key with 
‘oracle attack’

Mind the chip
tomorrow’stechnology

quoteworthy

Dying to make known your
view on the last film you

saw or the last book you read? If
you have your mobile at hand,
you may soon be able to post

your views right outside your
front door. Researchers the
world over are working on ways
to create mid-air messaging sys-
tems that let you post or read
comments that people have left
tied to a particular location. The
‘mid-air’ messages will hang in
the air until someone walks past
carrying a device, a phone,
handheld computer or laptop—
any device capable of receiving
the messages. 

The uses are manifold.
Sailors could be informed about
the latest hazards or other dan-
gers with the use of mid-air mes-
saging systems. Waterfront tours
in New York use mid-air mes-
saging to inform the audience of
information at every nook and
corner. One of the bigger mid-
air messaging projects taking
place in Bristol has just received
a grant from the government to
fund its development. 

However, a big problem is
identifying the right ‘locating
system’ to use. GPS, which uses
signals from satellites, only
works well outside and its 
co-ordinate system is only able
to resolve areas down to a few
meters in diameter. The other
problem is working out which
messages to serve up to people
as they pass. The software
loaded on the devices will have
to know about its user’s likes
and dislikes, so it only gives
them a notice of the things
they are interested in.

Posting messages
in mid-air

■ Mitnick’s security consulting company’s Web site hacked ■ FBI maintains ‘patriotic’ cyber attacks as illegal ■ Deep vein thrombosis linked to extended PC use
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The call of the Kiwis Hello,
I am currently doing my Master of Computingfrom the Unitec Institute of Technology,Auckland, New Zealand. I have beensearching high and dry for local com-puter magazines but can’t seem to findanything worthwhile. In my opinion,the best technology publications that Ihave ever seen have been the oneschurned out by Jasubhai Digital Mediaand I rate Digit as the best computer maga-zine. I would like to know if you are planning to launch Digit

in New Zealand.
Avinash Shridhar
Via e-mail

Hello Avinash,

Your uninhibited passion for Digit is refreshing, but currently we have

no plans of launching Digit in New Zealand. In the meanwhile, you can

always consider ordering an international subscription, which will

ensure that you don’t miss even a single issue of the “best computer

magazine”.

PS: Our publisher has been walking with a swagger ever since he

received your e-mail!

Cover up
Hi Vinit,
I’m infatuated by your September 2002 cover model,

Raksha Kapoor. I’ve spent the last five months searching for

some more information, but I’ve been totally unlucky so far.

Can you kindly tell me where can I get more pictures of

her? Also give me her e-mail address and let me know if she

has a fan club.
Raksha's greatest fan,Pinbar

Via e-mail

Hi Pinbar,

You’re not the first reader to ask for Ms Kapoor’s e-mail ID and

we are sure that you won’t be the last of her admirers. Unfor-

tunately, we cannot help you in any way and we most cer-

tainly cannot give you her personal contact details.

Q. Would you like more game reviews in Off the Shelf,
instead of the game feature in Arcade? 

Your vote counts

No problemo! Expect to see more game reviews in the next issue.

53%
Game reviews 

9%
Tips & Tactics

38%
Game feature

This month’s question:

Are you satisfied with the current 
packaging of Digit?

Log on to www.thinkdigit.com and vote on it

AAC mangta hai
Dear Vinit,
Being an ardent fan of the AAC audio codec, I was sur-
prised that you opted to provide a commercial trial of
dBpowerAMP Music Converter on your February 2003
CDs when you could have included a free alternative
such as PsyTELDrop. This lapse on your part would
have definitely put off many first time AAC users. As
for AAC, the only thing that is preventing me from
switching over permanently to this excellent codec is
the lack of support in portable MP3 players such as the
Creative Nomad Jukebox. Keith Sebastian

Via e-mail

Dear Keith,
Sure PsyTELDrop is free, but its interface is not as user-friendly as that
of dBpower AMP and it’s not as generous in the audio formats that it
supports. The only sore point with our recommendation is that it needs
the Powertools package, a shareware, for the AAC front end. Hard-
ware support for AAC is improving: check out the Panasonic SV-SD50
that was featured in the Droolmaal section of the same issue.

Send them in people!
Hi Vinit, 
I would like to say that your Backbyte section in the

February 2003 issue consisted of more contributions

from the Net and less from the readers. I think Backbyte

is a reader’s section where they can post their run-ins

with the ‘lighter side of computing’. I had submitted 

a picture for the Backbyte section and it did not appear.

I do not understand this. 
Anshuk KumarVia e-mail

Hi Anshuk,

You are absolutely right. Backbyte was never intended as a

whiteboard for us—the editorial team—to pin up our

favourite tech jokes that we wanted to share with the read-

ers. I would apologise unconditionally for this goof. Do keep

those contributions coming in so that Backbyte continues

to be one of the first sections most readers turn to.

MARCH 2003
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Platform Shoos Dear Vinit,Thanks for February’s excellent and

comprehensive testing of the various

processors and motherboards avail-

able in the Indian market. However,

the Best Value Award winners in the

processor and motherboard categories

aren’t mutually compatible. It will be

helpful for many readers like me, if

the Digit Team could have listed com-

patible PC components so as to enable

us to build a complete PC.
R. GanesanVia e-mail

Dear Ganesan,

The idea behind the test was that a read-

er would first identify the task that he/she

needed to perform, and then choose the

recommended solution from within each

application area. As you’ve correctly

pointed out, the Best Value winners in the

Motherboard and Processor categories

aren’t compatible, but they represent the

best buying choices for those looking at

only a specific component (that is, either

a CPU or a motherboard). To reiterate, if

you’re looking to make a purchase deci-

ion for a complete PC platform, identify

your frequent tasks and then look for our

recommendations within the appropriate

application area writeups.

First amongst equals 

Dear Vinit,

As a subscriber of Digit, I would like to know why new

subscribers get two great CDs free while the older sub-

scribers do not. Please tell me the

reason and also if us older

readers can obtain them at a

discounted price. 

Siddharth Bose

Via e-mail

Dear Vinit,

I had subscribed to Digit, accepting the monsoon sale

offer in the December 2002 issue. But your January

issue offered a similar deal with two free CDs thrown

in. I feel cheated, as will all those who subscribed to

Digit in the month of December. This was not expect-

ed from a magazine of your reputation.

Umashankar Jamdagney

Via e-mail

Send your letters marked ‘Readers Letters’ to the Digit office: 
D-222/2, MIDC, TTC Industrial Estate, Om Sagar Building, Nerul, Navi Mumbai 400 706, 

Phone: 022-7629191/9200  Fax: 022-7629224 
E-mail: readersletters@jasubhai.com 

Short Bytes
Dis content?
Vinit,
Do you have a mailing list,
which can inform me of
the contents of the next
month’s CDs so that I may
selectively buy the issues
that interest me?

Abhay Dang
Via e-mail

Selectively buy Digit? Don’t
tell me you need to justify
your purchase of India’s lead-
ing technology magazine! In
any case, you can check
www.thinkdigit.com at the
beginning of every month. We
update the site with all the
information within the cur-
rent issue and the accompa-
nying CDs.

Operation 
compatibility
Hey Vinit,
I wish that you will start
mentioning whether the
software on the CDs is
compatible with all ver-
sions of Windows.

Kashyap
Via e-mail

Now what was that old
phrase? Ah yes, “Your wish is
our command!”

It’s in the dictionary.
Honest.
Dear Vinit, 
The February 2003 issue
was TRILLIANT (superlative
for brilliant)!

Pulkit Gupta
Via e-mail

A test of the times
The comparison test in the
February 2003 issue was
superb. I especially liked
the recommended solution
which actually helps us
pick the right combination
of motherboard and proces-
sor. Please make sure that
the graphics card compari-
son covers an equally vast
range of cards.

Nishant
Via e-mail

You got it Nishant. A compre-
hensive video card roundup
waits on page 42! 

Dear Siddharth and Umashankar,At Digit we’re always striving to provide our customers with
compelling offers that provide immense value for money.
But let me assure you both (and anyone else who subscribed
to Digit in the month of December 2002) that you did not
receive a raw deal. In December we offered 28 issues of Digit
for the price of 18. In January we revised our offer to include
24 issues of the magazine for the cost of 18 along with two
gift CDs. Therefore, the December offer gave you 4 extra
issues of your favourite magazine, which includes 8 free CDs!

MARCH 2003

This is how we do itDear Digit,
I am working for a recording studio and hope tomake an interactive promotional CD for myorganisation just like your Mindware andPlayware CDs. Please provide me with moredetails on the applications and tools that youguys use.

Sandeep S.
Via e-mail

The Force is missedHi Vinit,
Your February 2003 issue was great. Itgave us a lot of information on themotherboard and processor market inIndia. However, one thing that wasshocking was the omission of the latestnForce2 chipset for motherboards thatsupport AMD’s processor lineup. Is thechipset not worth reviewing or will it bereviewed in the future? Sundeep, StarNet Computers, BelgaumVia e-mail

Hi Sandeep,
Here is the masala straight from the horse’s
mouth…err…Multimedia team: “We use Macrome-
dia Dreamweaver for the HTML layouts while the
interface for browsing the CDs is made using Macro-
media Director.”

Please be aware that you’d also need a spe-
cialised team of multimedia professionals in the form
of a Graphics Designer (who decides the look and
feel of the CD), an Information Designer (who decides
the content structure, navigation and interface) and
a Programmer (who writes the scripts that ties every-
thing together), not to mention a team of content
specialists (who generate/identify the content).

Hi Sundeep,

The nForce2 chipset form nVidia is a rela-

tively new kid on the block and as such we

could not get a suitable motherboard to test

it. Rest assured that we will put such a solu-

tion under the microscope as soon as we

can get our busy little hands on one.
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PRL PCME...and so on. ‘Parents are
listening, please call me later’ for
the initiated. For the rest, it’s plain

gibberish. SMS is sprouting up a whole
new language. The hearing impaired, for
instance, find it very handy. The text is
short and understood even by those not
used to the English language. And since
most mobiles can be set on the vibrator
mode, the hearing impaired get alerted
when there’s a message. 

There are no boundaries to the
development of this language. It will
never stop, given its popularity and
usage. There are no grammar or spelling
rules and there is no such thing as a 
mistake. There are only suggestions. 
You can use letters or numbers to 

complete words or instead of words—u =
you, l8r = later, 4 = for. The idea is to
make words as short as possible—wd =
would, mor = more, etc. 

Now there are over 11 million cellu-
lar subscribers in India. In all probabili-
ty, you and I use a cellphone. And all of
us do use the SMS facility extensively.
SMS has become so popular among exec-
utives, housewives and youngsters alike,
that 18 lakh SMS messages have been
recorded between major cellular phone
operators every day. 

About 3 lakh SMS were sent and
more than 22,000 customers dialled 
and registered for news alerts as soon as
they heard about Warne renouncing
‘cricket’s greatest show on earth’.
Acknowledging the fact that text mes-
saging is one of the most popular meth-
ods of communication among young-
sters, group SMS is being used in some
schools abroad to give the students some

valuable exam tips. SMS is undoubtedly
a great asset. 

But there are problems too. There’s a
danger of the means to an end becoming
an end in itself if not used in modera-
tion. SMS is being misused by terrorist
groups. We all are spammed by chain
messages. And now there are also reports
that the standard of written English is
getting sloppy among students due to
the overwhelming popularity of SMS.
Students in Singapore have been increas-
ingly using SMS-style English in their
class assignments. For instance, some
students now spell the word ‘before’ as
‘b4’, ‘night’ as ‘nite’ and ‘with’ as ‘wif’.
Teachers are concerned that the efforts
to promote the use of good English are
‘being undone by SMS’. 

Now SMS is the ‘n thing’, but
shouldn’t we observe a language proto-
col? To get to the Net, you have to follow
TCP/IP—a protocol. Real life rules are no
different. Like, would you ever strut into
a discotheque in a formal suit? Or would
you walk in for an interview with a bank
in half pants? Obviously not! You will
feel out of place or made to feel unwant-
ed. It makes tremendous sense to send a
quick SMS to your friend. He under-
stands your lingo so your acronyms gel
with him. But try sending your resume
in SMS, especially if you’re applying for
a copydesk or writer’s position (you will
be surprised that employers do get such
resumes). Your resume will be in the
trash can. Your potential employer will
be grr and you will be :-( 

The issue is not about whether the
English language gets corrupted or not.
The US changed the rules of the game
with their spellings. Language has to
keep on evolving but all communication
has a purpose—to be understood. What’s
the point of sending an SMS in an abbre-
viated form if the other person does not
understand the message? Besides, there
is the hsp (highly sensitive person) who
might take offence. So the next time you
SMS, make sure the language is tailored
to suit your audience. If the SMS lingo
becomes the dominant language, you
can have the LL (last laugh). Till then,
FTR and hand (follow the rules and have
a nice day). 
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Would you ever strut into
a discotheque in a formal
suit? Or would you walk in
for an interview with a
bank in half pants?

“
”

Leslie D’Monte
Managing Editor, Digit



In India, as in most parts of the world,
computers are a significant invest-
ment for ordinary people. One that
involves bargain hunts for the cheap-

est hardware that money can buy and a
muted exchange of illicit software that
money need not. From the collective
mind of technology pioneers around the
world has emerged a concept that prom-
ises to change the landscape of comput-
ing. From something that only a handful
of people, blessedly within a particular
income bracket can make use of, comput-
ing hopes to achieve a utilitarian status—
becoming as ubiquitous as electricity.
Such is the promise of grid computing: a
delivery system of computer resources
much similar to an electric outlet. Just
throw a switch and get instant, hassle-free
access to computer power. Cheap too.

Come together
To better understand this concept, we need
to take a closer look at the analogy of an
electric power grid. Such a grid gathers cur-
rent from resources that range from hydro-
electric dams to nuclear reactors. Then
using a vast network of cables, capacitors
and transformers, it distributes the gath-
ered power to homes and institutes geo-
graphically distant. Similarly, a computing
grid will gather geographically distributed
resources of CPU power, storage capacities,
network bandwidth, printers, people and
instruments and offer the collective under
a singular, OS-independent banner to

those who need it.
There is strength in
unity, computers
subscribe to this law
as well. Multiple
heads performing a
task are much better
than one—connect
two computers and
the resultant power
increases. Imagine
connecting super-
computers in such a
way, or connecting
the millions of desk-
top computers that
are equivalent in
performance to a supercomputer of yes-
teryear. The computing power thus
unleashed could be of staggering propor-
tions. All you would need to do is plug into
this hive of unified strength and draw
transparently upon resources hitherto out
of your reach.

Now that we have a logical structure
of a grid in mind, let us take a brief look at
what makes such a network tick. A grid is
a peer-to-peer network comprising four
layers. The lowest rung or layer 1 is the
heart of the unit. Called the Fabric, it com-
prises physical devices and resources that
will be shared across the network—CPUs,
storage devices, bandwidth, applications
and peripherals, to name a few. Above lies
layer 2, the Connectivity and Resource
chunk comprising communication and

authentica-
tion protocols that
allow sharing of data and
resources from layer 1. The Collective
layer or layer 3 consists of services and APIs
that allow transparent interaction between
resources. Finally, user applications form
the topmost layer 4. Just as a Web browser
can access data from the WWW via a
defined set of standards and protocols, so
will applications sitting on this layer make
use of underlying structures to access the
resources of layer 1.

As an example, consider that one of
your applications (sitting on layer 4) wish-
es access to a database (sitting on layer 1)
over a grid. It would first establish its cre-
dentials for a secure connection via the

By the masses, for the masses: we take a look at
a technology that promises to democratise computing 
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authentication protocols of layer 2. It
would then find out the location and avail-
ability of the required resource via the col-
lective layer of APIs that is layer 3. Next, it
would ask for an exchange of data between
networks or computers (remember that a
gird is a collective) via the Resource proto-
cols of layer 2. Finally, your program would
monitor the progress of initiated transac-
tion, pointing out success or failure as
appropriate, via the Resource protocols.

Greater than its parts
At this point in time the concept of grid
computing is emerging from the labs of
universities and government institutions,
looking for a commercial helping hand
that would allow it to reach a mass audi-
ence in a manner that the Internet did.

The scientific community has a vora-
cious appetite for computational
resources. Too much is never enough for
those who trade data in terabytes on a
daily basis. The work involved calls for no
other solution but a distributed grid.

Take for instance, trying to under-
stand the complexities involved in pro-

tein folding. Proteins are the building
blocks of life; they define us via chromo-
somes and defend us via antibodies, per-
forming every function in between. Dis-
eases such as Alzheimer’s and cancer are
linked to proteins and their property of
folding: a means to align selves into a
functional unit. To understand this mys-
terious process, simulations are run on
computers. Protein folding used to take
20 months to simulate. Thanks now to
grid-crunching numbers over supercom-
puters thrown across borders, it can be
done in a day, at 1 trillion operations per
second. The Human Genome Project, an
undeniable task of gargantuan data shuf-
fling, required 500 million trillion

sequence comparisons. Such a
feat would not have been pos-

sible without the advanced
computational infrastruc-

ture that a grid delivers.
CERN’s European

Laboratory for Parti-
cle Physics in

S w i t z e r l a n d
expects to pro-
duce several
petabytes of data
each year (think
20 million, four-
drawer filing cabi-

nets full of text and
you are thinking in

petabytes). Running
through this mass of digits

would require computing
power greater than 20 ter-

aFLOPS—IBM’s ASCI White hard-
ly touches the 12 teraFLOPS mark.

Clearly, joint computational power is
called for and CERN is look-
ing for a grid solution to its
dilemma.

For the scientific com-
munity, a grid allows access
to greater computing power
and faster networks, which
presents an environment
for better sharing of data
across borders, thus allow-
ing for better co-operation.
A grid-enabled earthquake
simulator hopes to divide
the task between nations
across continents: while
one laboratory will use its supercom-
puter to analyse stress caused on the
foundation of a quake-hit bridge, anoth-
er located miles away would simultane-
ously concentrate on the effects that the

rest of the structure show; effectively
reducing the total time for a complete
analysis by a huge factor. 

Cheaper than the whole
When terrorist strikes and clandestine
security hacks factor in a need for greater
data access and redundancy, a distributed
network becomes an ideal choice. A
national government can share vital data
on terror groups between states and its
policing authorities. Moreover, thanks to a
non-central, peer-to-peer network, even if
a section of such a grid is made useless,
other parts can chip in and balance the
load to assure continuity of service. Such a
data exchange need not be limited to intel-
ligence; it could also be used effectively to
impart greater transparency to bureaucra-
cy and governance. The dream of that elu-
sive global village has to materialise with
the advent of computing resources to our
physical villages, bridging the divide with
low-cost distributed networks. Finally, for
cash-strapped governments that cannot
afford singular supercomputers to simulate
ecological or military experiments, dis-
tributed computing offers equivalent pro-
cessing power at a much lesser cost.

Indeed, cost benefits have attracted
multinational corporations to grid.
Although less than 1 per cent of compa-
nies are using grid computing today, the
number is expected to grow to 10 per cent
by 2005 when large companies with more
than 10,000 employees will take a 40 per
cent chunk of the grid pie. The corporate
community needs a homogeneous, busi-
ness-to-business, data-rich environment
to conduct commerce. It has to leverage
existing resources and delay the need to

purchase new infrastruc-
ture. A company with 600
grid-enabled desktop PCs
can utilise all of them
together as one computa-
tional platform, providing
it with enough juice to
tackle the world’s 49th
largest supercomputer.

Take the case of Glob-
eXplorer, a company that
delivers imagery from satel-
lites and aerial photogra-
phy over the Internet and
other media. It has used

distributed computing to great effect: to
reduce its image processing time from 
1 terabyte a month to 1 terabyte a week
by scavenging spare compute cycles from
its workstations and servers.

The world’s fastest
supercomputer, the

IBM ASCI White, is
rated at 12 TeraFLOPS
and costs about $110
million. Thanks to grid
computing, SETI@home
gets about 15 Ter-
aFLOPS on an average
and costs about
$500,000 to date
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Other companies find favour within a
grid network. When Ford Motors was in
the market for an affordable solution to
simulate car chassis behaviour, Sun
Microsystems pitched in, with Gridware
in tow. Gridware, a German company,
now acquired by Sun, made software that
tied desktop computers into a mini-grid,
able to perform like a supercomputer. The
solution saved Ford $100 million and suc-
cess thus spawned, encouraged the motor
company to use the same solution to
design other components.

Coming soon…
BMW, Boeing and Motorola have also
deployed mini-grids as an affordable solu-
tion to enable virtual organisations that
span nations and yet provide transparent,
immediate access to its resources.

To consumers and home users, the
trickle down of this technology is mini-
mal. While distributed services such as
SETI@Home are here for desktop PCs, they
are hardly meant to grant immediate ben-
efits to an end-user. Perhaps Microsoft
with its much ballyhooed .NET initiative
or IBM spearheading the rival and open-
source OGSA (Open Grid Services Archi-
tecture, a set of standards and technolo-
gies to grid-enable computers using Inter-
net standards already in place) will trigger
a wave of grid-ready applications. Already
McAfee.com Corp has launched a new 

initiative called ‘Grid Computing Services’
that will use distributed computing tech-
niques to provide real-time, dynamic secu-
rity against viruses or trojans. McAfee’s
hub will consist of desktop PCs that will
process data coming in from users and
generate alerts, updates, fixes and infor-
mation about security threats—in the
form of pop-up windows that will either
be routed through proprietary software or
through Microsoft’s .NET Alerts.

Butterfly.net and IBM have teamed up
to offer a middleware solution (a middle-
ware lets you deploy a solution with min-
imal coding effort) for the online video
game industry. MMOGs (Massively Multi-
player Online Games) are a lucrative mar-
ket, fraught with pitfalls involving main-
tenance of networks and hundreds of
thousands of lines of game code. The 

Butterfly Grid is
powered by Linux-
based IBM machines
hosted by Big Blue
and connected via
efficient fibre-optics.
The grid design
potentially allows
for one million
simultaneous play-
ers to game together,
as opposed to the
several thousand
that would conven-
tionally fit into one
server. The trick is to
grid-connect multi-
ple servers then offer
a one-point gateway
to the collective for the desktop PCs run-
ning a game. The gateway then seamless-
ly toggles between constituent servers as
and when required—to load balance or
provide automatic fail-over capability.

The computational horsepower that
games demand has fuelled rumours that
Sony is looking to a distributed network to
leverage the power of the PlayStation 3
(PS3). Grid-enabled (likely with the use of
proprietary software), a collection of PS3s
will allow for transparent gaming all over
the world. The computing resource this
will unlock certainly promises titles
remarkably realistic in look and feel.

There are other promises that tantalise
the home segment. Grid-powered servers
would mean more dependable Internet
access and better Quality of Service, as such
a system load-balances itself. Individuals
will have faster computers, greater storage
capacities and better bandwidth at their
fingertips, at costs affordable to both the
rich and the poor alike. Cheap hardware
such as handhelds (like the Simputer, the-
oretically) could tap into the power of a
grid to offer experiences exponentially
greater than otherwise possible.

…right after this commercial
break
But there are hurdles. The technology is
new and as such there is some uncer-
tainty on the best route to take. A 
fractured vision of ‘how to get there’ is

slowly merging into a unified point of
view: open-source, community-driven
and corporation-backed initiatives such
as the Globus project. A further need to
tackle issues of security and rights man-
agement is urgently felt. Scaglia of
Hewlett-Packard has been quoted as say-
ing that the current level of security
offered by a grid environment is not
acceptable. Perhaps the biggest hurdle is
the economic practicality. Grid needs to
be largely accepted by organisations with
deep pockets. The NSFs, the IBMs and 
the Microsofts of the world need to 
take notice. Although the initiative is

heading towards that goal, the flow of
green needs to be much more generous
than it currently is. That and co-opera-
tion rather than competition, to define
overlapping open-source standards and
then adopting them remains the key.

We are witnesses to an information
overload. Every day massive amounts of
data flow helter-skelter, going-a-begging to
be structured and analysed, to be made
sense of. Hidden beneath this stream could
perhaps run cure for diseases: there are 
10-100 million species on this planet, 1.7
million are known, and only 50,000 have
been studied in any detail. A wealth of
knowledge lies at our feet and the limited
brain can only look to the tools it has built
for a feasible solution. Grid computing
then seems the logical step forward.

AHMED SHAIKH

A grid (A) is a pool of resources that finds its source from a collective
of personal and super-computers. With the right permission, any
computer within the grid can access this pool. The resource can be
storage space (B), processor(C), system memory (D) or network
bandwidth (E)

It’s kind of like the Borg—all the resources become part of the 
collective, but in a good way —Tom Hawk on grid computing, 

General Manager of grid computing for IBM
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Sony MZ-N1 MD Walkman (MD player)
It will rock you!
Sony’s new high-speed NetMD Walkman player/recorder
allows you to record MP3s or CDs at up to 32x speed from
multiple sources (PC, portable CD, home CD unit, radio).
It is supplied with a USB cradle for charging and easy PC
connection. The device features a three-line Dot Matrix
LCD display, up to 110 hours of playback, ATRAC3
playback and support for multiple Internet audio formats
(MP3, WMA, WAV). This recorder utilises affordable MD
Media for over 5 hours of music storage on one 80-
minute disc.  
Web site: www.sony.com

ADS USB 2.0 Turbo Web cam
Picture perfect
Here’s an easy way to video conference, video chat and e-mail
snap shots to family and friends. The USB 2.0 Turbo Web cam
offers you the high bandwidth of USB 2.0 technology, which
enables clear, smooth video over the Internet. It features a
640x480 resolution at 30 frames per second, high-quality lens for
crystal clear video, an adjustable desktop tripod and a SnapShot
button for still image capture. Also bundled are video
conferencing and editing applications. It allows you to chat 
and video conference with up to five people in real time! Here’s
to sharing special moments with far-flung family members 
and friends.
Web site: http://www.adstech.com/media/mediapdtimg.asp

▲ ▲

The final destination
to indulge your fetish
for funky devices

▲▲
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Siemens S 55
A splash of blue
SMS, EMS, MMS, e-mail, Bluetooth, GPRS class 10, WAP 1.2.1, integrated
hands-free and voice dial/command, currency converter and world
clock—this phone has it all. EMS allows you to send extra long texts,
icons, animations and even melodies. The e-mail client supports SMTP,
POP3, IMAP4. Besides, with triband technology, you can call from almost
anywhere in the world. An attachable camera with an integrated flash can
be purchased separately for taking images and sharing them using MMS.
The graphic colour display shows up to seven lines and has a visible area
of 33x29 mm, while its Lithium Ion battery offers about 300 hours
standby/6 hours talk time.

The S 55 also includes Java to enable you to download applications as
well as games. The S 55 automatically synchronises contacts, business and
social schedules wirelessly with PCs and PDAs. 
Web site: www.my-siemens.com

Bose Triport headphones
The right tone
If you think a headphone just cannot give you good sound, stylish design
and a comfortable fit all in one package, then it’s time you took a close
look at Bose Triport headphones. This pair gives you deep, full bass.
At the same time, the design is small and lightweight. Soft ear
cushions gently fit around your ears to create a comfortable,
portable experience. The thin, adjustable headband has several
easy settings and the ear cups swivel for added convenience. No
more do you need to compromise the quality of your favourite
music just because you’re listening through a pair of headphones! 
Web site: http://www.bose.com/products/headphones/triport/

Fujifilm FinePix F401 Digital Camera
Capture the world

The FinePix F401 integrates full digital multimedia video
and sound with a 2.1 Megapixel Super CCD, capable of

producing a maximum image file size of 4 million pixels.
Also, the CCD system can yield 1600 ISO at 1 Megapixel
with minimal electronic noise, higher shutter speeds and

extraordinary performance. An optional cradle helps charge
the Lithium Ion battery and acts as a simple USB computer

docking station or base for PC-Cam video conferencing.
Web site: www.fujifilm.com

▲ ▲

▲▲

▲▲



3billion human lives ended on August
29th, 1997. The survivors of the
nuclear fire called the war Judgment

Day. They lived only to face a new nightmare,
the war against the Machines...

A metal foot crushes the skull like china.
TILT UP, revealing a humanoid machine

holding a massive battle rifle.
It is the endoskeleton of a Series 800 ter-

minator. Its glowing red eyes compassion-
lessly sweep the dead terrain, hunting.

--Terminator 2: Judgement Day

This was the future. They all told us so—
Asimov and Cameron—our home was
going to be dominated by metalmen. And
if we weren't careful, they would stop serv-
ing us coffee and toast, and take over the
world. But the future is already here and
instead of menacing cold wires, and
exoskeletons with laser eyes, we have metal
canines going into a frenzy over a plastic
ball. Much as our soothsayers would like to
make us believe, robots are used for more
menial labour than world domination—
tasks unglamorous enough to restrict their
menacing frame to a giant limb with
enough mobility to pick up and place com-
ponents of a car frame firmly in place.

The beauty of robotics is that it brings
together different disciplines such as
mechanical engineering, electronics, dig-
ital electronics, communication, comput-
er science, algorithms and chemical engi-
neering. And it also diversifies into other

areas such as Artificial Intelligence, a
prime driver for the future robotics and
Hollywood movies alike.

Robots are more used in the industry
scenario to increase precision or produc-
tivity. The humble industrial robot is a
tool used to do routine and tedious jobs,
where human accuracy suffers over a
period of time. The typical working day
for an industry robot involves welding,
assembly, spray painting and replacing
the nuclear fuel rods in nuclear power
plants—jobs that are too monotonous or
harmful for human beings. While indus-
trial robots are a widespread norm in
countries such as Japan, Russia, Germany,
the United States and China, they haven’t
been able to catch up too quickly in India
for reasons financial and human. Which
is not to say that they aren’t here at all—
robots do thrive in the clinical environ-
ment of the mechanical laboratories of
our engineering universities. But will they
come out to butter our toast?

Still in school
C. Amarnath, teaching in the mechanical
engineering department of IIT, Mumbai,
has worked on the nine-year project,
Natraj, along with Isaac Kurien and the
students of mechanical engineering. The
Natraj is a walking robot built using com-
pletely indigenous components. The
development of the Natraj is funded by
the Bhabha Atomic Research Centre

(BARC) which aims to use it in its nuclear
plants for hazardous operations. So what’s
so special about it? Amarnath explains:
“The Natraj is a walking machine and it is
fairly more difficult to define its moves.
For a robot to walk, we have to study the
human sense of balance and movement
very closely and try to emulate it in the
mechanism. It has to learn to work with
gravity and balance itself while moving
its feet.” Kurien agrees: “Although all of
us walk, it’s hard to define it for a
machine. They don’t have a sense of bal-
ance and tend to overturn.”

Making a robot walk takes it to a high-
er level of mechanical intelligence and
gives it mobility. This, in turn, makes it
applicable to more areas of work. It can
now navigate itself around to do the pre-
scribed task. As Subir Saha, associate pro-
fessor in IIT, Delhi, and an ardent champi-
on of industrial robotics in India says, “In
the Indian way of life, drudgery and life
hazardous jobs are the norm. Anyone
exposed to nuclear, radiation or working in
steel factories faces occupational danger. In
a scenario like this, there is no reason why
robotics should not be applied for the wel-
fare of the human workers.”

And what is the future workday of the
Natraj going to be like? According to
Kurien, “With the Natraj, we’ve tried to
prove, using indigenous technology, that
machines can walk. The next step would
be to make it more intelligent using 
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sensors such as cameras and input sensors,
which will help it make its own decisions.
It will be able to do much more than what
it can do with the existing sensors. Right
now, it has internal sensors, which means
that the feet move the way we program
them to. This is the lowest level feedback.”

So does this mean that the Terminator
will have six legs and look like a spider,
instead of Mr America? Or to be more pre-
cise, will we be able to make a mobile robot
that takes stock of the obstacles in its course
and maps out a path to perform its task, or
is pre-programmed? “It’s both actually,”
explains Kurien. “The Natraj is fully pre-
programmed. The next step is to make
robots that work on simple operator com-
mands such as ‘go from this point to that
point’. While currently we spoon-feed a
robot on what has to be done at each point,
by then the robot will be equipped to
encounter the obstacles placed in its path
because they will be fed into the memory
and it will react as instructed. This will
require more sensors, the ability to recog-
nise the senses, classify them and to make

intelligent use of them.”
So are robo sapiens just

being put to use where no
good homo sapiens should
go? Not really. Other jobs
require an intelligent and
observant metal head with
a scientific background.
The National Institute of
Oceanography, Goa, is
developing Maya, an
Autonomous Underwater Vehicle (AUV)
which has a bright future. Elgar de Sa, a
scientist with the institute, works on the
Maya. “The visions we have is several
Mayas prodding the ocean floor, connect-
ing to each other and making discoveries.
We’re interested more in discovery—we
want to know what’s happening under the
ocean. It’s so vast, we can’t know enough
using just ships,” he says. 

AUVs are being built in other parts of
the world such as Europe and the United
States. However, their main focus remains
surveying the ocean. The Maya is a low-
cost, small, but intelligent AUV. “In place

right now are a few systems that are huge
and require sophisticated launch capabil-
ities and sophisticated sensors. We are not
looking at these systems. What we’re
looking at is small AUVs that are very
intelligent and highly manoeuvrable.
Their low cost makes them affordable to
be replicated in the future,” explains de
Sa. The Maya is approximately 1.5 metres
in length, 1.3 metres in diameter and runs
using a single motor. It can dive to a
depth of 300 metres and has a range of
about 30 km. The sensors used will have
to be state-of-the-art and hence will have
to be imported, but a lot of the hardware

Yantriki is the annual robotics festival that
is organised by IIT Mumbai. The brain-

child of C. Amarnath, the Dean of Students
Affairs, Yantriki has built up a legendary rep-
utation of attracting the best amateur teams
in the country to pit their robotic skills
against each other. This year was no excep-
tion; from January 31 to February 2, teams
from all over the country jumped in to take
a chance at winning the top honours.
Yantriki also coincides with Techfest, IIT
Mumbai’s annual technology festival, and
the resulting carnival makes this the most
fun technology event. 

The competition is made up of three

rounds, with increasing levels of complexity
and automation. At Level 1, the competition
involved a game board with a folded napkin
in the centre. Two robots come in from
either end, cross an obstacle and place

themselves near the napkin,
pick it up, and scoot right
back to their home. The
fastest one to do this is the
winner. At Level 2 , the bots
fight it out over table tennis.
Each bot gets 10 seconds to
pick up the ball and throw it
back across the net. Lose out
on the time frame and the
opposing bot wins a point.
In Level 3, the bots enter a
maze and negotiate their

way out. Sounds easy? Hold on then. Here
the mouse-bot is entirely autonomous—no
humans can control or intervene to help out
the mouse!

The bots came with tiny electrical
motors, belts, wires, toggle switches, tape
and aluminium foil and just about any-
thing that could be mounted on it; one
bot, for example, used a fan to whisk up
the ping pong ball in the Level 2 competi-
tion. The aggressive little bots came with
names such as The Titans, Sharp Shooters,
Jaws, Snatcher and Balbeer Pasha. In the
ensuing war, bots did break down, and
there was help at hand with IIT Mumbai’s
Robotics Lab providing a full-fledged
emergency room. 

And then came the final competition

Yantriki

The intelligence of 
a robot is meas-
ured by how
autonomous 
it isProf Isaac Kurien,

PROFESSOR, IIT MUMBAI

“
”

WOOF! Who let the dogs out?!

Grr! That's my play! (for those who missed
this: the Reds won, the Blues lost, and both
flipped and danced!)



and software used will be Indian.
So what is little Maya going to be when

she grows up? “There are a lot of applica-
tions being looked at—surveying the
seabed, for under-sea mapping. If we get
the right sensors, we can examine the
topology of the seabed. Currently, we only
use satellites that can only study the sur-
face of the sea.” The main task is to
increase the ability to collect data in inno-
vative ways. “I believe that if we can get
the technology in place, we can have a
family of them—small ones, big ones, ones
that can dive, that can go horizontally,
some that can explore by themselves,”
sums up de Sa. The battery technology
restricts the scientists from keeping Maya
underwater long enough to imprint the
scenic landscape on its electrodes. In the
future, de Sa hopes to use fuel technology
that will increase its endurance since
weight and power are the crucial factors
that will decide its staying capacity.

We have some aspirants for the med-
ical field too and misleadingly, one of
them is called the da Vinci. The da Vinci

console employed at the Escorts Heart
Institute and Research Centre in Delhi is
not known for its bedside manner. What
it is known for, however, is aiding doctors
during critical heart surgeries. The da
Vinci bears close resemblance to its video
gaming cousins and is accompanied by a
surgical cart with three arms jutting out.
The arms need to be assisted to the inci-
sions made on the patient and one of
them is fitted with an endoscope that
transmits images of the patient’s organ
onto a colour monitor. The da Vinci
recently aided a
successful bypass
heart surgery. The
Escort Centre is
currently one of
the handful of
hospitals to use
robots in surgery.
It needs to be
pointed out here
that robots are
only used to assist
qualified doctors;
they do not perform the surgery by them-
selves. 

The robot brings a lot of advantages
to the operation table—it does away with
the foot-long incisions needed in con-
ventional open-heart surgery by using a
smaller incision and displays the heart as
a three-dimensional image, magnified 10
times its natural size to give clarity. It also
takes over the function of artificially
pumping the blood while the operation
is in progress. But its special skill lies in
easing performance anxiety—da Vinci
deals with surgeon fatigue and hand
tremors by providing a stand for the
hand and steadying it. However, it will
be sometime before da Vinci finds its way
into more hearts. Today, the robotic heart
surgery costs around Rs 2 lakh and the da
Vinci costs Rs 7 crore to import. Industry
experts expect the costs to come down in
the next five years when the components
and technology involved will be cheaper.
It will also be cheaper for the patient,
since the recuperation time spent in the
hospital can get as short as three days. 

In the real world
All the budding technologies have been
late for their date with the subcontinent
compared to their counterparts in Europe,
the United States and Japan. These nations
have been using robots for some time now.
The primary hindrance is that robots have
traditionally been looked upon as replace-

ments for human labour. “The main rea-
son for the arrested growth of robotics in
India,” explains Amarnath, “is that most
western countries use robots as an alterna-
tive for their expensive human labour.
Another reason is that the components
used to make these robots were not avail-
able in India till late.” 

So what makes them ready for the
tropical subcontinental weather now?
“The key,” says Amarnath, “is to adapt
robots to our economic scenario. We can-
not use robots to reduce human labour.

Instead, we must use it as a tool and to
increase productivity and precision.” Saha
agrees: “We must use robotics since we are
competing with countries such as the Unit-
ed States, China, Russia and Japan. It has
been proved that precision cannot be
achieved by manual labour.” 

Robots can also be used to increase
productivity. In an industry such as car-
pet cleaning, a worker is paid by the
number of carpets he or she cleans.
Here, an automated tool increases the
efficiency and does not replace the
worker. Many industry experts feel that
we should study the robots being used
abroad and adapt and produce them
indigenously. This will lower their costs,
making them more accessible to 
companies.

The answer to the question that will
judgement day ever be brought upon by
machines, depends on their intelligence.
The intelligence of a robot is measured
by how autonomous it is. The definition
of robots itself establishes that it has to
be programmed to perform a task.
Hence, the intelligence behind it will
always be human. How well it performs
the task and how easily it overcomes the
obstacles it faces, will determine the
intelligence of the machine. So while we
may not yet have robots using us as bat-
teries to power themselves, there is a pos-
sibility of them cleaning our carpets.

MITALI PAREKH and SRINIVASAN RAMAKRISHNAN
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A published statistic
shows that 3,50,000
robots account for
less than 3 per cent 
unemployment 
in JapanProf Subir Saha 

ASSOCIATE PROFESSOR
IIT, DELHI ”

showdown—and the teams that won top
honours included Jaws from Veer Mata Jee-
jabai Technical Institute (VJTI), Mumbai, who
came up on top at Level 1, The Titans from
IIT Mumbai who triumphed at Level 2, and
AI from IIT Kharagpur who won the Level 3
competition. At the Level 2 finals, it was a
really close fight between The Titans and
their adversary, Balbeer Pasha (also from IIT
Mumbai) with both bots playing very hard
to win. The winners got to take home cash
prizes and Lego Mindstorm kits. 

Two students from the Dortmund Uni-
versity, Germany put up a game of robo-
soccer with six Sony Aibos. Each Aibo
responded to the movement of the ball,
and the concept of team play. And what’s
a mutt to do after winning? Why dance, of
course—six puppies danced to their victo-
ry, in sync and step with each other! 

The Ping-Pong Titans from IIT-B, 
winners of the Level 2 competition

“
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The Digital Media
Test & Research
Centre (DMTRC)
conducts a series

of elaborate tests to eval-
uate the merit of each
hardware and software
product. To ensure that
our readers have all the
information they need to
make an informed buy-
ing decision, engineers at
DMTRC evaluate and
review the latest hard-
ware, software and technology services in accor-
dance with the most up-to-date evaluation
processes and methodologies used around 
the world. 

Comparison Tests
We use a dual rating system, the first of which is

applied to the Comparison
Tests in which we compare
the performance of products
within a particular category.

Each product is evaluat-
ed under different parame-
ters such as performance,
value for money, features,
warranty and support, etc. 

Weightages are then
applied to the various test
parameters according to
their importance for 
that particular category of
products. 

These weightages are
then used to arrive at an
overall grade for each indi-
vidual product. An overall
grade of A+, therefore, indi-
cates that the product is
close to perfection.

The Awards
Digit awards out-
standing products
by selecting a Best
Performance and
Best Value winner in
each comparison
test. The winner of
the Best Perfor-
mance Award will be
the product that
scored the highest in
the performance seg-
ment of our tests.

This award represents the best performing prod-
uct in our tests and doesn’t factor in any other
parameter such as value for money, features, sup-
port, etc. The winner of the Best Value Award
will be the product that scores the highest in
our value for money parameter which is derived

taking into account the ratio of
a product’s performance and fea-
tures to its price. The product
winning this award offers good
performance at a great price.

In Bazaar
The second part of the rating system is used to
evaluate individual hardware and software prod-
ucts in the Bazaar section. The evaluation covers
parameters such as performance, ease of use,
value for money and the build quality/features of
the product in question and then arrives at an
overall rating. 

Here each of these parameters is given a
weightage of 25 per cent and is rated on a scale
of 5, which is represented by arrows ( ). 

The greater the number of arrows, the better
the product. This simple five-point rating system
is designed to give you an easy-to-interpret
assessment of a product. For example, a product
that receives an overall score of five arrows sig-
nifies an outstanding buy!

How we Test
Our feature test this month
presents a fresh perspective
into the video card market
in India. Some of the devel-
opments promise to surprise
you. Read the comprehen-

sive story
wherein
we test 36
AGP
graphics

cards to find out
how there are solu-

tions meant for everyone—
affordable and feature-rich.
Cards based on chipsets
from nVidia, ATi, Matrox
and Trident are suitably dis-
sected and analysed, help-
ing you to make the right
decision; be it for purchas-
ing a card for casual gaming
or for enjoying the latest
games at the best visual set-
tings. What’s more, an addi-
tional treat for all you com-
puter gamers comes in the
form of an extensive testing
of the best gaming periph-
erals. There are 24 devices
in the reckoning: be it a joy-
stick, a gamepad, or a rac-
ing wheel—with or without
force feedback—we have
them all lined up for your
perusal. Next up we have
the Bazaar section buzzing

with myriad products. A
Dell personal computer that
packs quite a punch within
an ultra small form factor, a
Canon Digital 2 Megapixel
camera, Creative’s latest 6.1
speaker set and a scanner
from Epson are just a few of
the goodies tested.

In Test this Month
It looks good and the technology is glitzy, but does it do the job?

Excellent: a brilliant combination of price, performance and features—far 
beyond expectations
Good: a good buy, better than most products in its category
Average: reasonably competent but nothing spectacular about the product
Mediocre: does not live up to expectations, needs improvement in many areas
Poor: has serious drawbacks and needs improvement before it can be 
used for its target application

The 5-point Rating System used in Bazaar
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Just when you thought the graphics card makers couldn’t pack in more technology
into their products, another card comes along that pushes the bar just a little bit
higher. So how do you sift through the MX440s, the 9700 Pros and the Ti4800s to pick
one that suits your needs the best? We evaluate the cards in the market and tell you
which ones pack the meat and which ones are just fluff.
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V
ideo cards cost a bundle. The set of applications
that one typically runs does not call for an
investment into such hardware. Motherboards
are now commonly equipped with an onboard
graphics chipset that does an adequate job of
satiating the needs of working with an office

suite, exchanging e-mail, browsing the Internet, even enjoy-
ing the odd game or two. You will thus find that unless you
specifically ask otherwise, your local PC assembler will 
consider it normal, supplying you with a system with an
onboard video chipset. The computer market, however, is
becoming more attractive and affordable to the masses; this
fact is also reflected in the falling prices of video cards, or
rather the availability of well performing, pocket-able solu-
tions. For a little over Rs 1,000, you can find yourself a decent
piece of hardware that will dedicate itself to painting your
monitor with pixels.

But why would you need to invest in such a solution? If
you wish to entertain yourself with DVD movies, you need a
current breed of video cards that carry hardware decoders that
will take the stress off your processor; if you find yourself
indulging in more than a weekly session of intense 3D-gam-
ing, well, nothing beats a good frag at 60 frames per second
(fps)—something only an AGP card can offer with elan. Even
professionals who find their source of income in 3dsmax or a
CAD application will be more comfortable powering their 21-
inch monitor with something that supports a resolution greater
than 1280x1024 with flicker-free refresh rates that exceed 75
Hz. There are cards that support dual-monitors (one of those
luxuries that soon becomes a necessity)—the Matrox Parhelia
can run three! There are those that can output to a television;
talk with your camcorder, exchanging movies; bring you cable
television and double as a video recorder, saving your favourite
programs on your hard drive, to be enjoyed at your leisure.
Applications such as these further emphasise the role of your
personal computer as the hub of digital information-exchange
and entertainment. 

Of all the applications, games come across as a determinant
of performance, being at the top of a food chain that consti-
tutes power-hungry applications—if your hardware can run a
game, other tasks become a walk in the park. You will thus find
that even the lowliest of cards meant for gaming, adequately
run CAD applications, or drive a large monitor at a comfortable
refresh rate and resolution. As you climb further up the price lad-
der, you find these cards with features that let you perform the
tasks listed above. Thus, at the very top you will find a card sim-
ilar to the ATI ALL-IN-WONDER 9700 PRO, one that is built
around a gaming chipset and offers a TV Tuner, a remote con-
trol, the ability to record TV programs or to connect external
hardware such as a flat-panel or a camcorder. While the low-
end cards are reasonably priced, beginning around Rs 1,000, the
high-end monsters exact a price in excess of Rs 20,000. With
this in mind, we have tested 35 cards from the leading vendors
in the Indian market, evaluating each one for two application
areas: casual gaming and high-end gaming. Let us help you
choose the right video card for your needs.

How we tested
Having established the areas of casual gaming and high end gam-
ing on which to evaluate a card, we then defined the areas
according to certain resolutions and feature sets. For casual gam-
ing the score split was 60 per cent performance and 40 per cent
price, while for high-end gaming the split was 80 per cent per-
formance and 20 per cent price. A card that would perform with
satisfaction at 640x480 and 800x600, while being affordable (not
greater than Rs 5,000) would be considered ideal for casual gam-
ing. For high-end gaming, we decided to weigh a card based on
its performance at resolutions of 1024x768 and 1280x1024, with
the logic that cards that cost a bundle should perform accord-
ingly. Furthermore, features such as dual-monitor support, bun-
dled VR glasses, a TV Tuner chip, API compatibility, etc also con-
tributed to the scores of a card for the high-end gaming area. 

We tested all the cards on the same set of benchmarks, but
awarded them differently based on the resolutions run. With the
benchmark scores in hand, we then calculated a Suitability To
Task Index (STTI), which was an amalgamation of pure per-
formance and price. We thus have an STTI score for the applica-
tion area of casual gaming (the higher a card scores, the better
suited it is to this task) and an STTI score for high-end gaming
(again, the greater a card scores, the more suited it is to the area
of high-end gaming). As an example, a card may score 70 STTI
for casual gaming and 40 STTI for high-end gaming, making it
an ideal buy for the casual gamer but an avoidable investment
for someone who demands greater performance at high resolu-
tions, advanced features such as DirectX 8.1/9.0 compliance, etc.

The benchmarks chosen were run at resolutions of 640x480,
800x600, 1024x768 and 1280x1024. Except for 3DMark2001 SE,
which was run at 800x600 and 1024x768 resolution. What fol-
lows is a list of benchmarks used and the reason for using them.
You will notice that all tests, synthetic or real-world, were relat-
ed to games—if a card copes well with these set of hurdles, you
can be sure that any video application you throw at it will be
tackled with grace.
Quake III Arena: The venerable OpenGL-based engine still
remains an intensive
test, especially for
cards with older
chipsets. The ability
of the game engine to
scale higher or lower
according to the hard-
ware allows us to
evaluate the perform-
ance of the graphics
cards by keeping the
rest of the test system
the same. Moreover,
most of the favourites in the Indian gaming market are deriva-
tives of the Quake III Arena engine. The age of Quake III Arena,
however, led us to delegate more importance to it in the casual
gaming area—it got the highest weightage under this sector. For
a card's performance under OpenGL for the high-end gaming
area we used a newer game, noted below.

Which graphics card is the best? The answer is simple: one that gives you optimum
performance at the price you can afford. We help you choose the right card whether you

are looking for killer effects or plain vanilla gaming
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Serious Sam: Second Encounter: The Serious engine is also
based on the OpenGL API, but is a better engine for evaluating the
latest cards. Not only does the engine scale well, it also churns out
a lot of high-polygon count monsters, stressing a video card to a
great degree. As mentioned earlier, this was the game of choice for
evaluating a card's OpenGL performance for the high-end gaming
area and was thus given a greater weightage in that sector.
Unreal Tournament 2003 Demo (UT 2003): This is the lat-
est Unreal engine that we could get our hands on, since Unreal 2
wasn’t released at the time of testing. Suffice to say, the engine
is sufficiently advanced so as to put even the fastest of cards
through their paces. Vertex shaders, reflective surfaces, bump-
maps, high-polygonal enemies and levels—everything men-
tioned in the Journal of Greater Eye-candy is implemented with
great care by this game. This engine was used to evaluate a card’s
performance under the DirectX API. This benchmark too, gath-
ered greater weightage for the high-end gaming area.
VulpineGL Mark: This is an OpenGL-based synthetic bench-
mark. It is used to evaluate the potential performance of a card

under advanced fea-
tures such as hardware
texture and lighting,
and cube mapping.
The test consists of
several stressful locales
such as a dense forest,
reflective water, a
high-tech lab with
transparencies and
lots of light sources
and shadows. Such

elements strain a video card, giving an indication of its perform-
ance while playing an OpenGL-based game. A final score is dis-
played in the form of an average fps that a card managed to draw. 
3DMark 2001 SE: 3DMark 2001SE fills in the boots of a synthetic
test for DirectX evaluation. It incorporates the new features that
went into the DirectX 8.1 API. This makes it suitable for evaluat-
ing the latest graphics cards that claim to be DirectX8.1 and Direc-
tX9.0 compliant, as it runs tests that use a card’s hardware T&L
unit, its pixel shader unit, various bump mapping techniques and
so on. This benchmark skips the relevant test if a particular feature
is not supported by the card—a course that is directly reflected in
the unified score which is presented at the end of the test.
3D Quality test: To determine the visual quality offered, we
tested the cards under Quake III Arena and UT 2003 with anti-
aliasing and anisotropic filtering turned on. The features offer
more realistic, cleaner pictures. Screenshots from the two games
were judged by a panel of three and points were awarded to each
card based on the quality of the shots.

To test the graphics cards, we used a test-bed consisting of a
P4 2.8 GHz processor sitting on the Intel 850EMV2 motherboard,
with 256 MB RDRAM and a 40 GB ATA/100 hard drive, along
with a Samsung Samtron 75E 17-inch monitor. The OS was Win-
dows XP Professional with Service Pack 1. The monitor was set
at 1024x768 resolution with 75 Hz refresh rate. Vertical Sync was
turned off from the respective drivers so that the frame rate while
benchmarking, would not get locked to the limit set by the mon-
itor’s refresh rate. For testing the nVidia cards, the latest 41.03
Detonator drivers for XP were used. The ATi cards saw the CAT-
ALYST 3.0 driver set loaded on the system. Matrox cards were
tested with the drivers that came bundled along.
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How they fared
When we talk about graphics cards, the conversation melts down
to ATi and nVidia. Solutions from Matrox and Trident, although
present, failed to impress us. The latest offering from these compa-
nies is nVidia’s GeForce 4Ti4800 chipset and the 9700PRO from
ATi. However, cards with nVidia’s GeForce4MX chipsets dominat-
ed the comparison, doing very well in the casual gaming applica-
tion area and performing not too shabbily in the high-end gaming
sector. The reason was simple: a very few games support all the lat-
est features that a card offers—you will often find a lag of six to 12
months between the release of a new API and that of a game that
fully utilises it. It is a rule driven by economy of numbers. Thus, a
card with a decent feature set and an affordable price comes across
as the ideal buy. Since almost all the features of the latest and the
fastest nVidia GPU are offered by the GeForce4 MX chipsets and at
a relatively lower price, the result was not surprising. The high-scor-
ers within the high-end gaming area were the latest chipsets men-
tioned above—another result that did not come as a surprise. The
point to note, however, is that ATi solutions are now capable of
taking the fight to nVidia, both in performance and in price.

Casual gaming
While a definition of a casual gamer will be hard to form, you
could consider yourself one of this kind if you find yourself tak-
ing in the occasional gaming goodness, with an interest that does
not exceed a few minutes. A quick bot-match in Quake III Arena, a
mission or two in Medal of Honor: Allied Assault, a brief tussle with
gems in Bejeweled, or a frag-session amongst friends in Counter-
Strike or Unreal Tournament. Such activities tend to define you as a
casual gamer. A video card suited to your needs will also be more
than adequate for other mundane chores of browsing, word-pro-
cessing, e-mailing, and satisfactorily working with CAD/3D mod-
elling applications. Such a video card need not run the latest games
at the highest resolutions and more importantly, should be afford-
able. No use sinking money into an activity that you only indulge
occasionally. Thus, the application area of casual gaming was
defined, and benchmarks run at resolutions of 640x480 and
800x600 formed the backbone of the tests for this area. On the fea-
tures side, we awarded points to a card if it had Video In and Out
ports, if it had a fast enough speed, a decent RAMDAC (to support
those high resolutions), compliance with gaming APIs, etc. After
the relevant scores were thus gathered, we calculated a Suitability
to Casual Gaming Index—an STTI score that determined the suc-

cess of a particular card in this application area. The logic was sim-
ple: the greater the score, the better the card. We further zoomed
in on the ideal solutions area by factoring in price. Thus, all cards
that scored above 50 STTI and sold at between Rs 2,500 and Rs
5,000 were considered ideally suited to the application area of casu-
al gaming. Based on this band, we present the following analysis.

The best video cards for Casual Gaming: The ideal frame
rate that a video card should offer is around the 60 fps mark.
Although the human eye is said to satisfactorily accept a 30 fps rate
for moving pictures, the nature of a game calls for a buffer. A game
is a dynamic creature, one moment you will be staring at a serene
landscape littered with nothing but interesting trees and rocks, only
to be suddenly surrounded by ghastlies that come fattened on poly-
gons and in great numbers. Moments such as these stress a video
card, which if it were hitherto running at around the 30 fps marks
would now crawl at less than the ideal frame rate, causing visible
stutters. Thus, a greater frame rate is always advisable—for the casu-
al gaming area, this rate should fall within the resolutions of
640x480 and 800x600.

Two benchmarks were given greater weightage here, Quake III
Arena and 3DMark 2001 SE. Video cards from ENNYAH dominat-
ed this area of gaming. Decent performances at very low prices ele-
vated them to this status. The ENNYAH Digiforum GeForce2MX
200 posted scores of 130.2 fps at 640x480 and 43 fps at 800x600

Before opening up the computer cabinet
and replacing your old video card with a
new one, here are a few things that you
need to do:

Un-install the drivers for the old
graphics card from the Add/Remove

section of the Control Panel. 
Shut down your computer and
open your cabinet. Pull out the cord

supplying power to your computer.
Remove the VGA connector attaching
your monitor to your video card.
Carefully pull out the old graphics
card, ensuring that you are electri-

cally grounded.
Hunt for the AGP slot: this should be
brown in colour and smaller than

the similar looking white coloured PCI slots.
Though unlikely, the card might be sitting
on a PCI slot.

Insert the new graphics card into
this brown slot and screw it in for a

comfortable fit.
Close the cabinet and switch on the
computer.
The new card will be now recog-
nised by Microsoft Windows and the

basic VGA drivers will be installed.

When asked to install the drivers for
the card, choose No and continue.
Insert the driver disk provided by the
card manufacturer and continue on-

screen instructions to install drivers for the
card. Restart machine and there you are. Your
new graphics card is ready to boogie. In case
your card does not come with driver software,
you can download the generic Detonator driv-
ers if your card has an nVidia video chipset
(find them online at ww.nvidia.com), the CAT-
ALYST drivers if you have an ATi-chipset-based
card (www.ati.com), or Matrox drivers if so
required by your card (www.matrox.com).
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resolution under Quake III Arena. As far as 3DMark scores are con-
cerned, a number close to 2,000 should be considered adequate
under this application area, while anything close to 5,000 should be
looked upon as a good show. The GeForce2MX 200 card showed its
age by posting just 1923 3DMarks under the 800x600 resolution—
barely adequate. Even under the real-world DirectX test of UT 2003,
this card did poorly, posting just 21.1 and 15.11 fps. Its OpenGL
showing continued to be adequate—even in the newer engine of
Serious Sam, the card posted above the 30 fps mark: 65.6 fps for
640x480 and 43.7 fps for 800x600. At Rs 1,750, only the MSI Trident
T64 is cheaper, but this card beats the performance of the T64 by far.
Consider it a buy if you are in the market for an inexpensive deal. 

This card’s elder sibling, the GeForce2MX 400 TV-OUT, did
worse, although it possessed a theoretically greater bandwidth. A
TV Out port granted this one a greater cost of Rs 2,750. Competing
head-to-head, we found the MSI version of the same chipset in their
MSI MX400 Pro64S GeForce2MX 400 card. Although quite a mouth-
ful, the card bettered its rival by far, scoring 226.5 fps as opposed to
95.5 fps in Quake III Arena at 640x480 and 4343 3DMarks against the
ENNYAH’s 1878 score. It also did surprisingly well in the UT 2003
tests, posting 43.52 fps at 640x480 and 31.28 fps at 800x600 reso-
lution. Its performance comes at a price, however—at Rs 4,300, the
card is twice as expensive as the ENNYAH, although its performance
certainly reflects that difference. 

To buy a GeForce2MX chipset at prices around the Rs 4,000
mark is not very advisable; you should rather opt for the newer and
more feature-rich GeForce4MX-based solutions. ENNYAH offers
three variants of this chipset: the Digiforum GeForce4MX 420 TV-
OUT is based on the 420 chipset, while the Digiforum GeForce4MX
440 TV-OUT-4X/8X are based on the 440 chipset which along with
support for AGP 4X/8X, provide greater bandwidth for transfering
data between the CPU and video card. The flavours perform to sat-
isfaction, posting scores greater than 200 fps under Quake III Arena

1/2 page Ver. AD

Take a video card with an onboard TV Tuner (such as the ATi ALL
IN WONDER 9700 PRO or the COMPRO VideoMate from
nVidia, or buy a PCI daughter card from the nearest hardware
shop (look to our Undercover report on page 82 for further infor-
mation). Add in coaxial cables to connect the card to your cable
provider, throw in a hard disk big enough and spice up the mix
with comfy seating, for one or two. There you have it, hot off
the stove, a solution that will put your TV and VCR to shame. 
What you potentially possess is called a personal video recorder
(PVR). The theory is simple: tune in to your favourite shows
using the TV Tuner, and power up the software supplied along-
side the hardware to encode and record the show on your hard
disk. PVR also lets you pause a live show, head off for a snack or
such, come back and continue watching the show where you
left off. What’s more, this ‘time-shifting’ also allows you to skip
commercial breaks! All through the wonder of some encoding
software and your handy hard drive.

Storage space is a potential bottleneck for PVR application. A
movie encoded in MPEG-2 format, at a resolution of 720x480,
running for a length of 1 minute with sound will take up half a
gigabyte of disk space! This is where video codecs come in.
Some of them are proprietary (such as the one supplied with
ASUS cards) but all of them aim to alleviate the burden of disk
space required to record your favourite shows.

A Recipe for Entertainment 
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and greater than the 6,500 mark under 3DMark2001 SE. They do
similarly well across the board—their performance under Serious
Sam hardly falls under the 80 fps mark, while even the stressful UT
2003 never manages to bring them to a level less than the 50 fps
level. Consider the GeForce4MX 440-4X and the 420 variants: at
Rs 4,500 and Rs 4,750, respectively you can see why it is wiser to
invest in one such chipset rather than one based on the
GeForce2MX chipset. Cheaper variants of the chipset are on offer
by SMEDIA cards—the GeForce4MX 420 and the GeForce4MX 440
by SMEDIA ask for Rs 3,200 and Rs 3,900, respectively. Although
the SMEDIA solutions do not perform up to the par set by the
ENNYAH cards, the performance married with the prices on offer
allow us to consider them as a better buy. A recommendation that
is reflected by the STTI score that these cards achieve: 81.80 STTI
for the SMEDIA GeForce4MX 420 and 88.68 STTI for the
GeForce4MX 440 variant. Judged purely on performance, the Gain-
ward Ultra/750 8X XP Ti4800SE comes across as the leader. Colour
it with a price of Rs 18,895, however, and you can see why the
SMEDIA cards are the overall winners in this category.
Our recomended solution: SMEDIA GeForce4MX 420

High-end gaming
Although the golden rule of greater than 30 fps still holds for the
high-end gaming segment, the landscape changes drastically due
to several factors. First amongst them is the resolution—when you
find yourself shelling out money in excess of Rs 10,000, your
expectations should similarly rise. Thus, frame rates of around 
60 fps at resolutions of up to 1280x1024 are considered notewor-
thy. Similarly, a score around the 15,000 3DMark should be con-
sidered ideal for such a card. Once resolution is duly handled, the
3D quality offered by a card is evaluated. For this, we concentrat-
ed on the visuals that a card dished out under the later and the
greater engine of UT 2003, giving it four times as much weightage
as we gave Quake III Arena. To do this, we enabled Full Screen Anti-
Aliasing (FSAA) and Anisotropic filtering for all the cards. A panel
of three then judged these and awarded points. We also sampled
FSAA scores for these cards, in order to gauge the performance hit
that each one took while enabling the said feature.

Finally, benchmarks of Serious Sam, 3DMark2001 SE and UT
2003 were given the maximum weightage for performance under
this application area. Feature-wise, we judged each card on dual-
monitor support, I/O ports (such as S Video-RCA), memory band-
width, number of pixel/vertex pipelines, API compatibility, etc.

The best video cards for High-End Gaming: A performance
STTI of 66 along with an ideal price of Rs 10,000 came together to
define the ideal buy under this particular category. To get a range
of suitable cards, we formed a band centred at the ideal card with
price ranging from a low of Rs 8,000 to a high of Rs 12,000. Thus,
all cards with a score greater than 66 STTI and falling within the
above price band were deemed suitable to buy. Even though the per-
formance scores within this area were skewed by a relatively low
price factor of 20 per cent, it was enough to cause some cards to lose
to cheaper brethren. A card such as the Matrox Parhelia was thus
immediately out of the running—this particular variant cost a stag-
gering Rs 30,000 even as it failed to score the 66 STTI needed. Sim-
ilarly upstaged were the Gainward Ultra/750 8X XP Ti4800SE and
the Hercules 3D PROPHET R9700. While the Gainward scored 79.22
STTI, its price of Rs 18,895 humbled it next to the Gainward
Ultra/650 TV GeForce4 Ti4200—the latter scored significantly less
at 78.79 STTI but also came significantly cheaper at Rs 11,995. An
identical fate awaited the 3D PROPHET—the R9700-based card
scored 75.6 STTI, but its high price of Rs 24,895 saw it lose its glory
to another R9700 card—the SMEDIA RADEON 9700 128 MB. The
latter scored 82.11, thanks to its cheaper tag of Rs 16,000.

That price is a significant leveller can be further ascertained
by looking at the best performers in this application area. The
Hercules 3D Prophet R9700 PRO scored 74.04 STTI, while the
SMEDIA RADEON 9700 128MB scored 82.11 STTI. Factor in price
and the picture becomes clear: between the Hercules at Rs 33,500
and the XSERVE at Rs 16,000, the choice becomes obvious—the
latter becomes a recommended solution for the task at hand.

When it came to pure numbers, the ATI cards proved to be a
superior buy. From nVidia’s stable, the GeForce4MX chipset made
a repeat appearance. As pointed out earlier, the low cost and good
enough feature set of these chipsets make them an ideal buy-
although not one with a great lifespan—for the non-discerning
gamer. Solutions from ASUS, COMPRO, Gainward and MSI car-
ried variants of this very chipset. 

While all of them managed to cross the 50 fps mark in the Seri-
ous Sam test, nothing beat the Gainward Pro/600-8X XP
GeForce4MX 440 as it touched almost 60 fps at 1280x1024, a great
showing indeed considering that it came in as the cheapest buy at
Rs 8,300. It also did equally well in the DirectX stresser, UT 2003,
posting a very playable 42.85 fps at 1280x1024. What then took
away its best buy status? The XSERVE RADEON 9700. Its amazing
posting of 82.11 STTI at a price of Rs 16,000, tilted the scales in its
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favour. Indeed, as pointed earlier, cards based on the ATi
Radeon came out tops. Of all tests of notable weightage, these
cards lost only once to their rival, the Gainward Ultra/650 TV
running on the GeForce4Ti4200 chipset—the test in question
being the Serious Sam game at a 1280x1024 resolution. 

The Gainward scored 71.3 fps, an amazing showing when
compared to its nearest competitor, the R9000 Pro-based Cre-
ative 3D BLASTER5 (with 66.2 fps). Memory bandwidth-saving
technologies such as a faster Z buffer-clear, an efficient memo-
ry chip layout and better compression algorithms, allowed the
ATi-chipset-based cards to perform very well under high-reso-
lutions. Thus, the 3DMark2001 SE crown at 1024x768 was
taken by the efficient and DirectX 9.0 compatible SMEDIA
RADEON 9700. The practical application of which shone under
the UT 2003 test, as this particular card managed to stay above
the 60 fps mark even at 1280x1024 with a score of 65.87 fps.

Of special mention is the COMPRO VideoMate Cinema.
Based on the GeForce4 MX 440 chipset, it bundles together
a set-top box that acts as a TV Tuner. You can thus enjoy
your favourite TV programmes on your PC and with the help
of the right software, you could even record and playback
some of your favourite shows and events at the cost of hard
disk space. (For more information on how to use such a video card
as a personal video recorder, see ‘Your PC as a VCR’ in the Decem-
ber 2002 issue of Digit.) The card in question costs Rs 11,995,
which is significantly more than the ASUS or the MSI ver-
sions, undoubtedly due to the TV Tuner card. 

The Matrox Parhelia also deserves a mention, thanks due



Graphics Cards at a Glance

Features
Chipset

On board memory
Dual Monitor Support
Manufacturing Process (micron)
Core Architecture (bits)
Clock Speed (MHz)
Memory bandwidth (GB/sec)
RAMDAC Speed (MHz)
Max Resolution Supported

AGP Interface 
Compatibility (DirectX/OpenGL)
Hardware T&L Support
Rendering Architecture

Pixel Pipelines
Texture Mapping Units/Pipe
Pixel Shader/Vertex Shader 

Visual Effects
Anti-Aliasing Technology 
Trilinear/Anisotropic Filtering

VR Glasses 
Video-OUT
Video-IN
S Video-RCA
TV Tuner Chip
Remote Control
Performance
Serious Sam Second Encounter

640x480x16
800x600x32
1024x768x32
1280x1024x32

Quake III Arena
640x480x16
800x600x32
1024x768x32
1280x1024x32

VulpineGL Mark
640x480x16
800x600x32
1024x768x32
1280x1024x32

3DMark2001SE
800x600x32
1024x768x32

Unreal Tournament 2003
640x480x16
800x600x32
1024x768x32
1280x1024x32

3D Image Quality (Scale of 5)
Quake III Arena
Unreal Tournament 2003

Overall Score
Suitability to Casual Gaming
Suitability to High-End Gaming
Overall Product Rating
Overall Product Grade

Vendor name

Phone
E-mail

Price (in Rupees)

ASUS V9180
magic 

GeForce4MX
440-8X
64MB DDR
✖

0.15
256
275
6.4
350
2048x1536@
75Hz
8X
8.1/1.3
✔

2
4
✖ /✔

✔

✔

✖

✔

✖

✔

✖

✖

95.3
73.8
51.5
39.4

297.5
160.3
110.4
70.3

66.3
50
39.1
24.9

6472
4846

61.2
50.3
35.4
24.38

3
3

58.28
51.85
55.06

Rashi 
Peripherals
022-28260258
ho@rptechindia.
com
9,950

ASUS V9280 

GeForce4 
Ti4200
128MB DDR
✔

0.15
256
250
8
350
2048x1536@
75Hz
4X
8.1/1.3
✔

4
8
✖ /✔

✔

✔

✖

✔

✔

✔

✖

✖

106.3
99.8
75.3
51.2

332.5
316.8
277.5
202.1

114.2
104.1
117.6
89

13927
11979

66.58
66.54
64.78
57.95

4
4

62.13
72.35
67.24

Neoteric 
Informatique
022-24172600
viren@neoteric-
info.com
22,000

COMPRO Video-
Mate Cinema

GeForce4MX 
440
64MB DDR
✔

0.15
256
270
6.4
350
2048x1536@
75Hz
4X
8.1/1.3
✔

2
4
✔ /✔

✔

✔

✖

✔

✔

✔

✔

✔

119
103.2
62.3
40.9

330.2
270.9
167.1
112.8

109.1
75
53.3
36.9

8264
7211

66.81
63.88
56.59
42.88

3
3

65.78
68.42
67.10

Mediatech

022-2239 6696
sales@mediatech-
india.com
11,995

Disclaimer: Prices are indicative and are subject to change             

ASUS V8170
magic 

GeForce4MX
440
64MB DDR
✔

0.15
256
270
6.4
350
2048x1536@
75Hz
4X
1
✔

2
4
✖ /✔

✔

✔

✖

✔

✖

✔

✖

✖

93.8
71.3
30.9
19.5

242.5
202.6
91.2
57.2

57.3
42.6
37.6
26.5

5768
4121

56.01
43.06
29.49
19.98

3
3

57.30
54.83
56.06

Rashi 
Peripherals
022-28260258
ho@rptechin-
dia.com
7,250

ASUS V8420
Deluxe 

GeForce4 
Ti4200
128MB DDR
✔

0.15
256
250
8
350
2048x1536@
75Hz
4X
8.1/1.3
✔

4
8
✔ /✔

✔

✔

✖

✔

✖

✔

✖

✖

105
96.7
78
79.3

333.8
329.3
231.1
175

114.4
104.5
111.9
53.4

14146
12408

66.56
66.43
66.03
59.44

4
4

60.75
71.15
65.95

Rashi 
Peripherals
022-28260258
ho@rptechindia.
com
23,000

ASUS V8420 

GeForce4 
Ti4200
128MB DDR
✔

0.15
256
250
8
350
2048x1536@
75Hz
4X
8.1/1.3
✔

4
8
✔ /✔

✔

✔

✔

✔

✔

✔

✖

✖

106.1
104.9
73.5
51.3

329.9
312.4
211.2
155.2

114.1
104.3
70
50.5

13478
11489

66.42
66.25
64.05
56.37

3
3

62.54
69.52
66.03

Rashi 
Peripherals
022-28260258
ho@rptechindia.
com
18,000

ASUS V9
180TD 

GeForce4MX
440-8X
64MB DDR
✔

0.15
256
270
6.4
350
2048x1536@
75Hz
8X
8.1/1.3
✔

2
4
✖ /✔

✔

✔

✔

✔

✖

✔

✖

✖

98.2
95
64.7
52

310.9
299.1
208.3
147.5

95.3
75
53.3
37

8062
6029

64.79
64.08
56.52
42.84

4
4

65.33
67.03
66.18

Neoteric 
Informatique
022-24172600
viren@neoteric-
info.com
9,950

ASUS V9280S 

GeForce4 
Ti4200
128MB DDR
✔

0.15
256
250
8
350
2048x1536@
75Hz
4X
8.1/1.3
✔

4
4
✔ /✔

✔

✔

✖

✔

✔

✔

✖

✖

106.3
98.3
81.5
59.5

330.9
328.7
228.8
186

114.6
104.8
125.3
96.8

14461
12755

66.6
66.54
65.78
59.89

4
4

62.01
74.15
68.08

Rashi 
Peripherals
022-28260258
ho@rptechindia.
com
22,500



ENNYAH 
Digiforum 

GeForce4MX
440 TV-OUT-8X
64MB DDR
✔

0.15
256
275
6.4
350
2048x1536@
75Hz
8X
8.1/1.3
✔

4
4
✖ /✔

✔

✔

✖

✔

✖

✔

✖

✖

98.8
80.3
50.2
36.8

305.2
266.2
201
104.8

95.4
74.6
53.2
39.4

7279
5780

64.32
58.77
47.38
33.55

3
3

76.91
63.82
70.36

Great World 
Tech Pvt Ltd
022-23892828
sales@
gtechworld.com
5,500

ENNYAH 
Digiforum 

GeForce4MX
420 TV-OUT
64MB DDR
✖

0.15
256
250
2.6
350
2048x1536@
75Hz
4X
8.1/1.3
✔

4
4
✖ /✔

✔

✔

✖

✔

✖

✔

✖

✖

108.3
79.5
40.7
26

246.8
158.2
111.1
70.8

66.1
49.9
39.3
29.4

6539
4877

61.75
50.57
35.62
24.54

4
3

71.94
56.93
64.43

Great World 
Tech Pvt Ltd
022-23892828
sales@
gtechworld.com
4,500

ENNYAH 
Digiforum 

Radeon VE

32MB SDRAM
✔

0.18
128
183
2.9
300
2048x1536@
75Hz
4X
8.1/1.3
✔

2
2
✖ /✔

✔

✔

✖

✔

✔

✔

✖

✖

39.7
28.8
16.3
9.4

103.8
53.1
36.4
17.3

27.8
20.9
13.9
8.8

2543
1430

24.77
16.97
16.97
11.23

2
2

33.49
38.35
35.92

Great World 
Tech Pvt Ltd
022-23892828
sales@
gtechworld.com
4,000

CREATIVE 3D BLA-
STER5 RX9000 Pro

Radeon 9000 Pro

128MB DDR
✔

0.15
256
275
2
400
2048x1536@
75Hz
4X
8.1/1.3
✔

4
4
✔ /✔

✔

✔

✖

✔

✖

✔

✖

✖

108.3
106
90.8
66.2

306.4
275.2
195.6
124.6

89
80.2
73.7
57.3

10208
8454

63.07
62.82
74.95
38.96

3
3

63.99
74.94
69.47

Compuage 
Infocom Ltd
022-28305500
info@compuagein-
dia.com
9,200

ENNYAH 
Digiforum 

GeForce4MX
440 TV-OUT-4X
64MB DDR
✖

0.15
256
270
6.4
350
2048x1536@
75Hz
4X
8.1/1.3
✔

4
4
✖ /✔

✔

✔

✖

✔

✖

✔

✖

✖

95.5
80.3
46.9
30

251.7
237.9
148
96.6

75.2
58
44.2
32.3

7373
5927

64.32
58.77
44.5
31.79

3
3

72.59
60.98
66.78

Great World 
Tech Pvt Ltd
022-23892828
sales@
gtechworld.com
4,750

ENNYAH 
Digiforum 

GeForce2MX
200
32MB SDRAM
✖

0.18
256
175
1.3
350
2048x1536@
75Hz
4X
8/1.2
✔

2
2
✖ /✖

✔

✔

✖

✖

✖

✖

✖

✖

65.6
43.7
13.8
7.1

130.2
43
26.9
15.1

23.8
17.8
11
5.2

1923
1310

21.1
15.11
9.65
5.74

1
1

60.33
35.58
47.95

Great World
Tech Pvt Ltd
022-23892828
sales@
gtechworld.com
1,750

ENNYAH 
Digiforum 

GeForce2MX
400 TV-OUT
32MB SDRAM
✖

0.18
256
175
2.7
350
2048x1536@
75Hz
4X
8/1.2
✔

2
2
✖ /✖

✔

✔

✖

✔

✖

✔

✖

✖

33.7
22.4
14.4
8.2

95.5
39.5
23.1
13.9

29.1
20.7
11.4
8.1

1878
1046

15.76
10.79
6.28
crashed

1
1

36.99
34.54
35.76

Great World
Tech Pvt Ltd
022-23892828
sales@
gtechworld.com
2,750

ENNYAH 
Digiforum 

Rage 128 PLUS 
TV-OUT
32MB SDRAM
✖

0.25
128
140
2.5
300
2048x1536@
75Hz
2X
8/1.1
✖

2
2
✖ /✖

✖

✔

✖

✔

✖

✔

✖

✖

23.2
22.9
Failed
Failed

47.9
28.2
11.4
Failed

Failed
Failed
Failed
Failed

1516
Failed

13.01
Failed
Failed
Failed

1
0

21.04
19.29
20.17

Great World 
Tech Pvt Ltd
022-23892828
sales@
gtechworld.com
2,500

Gainward
Pro/450 TV

GeForce4MX
440 
64MB DDR
✖

0.15
256
270
6.4
350
2048x1536@
75Hz
4X
8.1/1.3
✔

4
4
✖ /✔

✔

✔

✖

✔

✖

✔

✖

✖

61.3
58.9
32.8
21

293.4
255.4
45.7
29.3

54.8
43.3
33.7
22.9

6504
4837

61.53
50.48
35.4
24.38

3
3

73.86
56.05
64.96

Mediatech

022-2239 6696
sales@mediate-
chindia.com
4,990

GIGABYTE 

Radeon 9500

128MB DDR
✔

0.15
256
275
8.6
400
2048x1536@
75Hz
4X
8.1/1.3
✔

8
8
✔ /✔

✔

✔

✖

✔

✖

✔

✖

✖

104.3
101
52.8
39

295.3
287.2
185.9
115.5

83.4
77
73.1
60

12715
10714

65.8
65.8
64.4
53.39

4
4

58.59
68.24
63.42

Tirupati 
Enterprise
033-22423861
gigabyte@
tirupati.net
17,000



Graphics Cards at a Glance

Features
Chipset

On board memory
Dual Monitor Support
Manufacturing Process (micron)
Core Architecture (bits)
Clock Speed (MHz)
Memory bandwidth (GB/sec)
RAMDAC Speed (MHz)
Max Resolution Supported

AGP Interface 
Compatibility (DirectX/OpenGL)
Hardware T&L Support
Rendering Architecture

Pixel Pipelines
Texture Mapping Units/Pipe
Pixel Shader/Vertex Shader 

Visual Effects
Anti-Aliasing Technology 
Trilinear/Anisotropic Filtering

VR Glasses 
Video-OUT
Video-IN
S Video-RCA
TV Tuner Chip
Remote Control
Performance
Serious Sam Second Encounter

640x480x16
800x600x32
1024x768x32
1280x1024x32

Quake III Arena
640x480x16
800x600x32
1024x768x32
1280x1024x32

VulpineGL Mark
640x480x16
800x600x32
1024x768x32
1280x1024x32

3DMark2001SE
800x600x32
1024x768x32

Unreal Tournament 2003
640x480x16
800x600x32
1024x768x32
1280x1024x32

3D Image Quality (Scale of 5)
Quake III Arena
Unreal Tournament 2003

Overall Score
Suitability to Casual Gaming
Suitability to High-End Gaming
Overall Product Rating
Overall Product Grade

Vendor name

Phone
E-mail

Price (in Rupees)

Gainward
Pro/600-8X XP

GeForce4MX
440 
64MB DDR
✔

0.15
256
270
6.4
350
2048x1536@
75Hz
4X
8.1/1.3
✔

4
4
✖ /✔

✔

✔

✖

✔

✔

✔

✖

✖

91.4
89.8
80.2
58.9

305.9
268.2
171.2
113

95.3
76.2
52.5
36.9

8159
7195

64.87
63.33
56.47
42.85

3
3

69.01
72.80
70.90

Mediatech

022-2239 6696
sales@mediate-
chindia.com
8,300

Gainward
Ultra/750 8X XP

Ti4800se

128MB DDR
✔

0.15
256
275
2
350
2048x1536@
75Hz
8X
8.1/1.3
✔

4
8
✔ /✔

✔

✔

✖

✔

✔

✔

✖

✖

106.1
101.3
100.3
76

333
320
282
220

166.3
148.2
126.7
97.8

14496
12434

66.49
66.50
65.49
59.84

4
4

65.93
79.23
72.58

Mediatech

022-2239 6696
sales@mediate-
chindia.com
18,895

Disclaimer: Prices are indicative and are subject to change              

Hercules 3D
PROPHET FDX

Radeon 8500LE

64MB DDR
✔

0.15
128
250
8.8
400
2048x1536@
75Hz
4X
8.1/1.3
✔

4
8
✔ /✔

✔

✔

✖

✔

✖

✔

✖

✖

87.8
71.7
42.8
34.5

322.5
299.4
232
155.1

90.6
82.5
75.5
61.3

11228
9369

63.27
62.77
57.72
43.94

4
3

69.35
71.57
70.46

Mediatech

022-2239 6696
sales@mediate-
chindia.com
8,995

Matrox 
Millenium

G550

32MB DDR
✔

0.18
256
126
1
360
2048x1536@
75Hz
4X
8/1.1
✖

2
2
✖ /✔

✔

✖

✖

✖

✖

✖

✖

✖

42.7
31
16.7
10.8

121.6
45.4
36.5
23.3

14.5
9.7
Failed
Failed

2189
Failed

Failed
Failed
Failed
Failed

3
0

22.32
17.55
19.94

Neoteric 
Informatique
022-4172600
viren@neoteric-
info.com
8,000

Matrox 

Parhelia 128MB

128MB DDR
Three monitor
0.15
512
220
4
400
2048x1536@
75Hz
4X
8.1/1.3
✔

4
16
✔ /✔

✔

✔

✖

✔

✖

✔

✖

✖

66.2
58.9
48.4
35.7

275.2
244.4
157.5
101.3

41.9
38.6
31
26.1

10076
8413

62.88
62.93
60.66
52.22

4
3

46.87
56.67
51.77

Neoteric 
Informatique
022-4172600
viren@neoteric-
info.com
30,000

Gainward
Ultra/650 TV

GeForce4 Ti4
200
64MB DDR
✖

0.15
256
250
8
350
2048x1536@
75Hz
4X
8.1/1.3
✔

4
8
✔ /✔

✔

✔

✖

✔

✖

✔

✖

✖

118.5
116.4
87
71.3

329.8
315.9
211.9
149.1

161.9
137.6
103.7
76.5

13662
11607

67.23
67.03
65.11
56.89

4
4

71.20
78.79
75.00

Mediatech

022-2239 6696
sales@mediate-
chindia.com
11,995

Hercules 3D
PROPHET

Radeon 9700 

128MB DDR
✔

0.15
256
270
4
400
2048x1536@
75Hz
8X
8.1/1.3
✔

8
8
✔ /✔

✔

✔

✖

✔

✖

✔

✖

✖

99.5
88.1
55.6
51.6

307.6
301.7
284.4
256.3

86.8
80.8
81
78.4

15145
13679

65.68
65.75
65.89
65.92

4
4

57.94
75.60
66.77

Mediatech

022-2239 6696
sales@mediate-
chindia.com
24,895

Hercules 3D
PROPHET

Radeon 9700
PRO
128MB DDR
✔

0.15
256
325
4
400
2048x1536@
75Hz
8X
9/1.3
✔

8
8
✔ /✔

✔

✔

✖

✔

✖

✔

✖

✖

100.3
92
62.4
53.3

309.7
299.6
292.6
265.9

87.7
81
81
78.7

15798
14555

65.82
65.78
65.9
65.56

4
4

56.39
74.08
65.23

Mediatech

022-2239 6696
sales@mediate-
chindia.com
33,500



Maxforce 

GeForce2MX
400 64MB
64MB SDRAM
✖

0.25
256
175
2.7
350
2048x1536@
75Hz
4X
8/1.1
✔

2
2
✖ /✖

✔

✔

✖

✖

✖

✖

✖

✖

50.4
31.8
12.7
7.9

135.2
44.1
30.9
16.7

26.7
18.9
13.1
8.7

2392
1332

23.5
16.11
10.03
4.38

2
2

41.92
32.82
37.37

Maxtone

022-23091664
maxtone@
vsnl.com
3,300

Maxforce 

Trident T64

32MB SDRAM
✖

0.25
128
125
1.2
230
1600x1200@
75Hz
4X
8/1.1
✖

2
2
✖ /✖

✖

✖

✖

✖

✖

✖

✖

✖

Failed
Failed
Failed
Failed

53.4
19.7
9.6
5.8

15.2
8.3
3.1
Failed

1027
509

6.58
3.02
Failed
Failed

2
0

28.98
20.92
24.95

Maxtone

022-23091664
maxtone@
vsnl.com
1,375

MSI 

GeForce4MX
440 8X
64MB DDR
✔

0.15
256
275
6.4
350
2048x1536@
75Hz
8X
8.1/1.3
✔

4
4
✖ /✔

✔

✔

✖

✔

✔

✔

✖

✖

98.1
94.6
63.5
54.9

254.2
248.9
206.4
148.3

95.2
75
52.7
38.4

8321
6254

64.67
63.99
55.43
41.75

3
3

59.22
67.80
63.51

Priya Ltd

022-22663611
sales_bom@
priyagroup.com
9,400

Maxforce

GeForce2MX
200 32MB
32MB SDRAM
✖

0.25
256
175
1.3
350
2048x1536@
75Hz
4X
8.1/1.3
✔

2
2
✖ /✖

✔

✔

✖

✔

✖

✔

✖

✖

52.9
37.4
23.2
16.4

66.8
26.5
21.1
10.4

28.1
19.4
12.4
8.1

2155
1238

22.95
15.95
9.82
4.27

2
2

41.54
40.58
41.06

Maxtone

022-23091664
maxtone@
vsnl.com
2,200

MSI MX400
Pro64S

GeForce2MX
400
64MB DDR
✖

0.25
256
175
2.7
350
2048x1536@
75Hz
4X
8/1.1
✔

2
2
✖ /✖

✔

✔

✖

✔

✔

✔

✖

✖

85.9
62.9
28.9
16.9

226.5
166.8
68.8
41.4

52.1
38.2
29.3
20.2

4343
2947

43.52
31.28
20.75
13.73

2
2

62.53
44.87
53.70

Priya Ltd

022-22663611
sales_bom@
priyagroup.com
4,300

PixelView NVG28A
128DDR-DVI

GeForce4 Ti4200

128MB DDR
✔

0.15
256
250
8
350
2048x1536@
75Hz
4X
8.1/1.3
✔

4
8
✔ /✔

✔

✔

✖

✔

✔

✔

✖

✖

115.2
108.4
74.3
52

329.6
320.5
219.5
167.9

114.2
104.7
117.6
89.9

13896
11966

66.56
66.5
64.5
57.97

4
4

64.91
75.38
70.15

Rashi 

022-28260258
ho@rptechindia.
com
17,500

SMEDIA 

GeForce4 
Ti 4200 
128MB DDR
✔

0.15
256
250
8
350
2048x1536@
75Hz
4X
8.1/1.3
✔

4
8
✔ /✔

✔

✔

✖

✔

✔

✔

✖

✖

109.8
87.4
76.7
51.2

331.2
312.7
213.1
152.2

113.9
104.4
113.1
84.9

13635
11696

66.54
66.41
64.96
57.07

4
4

68.80
79.94
74.37

Xserve India

080-5202915
vivek_gupta@
xserves.com
12,750

SMEDIA 

GeForce4MX
420
64MB DDR
✖

0.15
256
250
2.6
350
2048x1536@
75Hz
4X
8.1/1.3
✔

2
4
✖ /✔

✔

✔

✖

✔

✖

✔

✖

✖

94.2
73.8
34.9
21.3

241
205
94.6
59.3

59.6
44.5
38.7
26.4

5954
4231

57.99
45.14
26.28
22.14

3
3

81.18
56.00
68.59

Xserve India

080-5202915
vivek_gupta@
xserves.com
3,200

SMEDIA

RADEON 9700
128M
128MB DDR
✔

0.15
256
275
17.3
400
2048x1536@
75Hz
8X
8.1/1.3
✔

8
8
✔ /✔

✔

✔

✖

✔

✖

✔

✖

✖

107.1
105.7
57.2
53.5

307
300.1
282.4
250.9

86.9
81
81.1
79.4

15824
14692

65.74
65.59
66.13
65.87

4
4

62.80
82.12
72.46

Xserve India

080-5202915
vivek_gupta@
xserves.com
16,000

SMEDIA 

GeForce4MX
440
64MB DDR
✔

0.15
256
270
6.4
350
2048x1536@
75Hz
4X
8.1/1.3
✔

4
4
✖ /✔

✔

✔

✖

✔

✖

✔

✖

✖

64.8
59.9
41.8
38.6

301.4
235.1
174.2
114.6

85.2
65.9
58.2
44.8

7703
6615

120.13
60.88
51.55
37.8

3
3

88.68
66.38
77.53

Xserve India

080-5202915
vivek_gupta@
xserves.com
3,900
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to its poor showing. It was often bested by older technology—the
MSI GeForce4MX 440 card beat it under Serious Sam with scores
of 63.5 fps and 54.9 fps, while the Parhelia posted 48.4 fps and
35.7 fps at 1024x768 and 1280x1024, respectively. As is evident,
it also failed to cross the 60 fps mark in Serious Sam and managed
to just achieve that goal under UT 2003 with 60.66 fps at
1024x768. This would not be a bad showing at all if it wasn’t for
the price tag of Rs 30,000. As it stands, we can only recommend
this card for those few of you who wish to work and play with
three monitors simultaneously.
Our recomended solution: Creative 3DBlaster5 RX 9000 Pro.

What it all leads to
That the consumer video card market is split unevenly between
nVidia and ATi solutions was apparent from this comparison
test. The entry-level cards are currently based on nVidia’s Rage
and GeForce2MX chipsets, but these will soon be pushed out of
contention by their older GeForce4MX brethren. As they should
be: the ENNYAH RAGE 128 PLUS failed to show textures for
3DMark2001 SE; under UT 2003, it showed corrupt textures for
the low resolutions and failed to run the high resolutions alto-
gether. Clearly, age is visible. 

While a GeForce2MX-based card can still be a cheap buy, it
would soon grow long in the tooth as is showcased by the Max-
force GeForce2MX 200, a card that refused to touch 30 fps in UT
2003. Solutions from Trident and Matrox also failed to impress.
While the Trident T64 costs the least at Rs 1,375, it brings with it
texture corruption galore in tests that show future-readiness
(3DMark2001 SE and UT 2003), while failing to perform to any
acceptable level in all tests but the low resolution one under Quake
III Arena (where it scored a decent 53.4 fps at 640x480). The
Matrox cards are too costly for the application areas under which
they fall, thanks both to technology and performance. The 
Millenium G550 at Rs 8,000 is in no way a casual gaming solution.

Decision Maker
And how!
You will need to play at lower 
resolutions and colour depth

800x600 should be an ideal screen
resolution, do keep most of the 
visual effects off though

You can graduate to 1024x768 level
with FSAA and anisotropic filtering set
at low setting

Play at 1024x768 with texture details
set to high and FSAA and anisotropic
filtering set to mid-levels

With at least 256MB of DDR RAM in
tow, a smooth gaming experience
awaits you at 1024x768

Enjoy a game at the highest level of
visual detail

You can play
Quake III Arena, Serious Sam 
Second Encounter, Need for 
Speed: Porsche Unleashed

Serious Sam Second Edition, Jedi
Knight II: Jedi Outcast, Need for Speed:
Hot Pursuit 2

Medal of Honor: Allied Assault, 
Serious Sam Second Encounter, Unreal
Tournament 2003

Medal of Honor: Allied Assault, 
Serious Sam Second Encounter, Unreal
Tournament 2003, Unreal 2

Medal of Honor: Allied Assault, 
Serious Sam Second Encounter, Unreal
Tournament 2003, Unreal 2

Almost any game

The right card for you
nVidia Riva TNT, ATi Rage 128,
Matrox G550, up to nVidia
GeForce2MX 200 based video
cards (up to Rs 1,750)
nVidia’s GeForce2MX 400,
GeForce2 DDR, ATi Radeon VE
based video cards 
(up to Rs 4,000)
nVidia’s GeForce3, GeForce4
MX 440, ATi’s 7500, 8500
based video cards 
(up to Rs 9,000)
ATi’s 7500, 8500, nVidia’s
GeForce4 MX 440, GeForce4 Ti
4200 based cards 
(up to Rs 12,000)
ATi’s 8500, nVidia’s GeForce4
Ti4200, GeForce4 MX 440-8X
based video cards 
(up to Rs 12,000)
ATi 9700, GeForce4 Ti 4800
based video cards 
(up to Rs 19,000)

Your CPU
250 MHz to 500 MHz

600 MHz to 800 MHz

850 MHz to 1GHz

1.1 GHz to 1.5 GHz

1.6 GHz to 2 GHz

2.2 GHz and above

1/4 page AD
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Similarly, the Parhelia at Rs 30,000 is outdone in performance by
cards that cost half as much.

The game thus revolves around two players: nVidia and ATi.
And the tables seem to be turning. While the budget solutions are
still nVidia-chipset-based cards, ATi is capturing the high-end seg-
ment, thanks to feature-rich, high-performing variants of its Direc-
tX 9.0-compatible R300 chipset. While we couldn’t get our hands on
a GeForce FX-based card, numbers flying around the Internet sug-
gest that it is not a clear winner over the R9700 by far. Further spec-
ulations suggest that the R350 (ATI’s answer to the FX) will not only
cost less but also perform 10 to 20 per cent better. As it stands, an
R9700-based card is our recommended choice for high-end gaming.

If you eat and breathe the frame rates and won’t touch games
without FSAA and Anisotropic filtering set to maxi-
mum, then look no further, SMEDIA RADEON 9700
is the card that will quench your thirst. This card eas-
ily won our Best Performance
Award. It is equipped with dual
monitor capability and S-Video Out
so you can watch high-quality
movies on a television set. In Quake
III Arena at 1280x1024x32 with set-
tings kept at high, it logged a frame
rate of 250.9 fps, which is not attain-
able by most of the cards in the mar-
ket. The same was the case in
DirectX-based 3DMark2001SE,
where it touched 14692 3DMarks.
This figure gives an indication of the amount of power packed in
this graphics card. The card also returned a very impressive 65.87
fps in UT 2003 at 1280x1024x32 resolution. 

Our Best Value Award goes to the SMEDIA GeForce4 MX440.
This card comes with both D-Sub and a DVI connector

to connect two monitors to the PC and S-Video
Out so you can enjoy the pleasure of a bigger
screen. The card is well suited to those who
want to play the latest games but don’t mind
disabling some features to get higher frame
rates. The card gave some impressive results
in our benchmarks. In SeriousSam SE, the
card reached a high of 59.9 fps at 800x600

resolution. This means that the card can eas-
ily run most OpenGL-based games
such as Jedi Knight II. In UT 2003 the
card logged 60.88 fps at 800x600
resolution, which means that what-

ever kind of game you play, be it first person shooter or strate-
gy game, it will simply fly with this card plugged into the system.
With a price tag of just Rs 3,900, this card is a steal.

ALIASGAR PARDAWALLA and AHMED SHAIKH

1/2 page Ver. AD

A GeForce4MX chipset
makes this SMEDIA card
the best buy

At Rs 16,000 the SMEDIA
RADEON 9700 is the best

gaming solution
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Drive ‘em Crazy

The wheel caters to a very small category of gamers as it can only be used with high-
speed racing simulators. This was the only category that saw a very limited com-
petition with no product from Microsoft and only one Logitech high-end

product. Saitek, Frontech and Typhoon managed to fill in the gaps with some good,
some bad and some strictly ordinary wheels. The cheapest wheel was from Typhoon,
while the ones from Logitech and Saitek stole the lime light for being expensive.   

Test process
We tested all the gaming devices on our test-bench comprising a Pentium 4 2.2 GHz on
an MSI 845E MAX2 BLR motherboard, 256 MB DDR RAM and a 40 GB Seagate ATA IV
7,200-rpm hard drive running Windows XP. The devices were tested on four primary
parameters: features, ergonomics, build quality and value for money. Each parameter was
assigned 25 per cent weightage. The overall scores were then calculated from how much
the device scored in each area. 
Features: For evaluating the features of every wheel, we took into account various param-
eters such as the interface of the device. A device with a USB interface scored higher than
that with a game port interface. The presence of both analog and digital controllers
fetched some extra points. More the number of programmable buttons, more were the
points awarded to the product; floor pedals as against hand paddles for gas and brake
functions made for brownie points. Features such as rumble effects and force feedback
were awarded extra points.  
Ergonomics: To calculate the ergonomics of the wheel, we took into account various
criteria such as the size of the steering wheel and its grip. Wheels with a recess for the
thumb and rubberised steering scored more than the ones without them. The button
layout was also considered when awarding points—a better layout, with well-placed
buttons scored more. Points were also awarded for the feel of the floor pedals, depend-
ing on their designed and pivot angle.  
Build quality: Wheels by their very nature are huge and sturdy. We awarded points for
the quality of materials used, the quality of the joints and their overall build. The but-

We call up the best wheels and race them against each other to the finish line

Features: Force feedback effects, wheel mounted gear switches, four
programmable buttons, floor brake, gear pedals Price: Rs 6,999 
Contact: Aditya Infotech Ltd Phone: 022-26338555 E-mail:
sunil_zarekar@adityagroup.com Web site: www.logitech.com 

The WingMan Formula Force GP is one
of the best wheels we’ve seen. The

build quality is rugged and the red
rubber grips make the wheel  non-
slippery. The gear paddles are done
away with and the touch-and-go switch-
es are placed just underneath the spokes.
The other four buttons are mounted on the facing
surface of the spokes. The foot pedal is connected to
the main unit via a small RJ45-like pin and uses a high-quality
spring that provides an excellent response. It sports a slip-free
design and is pivoted at right
angles for comfort gaming. The
Formula Force GP provides
excellent force feedback with
commendable accuracy and pre-
cision. This wheel has it all—good
ergonomics, ample force feedback
effects coupled with ease of use. 

Logitech WingMan 
Formula Force GP
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

A-A-

tons were awarded points based on tac-
tility and tackiness. The wheel with an
anti-skid floor board was given more
points. Also, the wheel with good clamp-
ing mechanism scored more. 

■ Go for a wheel with floor pedals
over a hand-mounted one for a
more realistic gaming experience.

■ The length of the floor cable
should be enough to connect to the

main steering wheel and must be
detachable for portability. 
■ The clamping mechanism of the
wheel should be strong enough to hold
the wheel in position, so ensure that
your wheel of choice has a proper
clamping device. 
■ The wheel should ideally have four
programmable buttons and wheel
mounted gear paddles for shifting the
gears, apart from the floor pedals for
gas and brakes. 
■ A force feedback wheel may be a good
investment in thrill but it does come at a
price. Consider it only if you are likely to
play every racing game released.

This was the only wheel with rumble effects in the entire com-
parison. The Adventure sports a D-

pad, and hand-gas and brake pedals.
The steering wheel has three spokes
with a clean button layout. The base
is light and four suction cups hold
the wheel in place. A toggle
switch allows you to choose
between the wheel and the D-
pad. The rumble effects are pre-
cise, but failing to configure it
properly makes it vibrate con-
tinuously. Rumble effects, 10
programmable buttons, a D-pad
and a choice between hand or
floor pedals for the gas and
brake, for just Rs 1,650 make it
irresistible.

Features: Rumble effects, wheel mounted gas, brake pedals, 10 pro-
grammable buttons, one D-pad, floor gas and brake pedals 
Price: Rs 1,600 Contact: Jupiter Infosys India Ltd 
Phone: 022-2001211/2001212 E-mail: frontech@bom
5.vsnl.net.in Web site: www.frontechonline.com

Frontech Adventure Wheel Logitech WingMan Formula Force

Frontech Adventure 
Wheel

B+B+

Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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The R100 Sports Wheel has a perfect set of fea-
tures and performance. The design is very

well-laid out with ample space
and no cramping of buttons.
The grip has a recess for the
thumb at just the right place.
The steering wheel uses a different
granular material for the palm grips. Two buttons are placed with-
in the reach of the thumb, and the two pedal switches are wheel
mounted and can be used as excellent gear shifters. 

The clamping mechanism holds the wheel firmly in place and
requires just a minute to dismantle. The footboard can be disman-
tled from the main steering unit using a small RJ45 pin. The brake
and the gas pedals use a stiff spring to provide optimum response,
when pressed, requiring a firm push to the floor. The floorboard
however, disappointingly skids a lot when called for duty.

Our R100 had a game port and we had a tough time detecting
it and getting it to work proper-
ly in some games. We even had
to download the drivers from
the Web site. The wheel comes
with a USB version that does away
with these problems. With a price
of Rs 2,250, the wheel is a good
non-force feedback buy. 

Saitek R100 Sports 
Wheel

Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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At first sight, this wheel gives the impression
of being cumbersome and clumsy given

the thousand-odd buttons thrown on its
surface. The buttons for acceleration and
brake are mounted on the wheel, and can
be operated using the thumb. Though this
is good since the buttons are ideally placed
just under the thumb, Typhoon did a somer-
sault by not providing the right type of buttons.
These buttons require to be squeezed hard to keep the accelera-
tion on and the same goes for the brake.

The centre console is a button farm with four P.O.V (point of
view) buttons and 14 other programmable buttons. The Joystick
is centred by stiff springs that jump into action the moment you
turn the wheel to either side. The base is small with four suction
cups for grip, yet the device slips on a smooth surface.

A price tag of Rs 1,080 hits the
sweet spot. The game port version
of this wheel is also available for Rs
990, but with less buttons. We
advice you to stick to the USB ver-
sion since it is simple to install and
gets detected quite easily.

Features: Game port interface, wheel-mounted pedals, two buttons,
floor gas brake pedals Price: Rs 2,250 Contact: Origin Marketing
Pvt Ltd Phone: 022-28801335 E-mail: origin@vsnl.com 
Web site: www.saitek.com

Features: Wheel-mounted gas and brake buttons, 14 programmable
buttons, four P.O.V button and USB interface Price: Rs 1,080 
Contact: Hitech Computers Phone: 022-24927323 
E-mail: bom@hitechit.com Web site: www.anubisline.com

Typhoon Power Wheel

Saitek R100 Sports Wheel

Features: Large steering wheel, four programmable buttons, floor
gas/brake pedals, a gear shifter knob, USB interface Price: Rs 1,650 
Contact: Hitech Computers Phone: 022-24927323 
E-mail: bom@hitechit.com Web site: www.anubisline.com

Typhoon Racer Wheel

The Typhoon Power Wheel does not score well in the aesthet-
ics department. However, the steering surface is coated with

rubber for excellent grip and four buttons are mounted on the two
spokes within easy reach. The highlight, though, is the presence
of a gear shifter knob—the gears move as smooth as a hot knife

through butter. 
The footboard is large with big foot pedals

and the surface is made rough by small plastic
bubbles for a good grip. Good anchoring to

the floor doesn’t let the footboard skid
even when slammed hard.

The steering wheel uses very stiff
spring for centring and hence requires some

effort to steer the car properly. The steering
wheel is very comfortable due to its large size

and is quite responsive. Disappointingly, 
the foot-

board is attached to the main
steering wheel and cannot be
detached or dismantled.

At Rs 1,650 it may seem a lit-
tle steep, considering the build
quality and features it offers. 

Typhoon Racer Wheel B+B+Typhoon Power Wheel
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

B+B+

The Saitek R440 is a mean machine with an aggressive design.
The four programmable buttons are placed on the wheel with-

in easy reach. However, the grip is
not too firm and the wheel
feels a tad cramped.

The footboard is made up
of two parts and the pedal
assembly can be dismantled from
the extended board. One nagging
problem that we came across was that the footboard lacks any
anchoring material. It skids when playing—an obviously irritating
distraction during an intense race. Moreover, the gas and brake
pedal can do with better spring tension to elevate the experience.

The force feedback effects were good but not very precise,
and the wheel made an irritating noise when used. The 
SGE programming utility bundled along, also lacks user-friend-
liness and is tedious to work with. The Saitek R440 Force Feed-
back wheel is a good gaming
tool that lacks the refinement
that one sees in Logitech
devices. At Rs 6,999 it provokes
a second thought, especially
since other wheels from the
same house pack more features
at the same price.

Features: Wheel-mounted pedals, four programmable buttons, floor
gas and brake pedals Price: Rs 6,999 Contact: Origin Marketing
Pvt Ltd Phone: 022-28801335 E-mail: origin@vsnl.com 
Web site: www.saitek.com

Saitek R440 Force Feedback

Saitek R440 Force 
Feedback Wheel

Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

B-B-

Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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Joy to the World

The Indian market has some of the best joysticks present in the global scenario. A glut
of low-priced sticks storm the arena every few months, and then vanish off the shelf
at the same speed. The major players are Microsoft and Logitech with awesome

technologies and prices to match. Companies such as Saitek, Frontech and Typhoon pro-
vide the price-to-performance advantage. We tested 10 joysticks from five different ven-
dors on various parameters.

Digit Test Process
We tested the gaming devices on our test-bench comprising a Pentium 4 2.2 GHz on an
MSI 845E MAX2 BLR motherboard, 256 MB DDR RAM and a 40 GB Seagate ATA IV
7,200-rpm hard drive running Windows XP. Four primary parameters were considered:
features, ergonomics, build quality and value for money. Each parameter was assigned
a weightage of 25 per cent. The overall scores were then calculated from these.
Features: For evaluating the features, we took into account various parameters—a USB
interface scored better than a game port interface. Other features that made a difference
were force feedback, number of axis, the presence of a hat-switch, a push throttle and
the number of programmable buttons.  
Ergonomics: Comfort is of paramount importance when judging the usability of a joy-
stick. We awarded points for a large palm rest at the base of the stick. Sticks with good com-
fortable buttons evidently scored more. The grip and thumb recess made for more points.
Build quality: The build quality was evaluated on various factors such as quality of the
materials used—the ball joint was given prime importance. As far as the button quality
was concerned, we considered the tackiness and the play the button offers—lesser the
play, better the sturdiness and hence higher the score. For overall finish, we looked for
panel gaps and squeaking sounds that are usually present in a bad quality product.

Sitting snuggly in the palm of the hand, the joystick is everyone’s favourite gaming device. We
evaluated this versatile performer to bring you the best

Frontech JIL-1730 Joystick Action

The JIL-1730 lacks in quality and feels too light;
people with small hands may not be able to

reach the head-mounted buttons. The stick does
offer a large palm rest for maximum comfort and has
four suction cups that hold the table firmly.

The head has two sunken buttons on either
side of a centrally placed four-way hat-switch.
The buttons are hard and require a firm push to
operate. The trigger offers a tactile feel with good
response. The joint seriously lacks the punch and
feels too slack. A throttle wheel provides enough throw for linear
throttle control but could be improved upon. Installation is has-
sle-free, but the calibration is a bit of a worry since you need to use
the trim controls present on the
underside of the joystick while
calibrating the X and Y axis.

With a price tag of Rs 1,200,
it’s way too expensive consider-
ing that at the same price one
can get more features with a bet-
ter build quality. 

Features: An unresponsive throttle, six programmable buttons and a
4-way hat-switch Price: Rs 1,200  Contact: Jupiter Infosys India Ltd
Phone: 022-2001211/2001212 E-mail: frontech@bom5.vsnl.net.in
Web site: www.frontechonline.com 

Frontech JIL-1730 
Joystick Action

Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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The entire body of the Josh stick is in dark violet
with a silvery base, making it an absolute stun-

ner. The thumb recess, good amount of thumb rest
and large palm rest pad make it very comfortable even
during long gaming sessions.

Two buttons are mounted on the head along
side the hat-switch and one button is placed under
the thumb for quick-action fire. The trigger button
is smooth. The base is large with suction cups at the
bottom to hold on to any surface tightly. It has a Turbo,
Slow, Clear, Select and Start button alongside a slider that can
be used to vary the rumble effects.

We experienced problems getting the rumble effects since
the drivers could not properly
detect the device. This device
could do much better with more
reliable drivers that can get the
maximum out of it. A price tag of
Rs 1,500 for a rumble stick with a
good design does make it a good
option though. 

Features: Rumble effects, USB interface, two-axis control, a slider for
controlling the rumble effects Price: Rs 1,500 Contact: Jupiter
Infosys India Ltd Phone: 022-2001211/2001212 E-mail:
frontech@bom5.vsnl.net.in Web site: www.frontechonline.com

Frontech JIL-1737 Josh Stick

Frontech JIL-1737 
Josh Stick

Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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■ Joysticks are ideal for playing
flight simulator and space games,
so if you are a great fan of these

don't settle for a game pad.
■ Joysticks are available in many

flavours, but ideally they should have a
hat-switch, a throttle control and at
least six programmable buttons. 
■ Before you buy a joystick, check out
the ball joint to ensure its durability. Do
this by holding the broom stick and
moving it side ways, if the motion is
jerky or sticky, don't buy it. 
■ Before you zero-in on a stick, hold it
to see whether your palm and fingers
feel comfortable, and your fingers reach
the buttons without extending them. 
■ Always buy a stick with a heavy base,
since a light base will skid or trip when
the stick is moved vehemently.
■ If you are an avid fan of flight simula-
tors, go for a stick that has three axes.
This will give you better control over
the rudder.
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Logitech WingMan Force 3DLogitech WingMan Attack 2

This WingMan Force 3D has a button lay-
out similar to that of the Strike Force 3D

with the missing scroll wheel button and a
more compact base.

The trigger button and secondary fire but-
tons are very responsive and a delight to
use during rapid fire sessions. The force
feedback effects are average and not very
pronounced or precise as in the WingMan
Strike Force 3D. The stick also features a third
axis for perfect rudder control. It uses a USB interface to connect
itself to a PC, and does not support a game port. An external
adapter takes care of the force feedback power requirements. 

With a price tag of Rs 4,999 and awkwardly placed 
buttons, the device is expensive for the features that are 
on offer. In case you don't want
a force feedback joystick, try the
WingMan Extreme digital 3D
that sports the same design and
button layout but does 
not incorporate force feedback
while offering game port con-
nectivity.

Features: Force feedback, seven programmable buttons, a concave
hat-switch, three-axis control Price: Rs 4,999 Contact: Aditya
Infotech Ltd Phone: 022-26338555 E-mail: sunil_zarekar@aditya-
group.com Web site: www.logitech.com

The WingMan Attack 2’s jet black colour with a light grey base
makes it stand out from the crowd. Silver buttons with a lit-

tle blue thrown in, highlight the base. It offers a good grip, large
rest pad and an angular thumb rest pad, much like the rest of the
Logitech line-up. The base is unusually heavy,
imparting a very stable feel and making it durable.
The ball joint is stiff and needs a firm push to
jerk it around, making the stick less responsive
while playing an intense game. One good feature is
that the joint is covered by a leather sheet, making
it impervious to dust and grime. The head
assembly consists of only one button and
a hat-switch is sorely missed when playing
a flight simulation game.

This joystick has a good build quality with a
stable base, well-laid out buttons
and an overall good game
response. Costing Rs 1,399, it feels
a tad expensive when considered
alongside other joysticks that offer
features such as hat-switch, two
extra buttons and the most impor-
tant—third axis for Rs 200 less.

Features: Two-axis control, USB interface, six programmable buttons
Price: Rs 1,399  Contact: Aditya Infotech Ltd 
Phone: 022-26338555 E-mail: sunil_zarekar@adityagroup.com
Web site: www.logitech.com

Logitech WingMan 
Force 3D

Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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Attack 2

Features
Build quality
Ergonomics
Value for money
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Logitech has worked hard to make the WingMan Strike Force
3D a flawless gaming peripheral. The placement of buttons

is ideal and the clickable scroll wheel swaps weapons rapidly.
The thumb fits firmly on the sliding throttle which has a good

amount of throw angle. 
However, the design is not ambidextrous. The base

is quite heavy and the force feedback effects are sharp
and quite realistic. But they lack the bite that

Microsoft devices offer. This stick also has sensors
that cut out feedback when the stick is not held.

It however, lacks refined sensitivity.
The installation was a breeze with Log-

itech’s WingMan profiler program handling
everything from installation to calibration. Although not

very intuitive, the software is simple to configure and use. You can
set force feedback effects and
dead zone settings and can also
test the variety of force effects
assigned to the buttons.

WingMan Strike Force 3D
comes at a heavy price of 
Rs 6,999, and falls in the league
of expensive gaming devices. 

Logitech WingMan 
Strike Force 3D

Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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Features: Force Feedback, seven programmable buttons, one click-
able scroll wheel, three-axis control, two programmable hat-switches,
slide throttle Price: Rs 6,999 Contact: Aditya Infotech Ltd 
Phone: 022-26338555 E-mail: sunil_zarekar@adityagroup.com
Web site: www.logitech.com

Logitech WingMan Strike Force

The first welcome detail in the new
SideWinder is the power adapter at the

base of the stick that lets you connect the
stick directly to a power outlet. The base is
made of a granular material for a good grip
and the small rubber pegs sit it firmly on the
table even when jerked around. 

The force feedback effects were pro-
nounced, with every small force being directed to
the stick precisely. Two smart sensors stop the feedback
the moment your hand leaves the stick. Like every Microsoft prod-
uct, you just have to plug the stick to a USB port and load the
accompanying drivers. The SideWinder game controller software
shows the various settings for the forces graphically. If you have a
VIA chipset, you need to install a
small patch for the force feed to
work properly.

This is the ultimate gaming
device money can buy. With a
price tag of Rs 7,500 it is too
expensive for all but the dis-
cerning gamer.

Microsoft SideWinder Force
Feedback 2
Features: USB interface, force feedback, three-axis control, hat-
switch, eight programmable buttons Price: Rs 7,500 
Contact: Trifen Technologies Phone: 022-26236061/6226777 
E-mail: trifen@vsnl.com Web site: www.microsoft.com

Microsoft Force 
Feedback 2 
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

A-A-
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The Microsoft SideWinder Precision 2 is designed exclu-
sively for the Indian gaming market. It incorporates very

few cosmetic and functional changes. The base is smaller,
lighter and funkier than its older counterpart but sports the
same design with a comfortable grip, thumb recess and a com-

fortably-sized palm rest. While the button lay-
out remains the same, one of the most
promising differences is its excellent
throttle. The throttle has a sizeable

amount of throw angle and thus gives a
very linear response.
Since the base was redesigned and made

smaller, it weighs less and hampers the stabili-
ty to an extent; the rubber pegs hold on to the

surface, but the stick has a tendency to trip when
jerked sideways. The presence of a third axis is laudable con-
sidering the price for which it
sells in the market. 

At Rs 1,200, the eight but-
tons, hat-switch, excellent
throttle, third axis and good
build quality. It is reasonably
priced for the causal and ama-
teur gamer alike. 

The Cyborg 3D USB Gold comes with a new
colour scheme, a funky futuristic design, an

all new Saitek Gaming Extension (SGE) pro-
gramming utility and a USB connection. 

It sports an ambidextrous design. The
height of the stick can be adjusted. For
even better customisation, the tilt of
the hat switch can be modified to
bring it closer or take it further from
your thumb. Saitek has thoughtfully
supplied an Allen key that gels into the
body of the stick and is mounted on its back. 

A push throttle is also provided and the trigger button gives
a feather touch operation. The operation of the stick is very
smooth and does not display any signs of jerkiness. 

The accompanying Saitek Gaming Extension (SGE), a pro-
gramming utility, is quite pow-
erful as far as programming is
concerned, but is very tedious
to work with.

This furturistice, feature-
rich, highly customisable
ambidextrous joystick is priced
at Rs 2,990.

Features: Customisable palm rest, tiltable head assembly, eight pro-
grammable buttons, USB interface, push throttle, three-axis control
Price: Rs 2,990 Contact: Origin Marketing Pvt Ltd Phone: 022-
28801335 E-mail: origin@vsnl.com Web site: www.saitek.com

Saitek Cyborg 3D USB Gold

Saitek Cyborg 3D 
USB Gold

Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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Precision 2

Features
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Ergonomics
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Saitek ST330 USB Control Stick
and Throttle

This joystick, in the tradition of all other Saitek joy-
sticks, is ambidextrous in design. The trigger is the

same as used in the Cyborg—feather light, with excel-
lent tactile feedback. The head layout is a
bit awkward and the palm rest pad is small
but provides just enough space.     

The buttons are of good quality with an
excellent tactile feel and good response. The push throttle is pre-
cise and has enough throw-angle for providing linear control over
the throttle. The base is appropriately heavy and stable. This stick
displayed good rumble effects with precise vibrations. It has only
four buttons, rendering itself useless when playing a full-fledged
flight simulator. A hat-switch, which should be a standard fit-
ment on a joystick of this class,
is also completely missing.

Saitek tried to fit in the
excitement of a force feedback
joystick into a price of Rs 2,990
and failed—the stick is over
priced and misses out on a num-
ber of features.

Features: Rumble effects, USB interface, two-axis control, four pro-
grammable buttons  Price: Rs 2,990 Contact: Origin Marketing Pvt
Ltd Phone: 022-28801335 E-mail: origin@vsnl.com 
Web site: www.saitek.com The Typhoon 3D Joystick is cleanly

designed without curves or recesses that
can increase or decrease usability. It is of an
optimum length with a fairly small palm
rest. The button layout is perfect, while
the base is large with five suction cups to
grasp a desk with confidence. The base has
a ring throttle and two turbo fire buttons
relegated into the background as the trigger
buttons, which work smoothly. A third axis offers
perfect rudder control.

A secondary fire button and a hat-switch placed above, form
the head. The hat-switch is very easy to reach and is quite
responsive. The buttons are very tactile, and provide a good feed-
back. The trigger too is a delight to use with absolutely no force
required to push at it. Two buttons are laterally mounted just
under the thumb for easy access. 

The Typhoon 3D joystick is
good where the price-to-feature
ratio is concerned—at a price of
Rs 825, you get the four buttons,
a hat-switch, a ring throttle and
a third axis. 

Features: Three-axis control, six programmable buttons, a push
throttle Price: Rs 825  Contact: Hitech Computers 
Phone: 022-24927323 E-mail: bom@hitechit.com 
Web site: www.anubisline.com

Typhoon 3D Joystick

Typhoon 3D Joystick
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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Saitek ST330 USB 
Control Stick and Throttle
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

B+B+

Features: Three-axis control, eight programmable buttons, hat-
switch and an excellent throttle Price: Rs 1,200
Contact: Trifen Technologies Phone: 022-26236061/6226777 
E-mail: trifen@vsnl.com Web site: www.microsoft.com

Microsoft SideWinder Precision 2 
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Pads to Launch your Game on

Gamepads are the most versatile of all gaming devices since they operate with
almost every game. The cheapest gamepad for our tests came from Frontech. The
best of the best came from the Logitech stable with cordless technology on

offer, albeit at a price. The other competing vendors were Typhoon and Saitek. The ones
that really shocked us were the ones from Microsoft which were aggressively priced.

Digit Test Process
We tested the gaming devices on our test-bench comprising a Pentium 4 2.2 GHz on an
MSI 845E MAX2 BLR motherboard, 256 MB DDR RAM and a 40 GB Seagate ATA IV
7,200-rpm hard drive running Windows XP. Four primary parameters were considered:
features, ergonomics, build quality and value for money. Each parameter was assigned
a weightage of 25 per cent. The overall scores were then calculated from these.
Features: For evaluating the gamepad features, we took into account various parame-
ters—a USB interface scored better than a game port interface. The presence of both
analog and digital controllers fetched some extra points. The number of programmable
buttons was also taken into account. The presence of a throttle and niche features such
as rumble effects, motion sensor and cordless technology got some extra points. 
Ergonomics: We awarded more points to gamepads that had large comfortable grip
handles with anti-slip materials. Gamepads with a comfortable grip that offered opti-
mum angle between the two handles was suitably rewarded. The spacing of the buttons,
the angle at which they are placed to the thumb, etc was also taken into account. 
Build quality: The build quality was evaluated on various factors such as quality of
materials used, button quality and feel, etc. For overall fit and finish, we noted the panel
gaps, the sturdiness of the battery compartment flaps and the squeaking made during
a good thrashing.

The often sidelined gamepad is slowly comming into its own. We invited the best to thrash it out in
our tests and here we bring you the results

The Fantasy pad from Frontech features the patented silver-
black two-tone colour finish. The handles are too close to

each other and rather too big. The D-pad has a good tactile feel
and quick response. The buttons are not properly laid and the
analog sticks are placed very close to them. The analog sticks are
over rubberised, making them sticky and uncomfortable when
used for long periods. The four shoulder-mounted trigger but-
tons are too loose and very tacky.

A mode button toggles the game pad between analog and dig-
ital mode. A small LED just above the mode button indicates the

operating mode. To install the pad, plug into a USB port and
load the accompanying driver. The pad can be cali-

brated through
the game
cont ro l l e r

options in the
control panel. The JIL-1736

is flawed and certainly not
worth any serious gamer’s
attention, even at Rs 850.

This Rumble Pad was the only wireless
contender in our tests. It is quite

heavy but this doesn’t affect the game-
play or strain you. The analog sticks are
extremely smooth and responsive. The
throttle is placed just above the right trig-
ger button and provides a good response. 

The pad uses 2.4 GHz radio frequency
signals and can be used from at least 20
feet away. It showed absolutely no lag time
and bundles four AA Duracell
alkaline batteries. The installa-
tion is effortless and the pro-
vided software takes care of the
calibration and button-pro-
gramming.   

This one offers the best fea-
tures, albeit at a price—Rs 4,999. 

Logitech Cordless 
Rumble Pad
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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Fantasy Pad
Features
Build quality
Ergonomics
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Features: Eight programmable buttons, two analog controllers, one
D-pad Price: Rs 850 Contact: Jupiter Infosys India Ltd 
Phone: 022-2001211/2001212 E-mail: frontech@bom5.vsnl.net.in 
Web site: www.frontechonline.com

Frontech JIL-1736 Fantasy Pad

Features: Cordless, rumble effects, D-pad, 11 programmable but-
tons, two analog controller sticks, a slider throttle
Price: Rs 4,999 Contact: Aditya Infotech Ltd 
Phone: 022-26338555 E-mail: sunil_zarekar@adityagroup.com
Web site: www.logitech.com

Logitech WingMan Cordless 
Rumble Pad

■ Before buying a gamepad,
check the interface on your com-
puter. If you have a USB port, go

for a USB device; else go for the
old game port interface. 

■ Ideally, a gamepad should have at
least six standard buttons, one eight-
directional D-pad and two shoulder-
mounted triggers. 
■ Gamepads are more suitable for play-
ing arcade games, side scrolling games
or sport simulation games. Hence don't
buy a gamepad if you want to play only
flight simulations.
■ For smooth and linear control, opt for
game pads with analog controller
sticks.  
■ Hold the gamepad in your hand, and
check whether you are comfortable
with the button layout, D-pad, etc.
■ Check the length of the cable—it
should be at least 4 feet long.



test drive ■
■ gaming devices

62 MARCH 2003

Logitech W ingMan Gamepad Logitech WingMan Rumble Pad

Logitech has carved a name for itself over the years by setting
a standard of sorts for all the features a device should have.

The Extreme wears stunning blue transparent buttons and D-pad
on its black body. The six standard buttons are placed in two

rows. A small dual colour LED indicates the status of
the tilt sensor. The winning feature is the

motion sensor control—the gamepad
senses your motion and takes the

directional input for the pad. However,
the analog controller is sorely missed.

The installation is fairly simple as it supports both, a
game port and a USB port. WingMan Profiler, the bun-
dled software, provides a simple graphical interface to
program the buttons and calibrate the gamepad as per

your preferences. You can even download profiles for
you favourite game directly from the company’s Web site. It
brings along a demo version of
Rogue Squadron3D Elite Missions.

With good support for game
profiles and user-friendly soft-
ware, this device is more suited to
serious gamers, considering that
it costs Rs 2,999. 

Features: Excellent tilt motion sensor, 11 programmable buttons, one
D-pad, one macro button, USB interface Price: Rs 2,999  
Contact: Aditya Infotech Ltd Phone: 022-26338555 
E-mail: sunil_zarekar@adityagroup.com
Web site: www.logitech.com

The Logitech WingMan Rumble Pad is just the old Logitech
joystick with a few enhancements in a different moulding.

The first thing to catch the eye is the well-spaced lay-
out of the buttons and controllers.

The buttons need a firm push to work, but the
analog sticks are very accurate, smooth and respon-
sive. The slider throttle was a bit loose and
lacked the stiffness, but offered good
control over the throttle, especially in flight
simulators. The rumble effects can be toggled
by the rumble button. The mode button can
be used to switch between the analog and dig-
ital mode. 

The rumble effects were appropriately stimulated by
every game detail. It can be connected using the long cable to a
USB port and does not support
a game port. The installation
and calibration was a breeze
with the accompanying Wing-
Man Profiler utility.

This joystick is priced at Rs
2,599, which is quite reasonable
for a feature-rich device.

Features: Rumble effects, two analog stick controllers, a slider throt-
tle, 11 programmable buttons, one D-pad Price: Rs 2,599
Contact: Aditya Infotech Ltd Phone: 022-26338555 E-mail:
sunil_zarekar@adityagroup.com Web site: www.logitech.com

This Microsoft gamepad is dull grey in colour with black but-
tons and D-pad. The first major difference from the earlier

pads is that the sloping body has been replaced by a flat one
and the handles have been shortened. 

The button layout is similar to the older ver-
sions and is tweaked for maximum comfort

and efficiency. 
The D-pad was the only let-down—it

is quite hard, has a very restricted motion
and lacks tactile feel. The new features
include a mode button and a USB inter-

face; a small green LED indicates the
power status. 

The sidewinder can be connected to the USB port
using its long cable. It does not bring along any software, taking
for granted that every user will be running Windows 98 or the
Me operating system. The installation is quite hassle-free and
the calibration can be done
from the game controller set-
tings in the control panel.    

The price tag is the real
clincher—the gamepad costs
only Rs 700—a package hard 
to ignore.

This SideWinder gamepad is the most basic
offering from the software giant. The first

thing to hit you is the unusual design—the
body shell is made up of hard plastic with
strips to make it stiff that create a striation
effect. The build quality is sturdy with no squeaks even
after a good thrashing. The body is slightly tilted on either
side, with the D-pad on one side and the four buttons on
the other. The triggers are placed just under the control of
your first finger and they provide an excellent tactile feel.

This SideWinder features an eight-way D-pad, four pro-
grammable buttons and two triggers. Surprisingly, the D-pad
does not provide good control in all directions due to a slackness
in its operation. The buttons are placed well within the reach of
small hands and the triggers offer precise control. This is a plug-
and-play USB device that gets
automatically detected once
the drivers are installed. What
makes this product an excellent
buy is the fact that Microsoft has
taken every small detail into con-
sideration to offer a very com-
fortable device for just Rs 700.

Microsoft SideWinder
Game Pad Plug and Play
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL

B+B+

Logitech Extreme
Features
Build quality
Ergonomics
Value for money
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Microsoft SideWinder
Features
Build quality
Ergonomics
Value for money
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Logitech WingMan 
Rumble Pad
Features
Build quality
Ergonomics
Value for money
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Features: Eight programmable buttons, one D-pad, USB interface
Price: Rs 700 Contact: Trifen Technologies 
Phone: 022-26236061/6226777 E-mail: trifen@vsnl.com 
Web site: www.microsoft.com

Microsoft SideWinder Game Pad

Features: USB interface, six programmable buttons, one D-pad
Price: Rs 700 Contact: Trifen Technologies 
Phone: 022-26236061/6226777 E-mail: trifen@vsnl.com 
Web site: www.microsoft.com

Microsoft SideWinder Plug and
Play Game Pad
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Saitek P220 Digital Pad

The Saitek P220 Digital Pad looks similiar to the Sony PlaySta-
tion One consoles. The D-pad is a round button with four

snouts and a dedicated digital throttle button is present in the
centre, above which four LEDs indicate the increase or decrease
of the throttle. The pad is too light for its own good.  

The buttons and the D-pad are silver in colour and make
a striking contrast to the grey body. The feel of the D-

pad and the buttons is fairly good but they tend
to feel a bit cramped. The throttle response
is not very linear and the increments in

jumps are jerky. The trigger buttons are
well-placed but need a firm push to work.

The device uses a USB interface and also comes with a
long cable. The calibration can be done via the game con-
troller options in the control panel, but a driver must be
included for utilising its full potentials, such as program-
ming the buttons.

Saitek has made the
product half-heartedly, without
much thought for aesthetics.
Costing Rs 990, it does have
some chances, mainly from the
economical aspects. 

Features: Eight programmable buttons, one D-pad, a digital throttle
button Price: Rs 990 Contact: Origin Marketing Pvt Ltd 
Phone: 022-28801335 E-mail: origin@vsnl.com 
Web site: www.saitek.com

The Cyber Motion 3D Gamepad comes with in-built sensors
that respond to the directional input of hands. It has a silver

grey colour combination, while the D-pad, buttons and throttle
are jet black. The handles are long enough for a giant and the

buttons are perfectly placed. The ergonomics is spot-on
with all control placed in the right place. The but-

tons are tear-drop shaped and placed right under
the right thumb. One of the most innovative
features was the centrally-placed throttle,
which is a rubberised ring and has almost
thrice the throw of any other device we test-

ed. This is very important since you get a very linear throttle
response, as you can increase the throttle in small increments. 

It can be installed using either the USB interface or the
game port adapter. The provided drivers take care of the
remaining installation; the calibration can be done through
the game controller options in the control panel. You can
adjust the sensitivity of the
motion sensors and the other
controllers.

Cyber motion 3D is an excel-
lent buy if you want a gamepad
with fairly good sensitivity at the
price of Rs 1,200.

Saitek P220 Digital Pad
Features
Build quality
Ergonomics
Value for money
OOVVEERRAALLLL
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Typhoon Cyber Motion 3D
Features
Build quality
Ergonomics
Value for money
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Features: Tilt motion sensor, eight programmable buttons, one 
D-pad, a ring throttle, a USB interface Price: Rs 1,200 
Contact: Hitech Computers Phone: 022-24927323 
E-mail: bom@hitechit.com Web site: www.anubisline.com

Typhoon Cyber Motion 3D
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There’s a common perception that anything that’s provided free is useless or just not up to the mark,
or simply redundant. We do agree that, in general, there's nothing called a free lunch. However, our
experience with free software on the Net has made us think again. But first, let's take the case of your
close friend who gives you a gift on your birthday. Would he or she ever think of giving anything less
than something that’s of value to you? Software developers are a strange lot. They may not be your
close friends but they act as one. Whether you need a free OS, free database, free Web server, free
image-editing software, free audio or video editor, free tweaking tools, free browsers, free download
accelerators, free Java or Perl scripts, and so on… They simply keep churning it all out. Since sifting
through the multitudes will be a herculean task for any individual, our team has done this task for you.
We believe that if you have these software on your desktop, you will not need anything else. The proof
of the pudding lies in the eating. So what are you waiting for?

All the
software

you’ll ever need*

*and it’s FREE!

ILLUSTRATION: Mahesh Benkar
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ClickTray Calendar

Acalendar, address and reminder pro-
gram—all in one. This is what Click-

Tray Calendar is. It has a user-friendly
interface and can be activated from the sys-
tem tray. Now you can use almost unlim-

ited notes, colourise each day individually,
enter repetitive tasks, and much more. 

This release also provides alarms, a
notice overview, a calendar printer, and
an address book. The new features include
automatic holiday calculation, text book,
categories in the To Do List, a wider inter-
face and a new design. A birthday and
anniversary list has also been added. 
Size: 2.59 MB

WordWeb

WordWeb is a free cut-down version
of WordWeb Pro. It includes a com-

prehensive English thesaurus and dic-
tionary, and can be used to look up words
from within most programs. 

Simply type in your word and press
the search button—one frame displays
the definition, the other shows syn-
onyms, antonyms, type of, types, part of,
similar and attributes. 
Size: 4.6 MB

FreeCard 2.0

Ah! It’s you’re girlfriend’s birthday.
You’ve still not sent her a card. She’s

going to be mighty annoyed. Don’t panic.
You can still send her an electronic card—
that too a jazzy one at no expense. You
can use FreeCard, which lets you create
electronic greeting cards with graphics or
video, text, music and sound to send with
e-mail or on diskettes. 

FreeCard takes standard Win-
dows bitmap (BMP), video (AVI),
MIDI music (MID), WAVE sound
(WAV) material files and creates
multimedia e-cards. Each created 
e-card is a self-contained, stand-
alone Windows executable (EXE)
file. This program creates very
compact e-cards (starts at 70 KB)—
ideal for sending by e-mail or from
Web sites. It includes a Watermark-
ing utility for embedding, identify-

ing and linking information to your graph-
ics and video materials. 
Size: 0.534

NATATA eBook Compiler

If you want to create an eBook, you can
try getting started with Natata eBook

Compiler.
It makes the process of creating an

eBook very easy-just go through all the
tabbed windows, choose configuration fea-
tures and navigation controls, and then hit
‘Compile’.

You can use it to compile eBooks,
offline Web pages, HTML photo
albums, presentations and more. 

There are a few nifty things
you can do with this eBook com-
piler. For instance, you don’t have
to re-type all your settings each
time you want to create a new
version of an eBook. Simply save
all your settings and open your
project at any time you wish. The
interface uses a step-by-step
approach that guides you through
the process of creating your com-
piled file. Additional features
include password protection,

print disabling, custom messages and
icons.
Size: 1.23 MB

Advanced File Organizer

Calling for a file from your computer,
which your boss needs urgently, is

often a time-consuming task. Especially if
you had stored the file without applying
much thought. Here’s a professional—the
Advanced File Organizer—to help you
streamline this chore. It’s a powerful, yet
easy-to-use cataloguing utility that helps
you find the location of any file stored on
a removable media or on your hard drive
in a matter of seconds. 

The program can work with all kinds
of media recognised by Windows as
drives: CD-ROMs, DVD-ROMs, Memory
Stick cards, ZIP disks, floppies, hard
drives, network drives, etc. This utility
organises files and folders into a hierar-
chical tree and lets you handle archive
files as ordinary folders. 

The program features powerful search
capabilities and has a built-in reporting tool
that lets you create and print reports that
summarise information about the indexed
media. You can also export search results to
the CSV format and analyse them with MS
Excel or other tools that recognise this for-
mat. This is a free-to-try version.
Size: 1.17 MB

Home
Free goodies on your home PC should include a calendar, a dictionary and a thesaurus. This, of
course, does not mean that we did not think of music and audio. We simply packed all that stuff
in the Multimedia category to show you how valuable home entertainment is. But there are plen-
ty of other things you can do. We thought you might want to send an electronic greeting card to
someone you treasure. There’s a cool tool towards that end. There’s also software to make you
organise your day. Best of all, if the weekends bring out the novelist in you, try to publish an

ebook. We, at Digit, promise to be your first readers

Manage your tasks with ClickTray Calendar

Advanced File Organizer: Locate files in a jiffy
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Acrobat
Reader 5.1
You simply need to
view PDF files. Version
5.1 includes capabili-
ties that will enable e-

government initiatives, and the ability to vali-
date signatures and open file attachments
from directly within Acrobat Reader. Also,
when windows are resized, text in tagged
Adobe PDF files is rearranged to fit the win-
dow for better onscreen reading.
Size: 8.6 MB

DirectX 8.1
DirectX is a technology that enables higher
performance in graphics and sound when
you’re playing games or watching video on
your Windows PC. DirectX helps experience
better 3D graphics, immersive music and
audio effects on your computer. It plays a
role in many functions, including 3D render-
ing, video playback, still and motion capture,
TV Viewing applications, joystick and mouse
interfaces, networking for multiplayer games
and lots more. 
Size: 19.1 MB

IE 6.0  + SP1
This latest release includes an Advanced

Search bar, an Image Toolbar for quickly and
easily saving images in e-mail or from the
Web, and the Contacts bar which allows
MSN Messenger Service members to use
instant-messaging features from within the
browser window while they surf the Web. 

The Media Bar provides a simple user
interface for locating and playing media
within the browser window. IE 6 includes
Outlook Express which has added some
security features. You can now block any
executable attachments, compressed files, or
Visual Basic Scripts, commonly associated
with e-mail viruses. 
Size: 128 MB

Irfanview 3.80 + Plugins
Irfanview 3.80 is an image viewer and con-
verter. It is a 32-bit graphic viewer for Win-
dows 9x/Me/NT/2000/XP. It is the first
graphic viewer with multiple (animated) GIF
support, multi-page TIFF support, and multi-
ple ICO support. It also includes support for
Apple Quick Time. A plugin is available for
Windows Media Player support.
Size: 4.3 MB

JRE 1.4.1
The Java Runtime Environment is a subset of
the files included in the Java Development

Kit (JDK). It does not include the compiler,
the debugger or related tools. Instead, it pro-
vides the minimum runtime for Java technol-
ogy-enabled applications (that is, the JVM,
JFC, JIT and supporting files).

It provides a Java compatible environ-
ment for today’s popular Web browsers. It
enables users to direct applets or JavaBeans
on their Web pages. That translates to con-
sistency and reliability when running applets.
Other features include full Java 2 SDK Stan-
dard Edition v 1.3 support, full Java compati-
ble support, a future-ready architecture and
a Java Plug-in Software HTML Converter.
Size: 7.64 MB

QuickTime 6
This latest release of Apple’s digital media
software for both Mac and Windows-based
computers delivers good quality for creating,
playing and streaming audio and video con-
tent over the Internet. With support for
MPEG-4 Video, MPEG-4 AAC Audio and all
earlier supported formats, Apple is revved up.
The new QuickTime 6 Instant-On tool starts
playback without waiting for buffering and
the Skip-Protection technology makes video
and audio streaming on the Web noticeably
faster and smoother.
Size: 10.5 MB

Internet
What are the essential ingredients of a rich, entertaining and fulfilling Net experience? Permit us to
spell it out for you by anticipating your needs. You hate filling forms. You desperately want to avoid
spam. You want to know more about alternatives to Internet Explorer and Netscape, and are yet
unaware of offline browsing software. You want to know which are the cool download managers
and want to expand your Outlook to other e-mail clients. You want to engage in simultaneous and

instant chatting with all your friends, and are overwhelmed by the plethora of bookmarks and URLs. You want to know
more about file-sharing programs and lastly, want to kill those irritating pop-ups. We have the right stuff you need. Read
on…they’re Free!

Crazy Browser

What can you expect from a browser
that is less than 1 MB? Sounds

crazy? Maybe that’s why it’s named so.
Whatever, it can do a lot. Crazy Browser
is a fully multithreaded Web browser and
it means that you can open several Web
pages simultaneously in one session. It is
customisable, providing options for
changing the way Crazy Browser looks
and operates. 

This version can handle multiple

monitors and has tab status indi-
cators. Annoying ad windows
can be removed automatically
and multiple pages can be saved
and reopened together. 

This browser has full support
for P3P privacy policy and zone-
based security assignments. You
can turn loading of multimedia
data on/off with a single click.
And you can make it your default
browser. Not a very crazy idea.
Size: 0.699

Crazy Browser supports XP themes, P3P privacy and
JavaScript error suppression

Essentials



Netscape 7.01

Netscape 7.01 incorporates Mozilla
features selectively. It includes

tabbed windows and a one-click search.
The tabs sit just below the menu bar and
let you switch among unlimited open
Web pages. In addition to high-speed
browsing and instant messaging capabil-
ities, Netscape features Quick Launch,
which reduces the browser startup time;
and improved instant messaging, includ-
ing support for Buddy Icons, file transfers,
and Buddy Alerts. 
Size: 30.8 MB

Opera 7.01

Opera is a fast and very popular alter-
native browser to Microsoft and

Netscape. It’s quite versatile and includes
a newsreader. You can run multiple win-
dows even at startup and special features
are included for users with disabilities.

Its user interface has received a major
overhaul, with a new startup dialog, new

default buttons and skins, and panels in
a blue and white colour scheme that can
be changed back to the classic Opera look
or another design. It handles non-stan-
dard pages using DHTML

Opera now offers one-click login to
password-protected sites.Changing the
look of a browser has never been easier
with Opera’s new one-click skin install.
For keyboard-lovers, Opera makes it pos-
sible to navigate entirely with keyboard
shortcuts. Its mail client automatically
categorises and sorts e-mail messages, has
an integrated spam filter and supports
POP3, IMAP and ESMTP.
Size: 12.6 MB

Naviscope 8.7

Naviscope is a nice compact utility that
helps you browse faster. It achieves

acceleration through five advanced tech-
niques: prefetching, DNS resolution
caching, persistent connections,
MTU/RWIN optimisations and advertise-
ment blocking. In addition to blocking
advertisements, Naviscope can also block
cookies, backgrounds, blinking text,
Javascript and sounds.

Naviscope has a popular SiteMapper
that allows you to navigate a Web page
before your browser even displays it. Using
Naviscope, you can perform Internet diag-
nostics, obtain Web site registration infor-
mation and even stop individual objects
from loading.  
Size: 0.614

Eudora 5.2

This e-mail client is available as a full-
featured free version, but you have to

put up with ads in the interface’s lower-
left-hand corner. It has a nice feature called
MoodWatch, which analyses messages on
the fly, and rating them on a flame scale
from ice cube to three chilli peppers. You
can see the rating as you type, and you’ll
be warned before sending that the message
might be offensive. Eudora also includes a
way to send voice messages via e-mail as
well as very powerful filter and search fea-
tures. Eudora 5.2 features even greater fil-
tering to protect users from aggressive
quantities of junk mail.
Size: 6.13 MB

Free Agent

Free Agent is a free newsgroup reader
that provides multipane viewing, and

news can be read online or offline. Other
features include flexible article purging,
database compacting, carbon copying for
e-mail and article posting, editing of all
fields, and cancelling of posts.

One of Free Agent’s best features is the
ability to extract information from anoth-
er newsreader during setup so that the user
doesn’t have to input the same informa-
tion over and over again. 

Additional features include quick find,
send mail, word wrap, quick purging, and
automatic ‘catching up’. With Free Agent
v1.93, several essential features have been
added, including improvements in overall
speed, database compression, and database
purging.
Size: 2.29 MB

WebStripper

WebStripper is an offline browser that
allows you to copy Web pages or

entire sites to disk for viewing offline. It
retains the HTML links, which you would
otherwise lose if saving from the browser.
It is fast and allows you to download many
items at once. The program offers several
options to filter what is downloaded by file
type/size including a ‘text only’ option. 

Additional features include the abili-
ty to only download new or updated
pages, keep a ‘What’s new’ list, a file
explorer and more.
Size: 1.74 MB

JetLinks

JetLinks manages Internet bookmarks,
links, URL collections or favorites. Fea-

tures include multiple browser compati-
bility, system-wide hotkeys, XML-based
storing of bookmarks in separate files,
URL and link import from HTML, plain
text and open browser windows. Jet
Links has a highly-configurable user
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RealOne Player 2
RealNetworks’ RealOne Player 2.0 is a play-
back tool for all major media formats. It
includes high-quality video playback, a music
jukebox, a 10 band graphic equaliser, a built-
in Web browser and an improved radio tuner
function. It plays well on all Windows
flavours, but you need a plugin to create
WMA files. The latest release features Univer-
sal Playback, so you can play QuickTime or
Windows Media Player content encountered
while surfing within RealOne’s integrated
browser.
Size: 7.97 MB

Windows Media Player 7.1
Microsoft Windows Media Player 7.1 consists
of seven features in a single application: a CD
player, an audio and video player, a media
jukebox, a media guide, an Internet radio
tuner, a portable device that you can transfer
music files to, and an Audio CD burner.  

It adds Windows Media Audio 8 (WMA8)
encoding, Windows Media Audio and Video
8 decoding, new smart transcode support
for high-quality transfer to portable devices,
and other enhancements and bug fixes. It
should not be installed on computers run-
ning Windows 95 or Windows NT 4.0.
Size: 9.94 MB

Get the relevant newsgroup postings with 
Free Agent
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interface and complete online help in
HTML help format.

This version features advanced han-
dling of duplicate URLs with the new alias
mechanism, and partial support for
Netscape 6. Many bugs have been fixed,
making the program stable on Windows
9x platforms.
Size: 2.49 MB

Pop-up Stopper 2.9

You can stop pop-up windows with
this latest upgrade. There is no need

to adjust proxy settings, or add sites to a
list. The user settings allow various pop-
up notifications, such as a flashing icon
or new, fun sounds. Simply press the
[Ctrl] or [Shift] key to allow selective
pop-up windows, but most new links
should now open automatically.

Pop-up Stopper is not advertising sup-
ported, nor does it require registration, and
no information is collected from or about
product users. 
Size: 0.454 MB

Spybot-Search & Destroy 1.1

SpyBot-S&D searches your hard drive for
so-called spy- or adbots—that is, little

modules that are responsible for the ads
that many programs display. Many of these
modules also transmit information, includ-
ing your surfing behaviour on the Internet.
If SpyBot-S&D finds such modules, it can
remove them. It also removes usage tracks,
which makes it more complicated for
unknown spybots to transmit useful data.
The list of last visited Web sites, opened
files, started programs, cookies, all that and
more can be cleaned.

Spybot-S&D also contains some rou-
tines to find and correct invalid entries
(regarding links left over from software

uninstalled long ago, for example) into the
registry.
Size: 2.31 MB

Spinner Plus

Spinner Plus is a free Net music player
that gives you access to more than

350,000 songs that are categorised into
more than 140 channels of music. Spinner
Plus operates independently of a browser—
no additional software or plugins are need-
ed. It also features 21 channel presets, a pre-
set mouse over feature that lets you know

what’s playing on other channels,
extensive keyboard and toolbar
controls, skins, and an animated
display. Other features of Spinner
Plus include complete artist, song
and title information, and the
ability to purchase CDs directly
from within the player.
Size: 2.62 MB

Windows Media
Stream Recorder

Windows Media Recorder
allows you to record

streaming video and audio clips from the
Internet and save them to your hard drive
so you can play the clips from your com-
puter without the interruptions inherent
in Internet connections. 

Media clips can be recorded while
browsing the Net or from Windows Media
Player play lists. The program detects the
beginning, the end and names of the
media such that multiple clips can be
recorded automatically. It supports
Microsoft Windows Media Player video
and audio stream formats.
Size: 0.28 MB

AI RoboForm

If you hate filling Web-based forms, AI
RoboForm does just that. It is a password

manager and one-click Web form
filler with serious Artificial Intelli-
gence inside. It memorises online
passwords, automatically logs you
into a Web site, generates random
secure passwords, fills registration
forms from identities, encrypts
sensitive information using DES,
prints a list of your passwords on
paper, and allows easy backup and
restoring of passwords. 

You also can set up the pro-
gram so it only fills out part of a

form, leaving you flexibility to manually
enter values for a few fields. Finally, the pro-
gram also saves your user IDs and pass-
words. 

Version 5.0 is a major upgrade with
about 20 major changes and more than 100
small changes.
Size: 0.608 MB

Cloudmark SpamNet Outlook

Cloudmark SpamNet Outlook add-in
saves you time and frustration by stop-

ping spam automatically. The program runs
invisibly in the background of your e-mail
program. All you need to do is delete the
spam from your own inbox. 

Just like a P2P file sharing network,
SpamNet allows you to share the spam you
receive with a global database that blocks
those messages before they arrive in your
inbox. Version beta 6e features improved
handling of critical and non-critical Out-
look errors, better ability to process large
numbers of incoming messages, and other
enhancements and bug fixes.
Size: 1.6 MB

Trillian 0.74

What if you could chat with all your
friends simultaneously, especially if

one is on Yahoo!, the other on MSN and
the third on ICQ? Trillian does just that. It
lets you simultaneously connect with
Yahoo! Messenger, MSN Messenger, ICQ,
mIRC, and AIM. By importing your pass-
words, buddy lists, various client prefer-
ences and other chat specifics into its own
simple interface, Trillian acts as a single
hub for all your chat traffic.

You can check supported e-mail
accounts with a single click, view detailed
event logs for each client and, of course,
chat your brains out. Plus, there are indi-
vidual options for each supported chat
client. Trillian supports skins too, but they
could be easier to install. Version 0.74

Say no to pop-up windows

Stay connected with Trillian



includes bug fixes and other minor
enhancements.
Size: 2.4 MB

ICQ Pro 2003a

This latest release includes ICQphone, a
feature that incorporates IP telephony

functions into the ICQ program. Users can
initiate and participate in PC-to-PC and PC-
to-phone calls. Users can also use the SMS
facility, send wireless-pager messages, view
current information on ICQ channels and
integrate ICQ with Outlook.

This version allows you to move
instantly from the Pro to Lite versions just
by clicking ‘Switch to ICQ lite’ from the
Main menu, and the shared ICQ prefer-
ences and password make it easy to move
between Lite and Pro versions without los-
ing your settings.
Size: 3.79 MB

MSN Messenger

MSN Messenger is an instant-messag-
ing program that notifies you when

your friends are online so you can send
messages or chat with several friends at
once. It also notifies you when you have
new e-mail in your Hotmail account and
allows you to access your inbox with the
click of a button. At any time, you can see
a list of all users who have added you to
their lists, and you can easily block them if
you choose to do so. MSN Messenger also
offers integration with Outlook Express 5.0.
Size: 4 MB

LeechGet 2002 1.0 .1440

LeechGet is a download manager, that
uses a Microsoft Outlook-like user

interface and seamlessly integrates into
Internet Explorer, allowing you to easily
start and manage your downloads. It also
includes a full-featured FTP client to
download, delete and manage files on
FTP servers.

LeechGet provides automatic down-

loading, resuming of broken downloads,
download timer, automatic hang-up and
shutdown and more. 

A built-in Web parser even lets you
download a complete Web site inclusive of
all images and scripts. LeechGet also pro-
vides a history of your downloaded files,
sorted by day, week and month. Addition-
al features include a file drop icon and
bookmarks.
Size: 2.2 MB

KaZaa Lite

KaZaa Lite, a file-sharing client, is a
slimmed-down version of KaZaa. It is a

P2P file sharing application that does not
contain any spyware or adware.

Unlike Napster, where file types were
restricted to music files, KaZaA Lite allows
these shared files to be all sorts of differ-

ent media: audio files, video clips, photos
and even software applications. If you
have a band, getting your tracks on the
KaZaA (FastTrack) network is a great way
to get your music known and recognised.
Budding filmmakers can have the same
sort of exposure.

KaZaA Lite can download sin-
gle files from multiple users to
ensure you get the most efficient
use of your bandwidth.

The latest version includes
K++, which increases your search
possibilities. You can also do multi-
source downloads (maximum of
40 instead of eight); find more
sources for a download every 4
minutes (instead of 10); and no dll
files are loaded anymore.
Size: 2.53 MB

eDonkey

eDonkey is a file sharing program
with no central server. It allows you

to transfer any type of file with anyone
on the eDonkey network. It automatical-
ly resumes interrupted transfers from
alternate sources. It even introduces ways
to share a collection of files together so
you can be sure to get all the songs in an
album or all parts of a movie. 

eDonkey is smart enough to tell the
difference between two files, even if
they have the same file size and name.
This unique file identification also
allows you to create links to the files you
have, sending them to friends or family,
or put them on your Web site, so users
who have eDonkey installed as well can
download that exact same file from you,
or any other user who has it.
Size: 0.865 MB
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Manage your downloads with LeechGet

Multimedia
Let’s admit it. We all love music. But it’s one thing to just play songs and it’s an altogether different
thrill to edit and ‘own’ them. And so is the excitement of extracting MPEG streams from CD images,
converting VCD files to MPEG, correcting MPEG errors, and so on. We promise you that by the time
you finish reading this section, you will have the means to fulfil these ends. We have a media player,
audio and video editors, codecs to make your life a breeze, and even a data recovery tool to recover

data from CD/VCDs if they have gone bad. Now isn’t that music to your ears?

A2 Media Player 2.21

A2 Media Player mixes Sonique’s non-
traditional interface with Winamp’s

right-click menus and mouse over help. It
features a mixer, an equalizer, skin support,

visualisations, ID3 tag editing and support
for PLS and M3U play lists. You’ll also find
full-screen karaoke emulation with syn-
chronised lyrics and image display, plus
system tray transport controls. It can han-
dle audio CDs as well.

It supports VCD, MPEG and AVI video
playback. It also supports playback of
mixed media files in one playlist. It now
has image/video capture and screen cap-
ture features, a media file manager for
building media libraries to collect, search,



and modify media files, and to copy, move,
and delete media files, and a download
manager for downloading A2 resources
such as skins, language files and demos. 
Size: 7.18 MB

Audacity

Audacity can record sounds, play
sounds, import and export WAV, AIFF,

MP3 files, and more. You can use it to edit
your sounds using Cut, Copy and Paste
(with unlimited Undo), mix tracks togeth-
er, or apply effects to your recordings. 

It also has a built-in amplitude enve-
lope editor, a customisable spectrogram
mode and a frequency analysis window for
audio analysis applications. Built-in effects
include Bass Boost, Wahwah, and Noise
Removal, and it also supports VST plugin
effects. Audacity mixes automatically. 

Audacity does not run on Windows 95.
Windows 98 or higher is required. If you
want Audacity to create MP3 files, you will
have to download LAME MP3 Encoder
Library.
Size: 1.55 MB

dBpowerAMP Music Con-
verter 9.0 + codec plugins
for different formats

dBpowerAMP Music Converter is one of
those must-have utilities for audio-

philes. You can use it to convert your audio
files from one format to another—just
right-click on a file and select Convert To.
It lets you rip from audio CDs, edit ID tags
and display track info, and record from LPs

(optional install) and tapes. It also
gives pop-up information in all sup-
ported media files within Explorer.
dBpowerAMP Music Converter sup-
ports a wide variety of formats
through plugins.

We have included the plugins
for dBpowerAMP Music Converter
that will let you encode audio files
into the Ogg Vorbis, WMA 9 and
MP3PRO formats. Some of the
prominent features of this tool
include a skinnable interface, dif-
ferent types of play lists support,
three types of controls: normal applica-
tion window, mini tray control and con-
trol bar that sticks to the title bar of other
windows and equalizer. Connect it with
MP3 burning software such as MP3 CD
Converter and you have a complete MP3
solution.
Size: 6.23 MB

n.player 1.1.0.2

n.player is a small and compact media
player with support for several pop-

ular formats, including DVD playback. It
can play Audio CDs, video, MP3 and DivX
with support for subtitles and WinAmp
play lists. 

It comes with a handy toolbar option
that puts the player controls directly into
your taskbar. Additional features include
auto-skip of DVD intros, free db support,
favourites manager, skin support, on-
screen display and much more. It requires
DirectX 8.0
Size: 1.04 MB

VCDGear 3.06

VCDGear is a program designed to allow
a user to extract MPEG streams from

CD images, convert VCD files to MPEG,
correct MPEG errors, and more—all in a
single step. 

People who need to transport their
video materials will find VCDGear as a
useful tool to assist them in getting the
video to play on their computer or Video
CD player.
Size: 1.32 MB

VirtualDub 1.4.11

VirtualDub is a video capturing and
processing program that works with

any Video-for-Windows compatible
device. It helps you to get video onto your
computer by capturing it from a Web cam

or other input device, and also to edit
existing video files you may have. 

It has batch-processing capabilities for
processing large numbers of files and can
be extended with third-party video filters.
VirtualDub is mainly geared toward pro-
cessing AVI files, although it can read (not
write) MPEG-1 and also handle sets of
BMP images. 

You can decompress and recompress
both audio and video, remove segments of
a video clip and save the rest, without
recompressing as well as preview the
results, with live audio and more.
Size: 0.748 MB

WMA 9 System Codecs

This contains the new WMA 9 system
codecs. This is required if you want to

be able to encode into the WMA 9 audio
with the WMA 9 plugin.
Size: 3.78 MB

Xnview 1.50.1

Xnview is used for viewing and con-
verting graphics files. It supports

around 360 graphics formats and offers
many additional features. You can export
around 40 graphic file formats. You can
apply filters and effects to your images,
import from a twain source (scanner, cam-
era) or use the thumbnail picture browser
to explore your image collection. 

Xnview also offers a customisable
screen layout, screen capture, slide show
and much more. You can create contact
sheets and Web pages from your images,
generate file listings and manage your file
by move and copy.
Size: 1.75 MB

Gazo Digi-Book 9

If you want your album to come alive,
Gazo Digi-Book is a must-have. It

test drive ■
■ essential freeware

70 MARCH 2003

VirtualDub: A video editor for 32-bit Windows platforms 

Music, games, e-books, software.
There’s plenty available for the taking
on the Net. But beware; you may be
downloading more than you asked for.
Downloading may not only help plac-
ing the software on the desktop but
also something extra in the form of
viruses, Trojans, spyware and steal-
ware—a new name given to products
that modify affiliate-tracking codes in
order to change the person to whom
the payment is due.  

Always download from reputed
sites as they make it part of their
process to eliminate malicious down-
loads. To further eliminate dangers,
always run a good anti-virus software
to screen what you download.

The Dark Side of
Downloading



OpenOffice 1.0.2

Afree alternative to Microsoft Office and
Star Office. OpenOffice.org includes

key desktop applications, such as a word
processor, spreadsheet, presentation man-
ager, and drawing program, with a user
interface and feature set similar to other
office suites. The current release, 1.0.2, is a
‘micro’ release that incorporates many bug
fixes. It can import and export different
types of documents and templates in a
huge range of formats from HTML to MS

Office XP. It runs on all modern operating
systems, except Mac OS X.

The Autopilot feature guides you
through creating complex documents. The
OpenOffice.org Writer is a word process-
ing and document layout program. You
can compare changes and work collabora-
tively using the Versions system. You can
connect with external e-mail software.
AutoCorrect word completion speeds up
your writing in a non-obtrusive and pow-
erful way. Indexing functions make mov-
ing around inside a document easy. It also

has a Desktop Publishing (DTP)
functionality that allows you to dis-
play everything you want simply
and clearly.

DRAW gives you the tools to
work with graphics and diagrams,
though not as good as other image-
editing programs. FontWork allows
you to work with 2D and 3D
images from text for an extra effect.
Size: 50.85 MB

NoteTab Light 4.92

Afree alternative to Notepad, NoteTab is
light in resources and heavy in features.

It includes a handy HTML editor. It can
handle many files with a simple tabbed
interface. It can search files, strip HTML tags
and format text quickly. It allows you to
write with the font of your choice, fixed-
width or proportional. If you need to cut
and paste from a pile of files, you can set
up a Paste Board file to save text clips
automatically. You can use the system-
wide search and replace tools and you can
speed up your work with text macros.

Version 4.92 fixes some issues that were
introduced in the previous release. 
Size: 1.8 MB

Stickies

Stickies is a virtual post-it notes program
that allows you to place sticky notes on

your desktop, which will remain where

enables you to display and manage pho-
tos in a virtual album, using a virtual
bookshelf interface. 

The photos are displayed as thumb-
nails and you can add text and sound
comments to each image. It allows simple
drag and drop to create new albums. You
can also import images directly from
your memory card or other media
devices. 

The current version provides auto-
matic launch systems that allow you to
import and create albums just by plug-
ging your digicam to your PC. It has the
ability to read and export most image
formats. Slideshows can even be made
into screen savers. 

It offers printing functions that
allow you to print images as a catalog,
and Web page export functions to allow
you to share your albums. The Album
Viewer Export functions will publish
your albums for friends and family.
Size: 2.86 MB

UndercoverXP

UnderCoverXP is a program to easily
print CD covers. It supports JPEG,

GIF, PNG and BMP formats and can auto-
matically scale front covers, back covers,
front and inside inlays, DVD boxes,
Playstation covers and CoolBela LD001
labels to the correct sizes. Other label types
can be added via a configuration file. The
program is easy to use and uses a visual dis-
play to show the selected images as they
will appear on your cover.
Size: 0.692 MB

IsoBuster 1.2

The name is quite misleading. Neither
does this nifty tool bust anything nor is

it an ISO (quality) standard. It is, in fact, a
data recovery tool used to recover data
from a CD/DVD even if the latter has
scratches or errors on it. It can read ISO files
of many formats, and can extract video
from VCDs to MPG or convert DVD to
MPEG. Besides fixing the bugs in the earli-

er version, this release features a full surface
scanning function to find missing/deleted
files on a UDF-written CD-R, CD-RW,
DVD+R, DVD+RW, DVD-R and DVD-RW.
Size: 2.2 MB
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✔ Always use a download manager. 
✔ Create a directory for only down-
loads and sort them under different
sections as per your need (songs, soft-
ware, games, etc).
✔ Save the file to the disk rather than
opening it directly by clicking on the
‘Save to disk’ option.
✔ Scan the file with a good anti-virus
engine. Try and integrate the virus-
scanning program with the download
manager.
✔ Try and choose the closest FTP server
from where you can download.
✔ Disable any screensaver that is on.
✔ If possible, try and use a firewall to
block unwanted traffic.

7 Tips for Downloading 

OpenOffice: a multi-platform office productivity suite

Office
Since most of us spend our waking time in the office, we thought it wise to arouse your interest in
alternative office suites that pack in a host of features for free. It will force you to think differently.
Don’t take our word for it. Try it out yourself. We are also sure that you would need to plan and jot
down notes, so there are the colourful stickies for you. We understand the growing need for instant
exchange of notes, documents and the urge to conference. So we have squeezed in a collaboration

tool for you. Last, but not the least, there’s an alternative to Notepad.
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Developer Tools

Bloodshed
DEV C/C++
4.0
Bloodshed Dev-C++
is a full-featured
Integrated Develop-
ment Environment

(IDE) for the C/C++ programming lan-
guage. It is able to create Windows or
console-based C/C++ programs using the
Mingw compiler system or the Cygwin
compiler. It can also handle the Insight
Debugger. Included in the Dev-C++ envi-
ronment are all of the standard features
necessary for writing, compiling, debug-
ging, and executing programs written in
C. Strictly for the hard-core C++ program-
mer, Dev-C++ allows you to compose all
of your source code without many of the
hand-holding features and expenses
included in many of the available pro-
gramming environments.
Size: 7.5 MB

JCreator v2.50 LE
JCreator is a powerful IDE for Java. JCre-
ator provides the user with a wide range
of functionality such as project manage-
ment, project templates, code-comple-
tion, debugger interface, editor with syn-
tax highlighting, wizards and a fully cus-

tomisable user interface.
JCreator is written entirely in C++. Its

features include pop-up code completion,
pop-up code snippets, pop-up code identi-
fier, source code navigation, integration of
the Javadocs, Debugger Interface, custom
document types, Class Wizard and Interface
Implementation tool.
Size: 2 MB

GLUT binary + source code
GLUT is the OpenGL Utility Toolkit for writ-
ing OpenGL programs. It provides a
portable API so you can write a single
OpenGL program that works on both
Win32 PCs and X11 workstations. GLUT is
designed for constructing small to medium-
sized OpenGL programs. 

GLUT is simple, easy, and small. The
GLUT library has both C, C++, FORTRAN,
and Ada programming bindings. The
GLUT source code distribution is portable
to nearly all OpenGL implementations for
the X Window System and Windows
9x/NT.
Size: 12.577 MB

IndigoPerl V2003.02
IndigoPerl is a binary build of Perl, Apache
and PHP for Windows. It includes an inte-
grated Apache Web server and can be used

for developing and running Perl scripts and
Web applications. A browser-based GUI
Package Manager for installing Perl mod-
ules is included. You just need to unzip and
run setup. IndigoPerl is provided as a
zipped file with a Perl script installer. 

It can be installed on all Win32 systems.
It does not install files in windows directo-
ries, nor does it keep data in registry,
except for Apache service information. Mul-
tiple versions can be kept on same PC.
Size: 19 MB

Java 2 Development Kit 1.4
The Java 2 Development Kit lets you write
Java applets that conform to the latest
applet API for Java. Previous versions added
new functionality to Java, including accessi-
bility, drag-and-drop, application services, a
Java extensions framework, collections,
input methods, version identification, refer-
ence objects, the Java interface definition
language (IDL), the Java Virtual Machine
Debugger Interface (JVMDI), Java servlets,
and Javadoc doclets. 

Performance enhancements include
native thread support, memory compres-
sion for loaded classes, faster memory allo-
cation and garbage collection, monitor
speed-ups, and a native library JNI port.
Size: 37 MB

placed until closed, even if you reboot your
machine. The appearance of the sticky
notes can be customised. In addition, the
notes can be sent across a network and also
synchronised with friends, imported/
exported, sent by e-mail and more. 
Size: 0.47 MB

Project Planner - PE 2.0

Project Planner - PE lets you manage your
projects and allows your team members

to modify their task status online in real
time. It also gives you control over the
schedule as well as the expenditure on your
project along with a risk log. Using the
built-in metrics features, Smartworks lets
you predict the slippage in terms of
cost/schedule for your project.
Size: 5.12 MB

Above & Beyond 2000

Above & Beyond 2000 is an easy-to-use
PIM that features a unique Dynamic

Planning technology. It’s suitable for single
users and workgroups. The Split Task
option schedules time for projects, allowing
for dependencies such as prerequisites. 

Additional features include prioritis-
ing, alarms, pop-up calendars, agents,
workload balancing, filters, timers, contact
databases, autodial, time accounting, case
number, expense and mileage reports, Web
site connecting, custom fonts, colour
printing, world time zones, LAN schedul-
ing, a meeting maker, password protection,
and encryption. 
Size: 1.59 MB

Microsoft Netmeeting 3.0

NetMeeting delivers a complete Inter-
net conferencing solution for all Win-

dows users with multi-point data confer-
encing, text chat, whiteboard, and file
transfer, as well as point-to-point audio and
video. (Refer, ‘Getting it Together’ on page 114
for more details)
Size: 1.57 MB

Sprat 1.1.0

Sprat is an easy-to-use custom database
builder. Use the many features to cre-

ate your perfect database. It even has a
variety of options for working with a cre-
ated database. With Sprat you can create
custom database tables in an easy-to-
understand environment. Information
can be added, edited or deleted simply by
clicking a button. You can choose to print,
preview, or format for HTML the output.
There is even a find stats button that
includes regression.
Size: 3.9 MB

Acropad PDF Creator 1.0

This simple utility looks like a copy of
Notepad but it actually saves to the PDF

format. You don’t need Adobe Acrobat.
Simply open the text or RTF file, select the
line feed, page properties, font, and other
options, then save it as a PDF.
Size: 0.315 MB
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Apache 2.0.44
A very popular Web server on the Internet
since 1996, Apache is a high-quality, open-
source HTTP server for modern OSes includ-
ing the UNIX and Windows families. It pro-
vides a robust and commercial-grade refer-
ence implementation of the HTTP protocol.
It supports Dynamic Shared Objects, which
allows for modules to be loaded at runtime.
The server includes an experimental digest
authentication module, an expat XML pars-
er and enhanced support for Tandem, TPF
and Mac OS. 
Size: 4.76 MB

HTML Kit
HTML Kit is a full-featured text editor
designed to help HTML, XML and script
authors to edit, format, validate, preview
and publish Web pages. Newcomers to
HTML coding can benefit from the pro-
gram’s error-catching abilities. Experts can
save time spent on common tasks, using
the customisable and extendible editor,
while maintaining full control over the
code.

HTML Kit can be integrated with HTML
Tidy, a utility for analysing and correcting
errors in HTML and XHTML files. 
Size: 2.84 MB

HTML Reference Library
The HTML Reference Library (HTMLib) is a
Windows HLP file (available in Windows 3.x
and Windows 95 versions) which details with
numerous screenshots and example code,
how all currently useable HTML elements can
be employed for the creation of Web pages. 
Size: 3.12 MB

PHP 4.3.0
PHP is a widely used general-purpose script-
ing language that is especially suited for
Web development and can be embedded
into HTML. 

PHP can be used on all major operating
systems, including Linux, many Unix 
variants (including HP-UX, Solaris and
OpenBSD), Microsoft Windows, Mac OS X,
RISC OS. 
Size: 5.8 MB

Python 2.2.2
Python is an interpreted, interactive, object-
oriented programming language. It has very
clear syntax, modules, classes, exceptions,
very high-level dynamic data types, and
dynamic typing. New built-in modules are
easily written in C or C++.

Python runs on Windows, Macintosh,
Linux, Unix, OS/2, WinCE, and many other

operating systems. The full source code is
available for the language and associated
standard libraries. Key features of Python
include object orientation, modular name
spaces, exceptions, and multi-threading;
high-level dynamic data typing and very late
binding; tight integration with C, C++, and
Java modules; may be compiled to Java byte
code for use in any JVM; string and regular
expression processing; extensive XML and
web services support; GUI development and
multimedia services; unit testing, profiling,
and documentation generation; and restrict-
ed execution security option.
Size: 6.92 MB

MySQL 3.23 + Control Center
MySQL is a very popular open source data-
base. The latest version 3.23 is now
declared stable which means that MySQL
3.23 can now be safely used in production
environments. This release includes full-text
search, replication between a master and
many slaves and several new table handlers
that support large files and transactions by
using the Berkeley DB library from Sleepycat
Software to implement transaction-safe
tables.It now has full-text indexing and
searching capabilities. 
Size: 16.2 MB

System 
What’s the first thing you’d do after selecting a software? Install it. So we’ve given you installers
that do things the right way. You obviously need an anti-virus scanner. We have it. You may want
to recover lost files, take backups, tweak your registry, secure your privacy, check what you have
on your system or extend your clipboard memory. You may also want to install a firewall to pre-
vent intruders from hacking into your system. Besides, an event scheduler, a macro-maker, file-

splitter, and file renamer make life so easy. You wonder why you never had them on your PC before. That’s why we’ve
got these for you.

Microsoft Windows Installer

If you are apprehensive of harming your computer by installing
new software, try out the Microsoft Windows Installer—an instal-

lation and configuration service that ships as part of the Microsoft
Windows 2000 operating system.

It restores the original state of the computer upon installa-
tion failure. It keeps track of all changes made to the system
during the application installation process. If the installation
fails, Windows Installer can restore, or roll back, the system to
its initial state.  
Size: 1.62 MB

UninstallAbility 1.0

If you want to get rid of unwanted programs, try UninstallAbili-
ty, which ensures that you will always be able to uninstall unnec-

essary programs from your computer—even if your Add/Remove
list of installed program has gone corrupt or even lost. 

UninstallAbility maintains backup copies of the uninstall list.
It can also help you when a program you want to uninstall has dis-
appeared from the uninstall list, but not from your computer. The
program can perform automatic backups, daily, weekly, etc and
also keep multiple versions of the backup set.
Size: 0.551 MB



AntiVir PE

AntiVir Personal Edition detects and
removes more than 50,000 viruses. The

resident Virus Guard serves to monitor file
movements automatically. It comprises an
on-demand scanner for Windows and for
DOS, on-access scanner for Windows,
Scheduler, Internet update program and

Support Collector. AntiVir adds a scan
menu item to the Windows Explorer con-
text menu of directories and files. If this
feature is disabled during the installation,
you will be able to scan only entire drives
but not single directories or files using the
Windows on-demand scanner.

If you have installed an earlier ver-
sion, do remember to uninstall it before
installing this new version. 
Size: 3.75 MB

ZoneAlarm 3.1.395

ZoneAlarm provides PC protection for
the home user. It installs easily, and a

simple setup wizard helps you configure
standard Web applications, such as your 
e-mail client and Web browser, to access
the Web without the need to fiddle with
port addresses or proxy settings. 

When other programs or processes
attempt to access your Internet connec-
tion, a window pops up that prompts you
to permit or deny access. 

The latest version adds several features
including in-client logging, which pro-
vides log filtering, sorting, and real-time
analysis; new AlertAdvisor, which offers
instant security advice; zone management
area, which lets you easily share files with
computers and networks you trust while
simultaneously blocking ones you don’t;
an all-new user-friendly interface; and
much more. Other updates include
improved interoperability with proxy serv-
er applications, an improved user interface
with a new maximise/minimise button.
Size: 3.6 MB

EasyMTU 3.0

Speed is what we want to get from the
Internet. We never seem to have enough

of it. EasyMTU helps speed up your Inter-
net connection by optimising your TCP/IP
settings. Windows has default settings for
TCP/IP that may be optimal for a net-
worked PC, but not for a standalone con-

nected to the Internet with a
modem. 

EasyMTU lets you quickly
change the Registry settings to
optimise your modem speed on
a standalone PC with a dial-up
connection. It changes your PC’s
MaxMTU to coincide with your
router’s MaxMTU for maximum
performance. It even includes a
benchmark program that lets
you compare the throughput for
different settings. 

EasyMTU also contains a unique
FindMTU utility and a benchmark for
comparison between different settings.
Size: 0.357 MB

jv16 PowerTools 1.2.0.181

jv16 PowerTools is a full set of tools to
keep your computer up and running. It is

a registry and system-tweaking tool from
the same developer that released the pop-
ular RegEdit utility. It contains all the tools
needed for monitoring, cleaning and con-
trolling the Windows registry, the file sys-
tem and your Local Area Network. 

The jv16’s interface is split up into
three sections—the Registry Tool, the File
Tool and the LAN Tool. The many fea-
tures include cleaning the add/remove
software list, scanning the registry for
invalid and obsolete registry entries, start-
up control, searching for duplicate files,
finding broken shortcuts and much more.
LAN features include chat, remote task
manager, run programs on a remote
machine and more. 

There’s version 1.3 in the off-
ing which  has added a few console
commands—there are now 216 of
them. It has a lot of bug fixes and
other small improvements.
Size: 2.05 MB

Backup4all 1.0

Backup4all is a full-featured back-
up tool, which will allow you to

define custom backup configura-
tions to meet your personal needs.

Backup4all also enables you to see
what files have changed since the last
backup and to preview the statistics for
the next backup. Additional features
include zip compression, Explorer inte-
gration, incremental backups and more.
Backup4all works with any drive letter,
including mapped network drives, CD-
R/CD-RW media and UNC paths.  

The backup speed has improved with
the latest release. An option to minimise
on tray was added. A new option is made
available for hiding the background image
on the left side of the application’s main
form. You can now add individual files to
the backup source and not just to the fold-
ers. The Shutdown problem which occured
with Windows 2000 has been corrected.
There is now a visual indication for back-
ups that are currently executed.
Size: 1.124 MB

PC Inspector File Recovery
3.0

PC Inspector File Recovery is a data recov-
ery program with support for FAT

12/16/32 and NTFS file systems. It recovers
files with the original time and date stamp,
and can optionally restore them to a net-
work drive and can recover many files, even
when a header entry is no longer available.
On FAT systems, the programs find parti-
tions automatically, even if the boot sector
or FAT has been erased or damaged.  

The current version 3.x replaces the
previous version. It finds partitions auto-
matically, even if the boot sector or FAT
has been erased or damaged (it does not
work with the NTFS file system). It recov-
ers files with the original time and date
stamp. It supports the saving of recovered
files on network drives. It recovers files,
even when a header entry is no longer
available. The ‘Special Recovery Function’
supports a host of file formats. 
Size: 2.81 MB
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AntiVir PE: The bug killer

PC Inspector automatically retrieves recoverable files



SequoiaView 1.3

Ever wondered why your hard disk is
full? Or what directory is taking up

most of the space? When using conven-
tional disk-browsing tools, such as Win-
dows Explorer, these questions may be hard
to answer. SequoiaView, however, uses a
visualisation technique called cushion
treemaps to provide you with a single pic-
ture of the entire contents of your hard
drive. You can use it to locate those large
files that you haven’t accessed in one
year, or to quickly locate the largest pic-
ture files on your drive. 

Treemaps make more efficient use of
the available screen space. Instead of
showing a file system as a long list of files
and directories, files are displayed as rec-
tangles, with the size of the rectangle
being proportional to the size of the file.
The program also allows you to apply dif-
ferent colour schemes to easily identify
certain file types.
Size: 0.554 MB

Super Tray Info 2.2

Super Tray Info is a small and simple
system information utility that runs in

the system tray and provides one-click
access to various system information, as
well as your current IP address. 

You can get information about all
your drives (total size, free size, usage);
CPU informations (CPU usage [%], ven-
dor [AMD, Intel, ...], MMX support,
3DNow support, cache informations
[L1 and L2] ); drive information (free
space, total space, usage [%], volume,
serial, file system [FAT, NTFS, ...] );
memory information (total memory,
free memory, memory usage [%]), 
display information (type of adapter,
current resolution, number of colours);

operating system information (OS 
type [Windows 2000, XP, 98, ... ], build,
system up time, machine name, IP
address); default printer, network
adapter name, audio adapter name 
and more.
Size: 0.756 MB

The Shadow

The Shadow is an event scheduler. It
can run any program at the time that

you specify, as well as hourly, daily, at
startup, shutdown, etc. The program con-
sists of two parts—a small, tray resident
program which is started when the sys-
tem starts up, and an easy-to-use config-
uration program which you will use to
configure and add events.
Size: 0.34 MB

XOSL 1.1.5

Extended Operating System
Loader (XOSL) is a full-fea-

tured, free boot manager with an
easy-to-use graphical user inter-
face with mouse and keyboard
support. XOSL supports up to 24
boot items, as well as automatic
booting and password protected
boots. Additional features
include Hotkey per boot item,
Master boot record virus protec-
tion, drive swapping, co-exis-
tence with other boot managers
and more.

You have to create a dedicat-

ed partition before installing the boot
manager.
Size: 0.5 MB

Yankee Clipper III

Yankee Clipper III is a powerful Win-
dows clipboard extender/memory. It

handles pictures, richtext, URLs, etc of any
size. It features printing, drag and drop,
and optional permanent storage of clip-
pings. It can save past 200 text and RTF, 20
BMP and Metafile, and 200 URL clipboard
entries. It has a ‘Load and Shoot’ function
to paste text anywhere, and can float on
top of other applications for fast pasting. It
has no size limits for ‘clippings’.

It has a global hotkey to make the
application visible when hidden, and
another to instantly show and select past
‘clippings’ without showing the applica-
tion. The clippings can be dragged and
dropped to/from YCIII. It can strip
unwanted ‘quote’ characters ([<], [|]) from
‘clippings’.
Size: 1.04 MB

MacroMaker 1.0.43

MacroMaker allows the user to build
macros and assign them to hot keys.

The user can simulate a series of keystrokes,
execute built-in functions, or playback a
previous recording with just a keystroke. 

With the copy and paste functions
available, you can feasibly have a clip-
board, which can store text only, assigned
to every key on the keyboard amongst
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Free Software: Free software is a matter of
freedom, not price. You can use, copy and
distribute it in its original form or with
modification for free or with a fee, provid-
ed the source code is provided with it. The
GNU General Public License (GPL) is an
example.
Freeware: The software is available for free
and can be distributed freely in an unmod-
ified state. In case the source code is pro-
vided, you need permission from the origi-
nal developer to modify and redistribute it. 
Shareware: Also called liteware, this is
usually available free for a limited trial peri-
od, after which the developer requires you
to register and pay a licence fee. Share-
ware may have certain features disabled 
or there may be constant reminders to
register.

Adware: This type of license given to soft-
ware comes with a banner or a pop-up ad.
Even though such software is available free,
you’d have to register with the developer to
ban the ad.
Nagware: Something in the mould of a
shareware program, this type of licensing
presents the user with one or more pop-up
windows or alerts when an application is
launched or closed (sometimes both),
reminding the user to register, purchase the
application, or take some other action.
Nagware is commonly used with shareware
programs that have been downloaded for
trial use.
Trial Version: This type of licensing allows
you to use the software for 30 days after
which the program will stop responding
and you’ll have to register.

Making Sense of the Software Licenses

Access your system information in just one click



other prebuilt functions. You can also store
textual content from the clipboard in
internal MacroMaker buffers for later use.
Size: 0.244 MB

Gsplit 1.7.0

Gsplit is a powerful file splitter that lets
you split your large files into a set of

smaller files called pieces. The pieces can
be easily combined, using the generated
Self-Uniting Executable, that automati-
cally restores the original file for you
without requiring GUnite. Gsplit also
includes advanced features such as differ-
ent splitting methods (blocked or spanned
disks pieces), CRC32 checks (detects file
corruption), splitting logs, keeping file
information, creating specific pieces with
your own names and shell integration.
Size: 1.14 MB

Flexible
Renamer 6.1.5

Flexible Renamer 
is a powerful

file/folder renaming
utility,that supports
Wildcards and Regu-
lar-Expressions. It
offers a Windows
Explorer style inter-
face and a variety of
renaming options,

including options to remove numbers or
strings, replace strings, insert numbers,
translate letters and much more. 

You can also use Flexible Renamer to
create empty objects in the form of files
or folders. It also supports Tag-informa-
tion such as ID3(MP3), EXIF, IPTC, MS-
Office, HTML.
Size: 0.58 MB

Zip genius 1.4.3.1294

Your zipped files are not safe, even if
you protect them with a password.

That’s why ZipGenius offers CryptoZip to
encrypt zip files and transform them into
Czip files through a numeric key of your
choice. 

ZipGenius has all the functions of a
typical compression utility plus some extra
features which include 21 compression and

encoding/decoding formats; zip encryp-
tion/decryption (CZIP format via Cryp-
toZip); PocketPC support via ActiveSync;
Drag and drop support; Customisable look
and feel; Grid to separate data; Custom
font which can be applied to ZipGenius
buttons and menus; `First Step Assistant’
button to drive newbies; and ZipGenius
Mail, a built-in e-mail client.
Size: 6.12 MB

Eraser

Beware! Data does not vanish simply
because you’ve deleted a file. The

operating system does not really remove
the file from the disk; it only removes the
reference of the file from the file alloca-
tion table. Eraser uses the ‘Darik’s Boot
and Nuke’ (DBAN) disk option to erase all
your hard drives.

Eraser deletes encrypted Files and Dri-
ves; erases FreeSpace on Windows 95/98/
NT/2000 and XP; erases contents of the
Recycle Bin; erases Internet Cache; appears
as an ‘Erase’ option on the Context Menu
of Windows Explorer and Recycle Bin;
comes with an Eraser Scheduler that allows
you to create user-defined tasks; and sup-
ports FAT32 and NTFS Files Systems.

You can drag and drop files and fold-
ers to the on-demand eraser, use the
Explorer shell extension or use the inte-
grated scheduler to program overwriting
of unused disk space or, for example, set
browser cache files to happen regularly,
at night, during your lunch break, at
weekends or whenever you like.
Size: 1.77 MB

PGP 8.0

Everybody wants to exchange messages
securely. Encryption is the buzzword in

this game of maintaining privacy. The stan-
dard in encryption today is PGP or Pretty
Good Privacy. It is a powerful crypto-
graphic software suite that enables people
to securely exchange messages, and to
secure files, disk volumes and network
connections with both privacy and strong
authentication. In addition to secure mes-
saging, PGP also provides secure data stor-
age, enabling you to encrypt files stored
on your computer.  

PGP 8.0 allows only the encrypting
of e-mail and does not include plugins for
e-mail clients. The PGP 8.0 source code is
available for download; the license allows
review only, not reuse.
Size: 8.44 MB
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An easy way to build macros

Commercial Anti-virus: It Pays to Put Your Money on Them!
The game of one-up-man ship between virus makers and virus catchers is an ongoing
one. Though there are free and trial versions of anti-virus software that do a pretty decent
job of keeping your system safe from common viruses, you’d need a feature-rich, versatile
tool to bust the slimier ones that have developed a higher resistance to general anti-virus
techniques. And these come at a cost. 

If you are constantly online, it is wise to go for a paid version of anti-virus software, as
these provide you more complete protection from existing as well as emerging viruses.
Some of these commercial software are available for trial, so do try them out and see
which one suits you best.

Name
Norton Antivirus 2003

Professional edition

McAfee Virus Scan 7.0

Panda Antivirus 

Titanium

PC Cillin 2003 v10

Web site
www.symantec.com

www.mcaffee.com

www.pandasoftware.com 

www.trendmicro.com 

Features
Live updates, script blocking,

scans IM attachments and

incoming/outgoing mail

Script blocking, integrated

firewall, tightly integrated

into MS Office and Windows

Automatic updates, Smart-

Clean technology to repair

files

Integated firewall, down-

load/browser/file sharing/IM

attachment scanning

Size
38.3 MB

41.1MB

15.4 MB

16.5 MB
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The OptiPlex SX260 desk-
top computer from Dell

has an ultra small form factor
and is quite well-built. It
sports a black body with a sil-
ver-grey front panel, which
houses the power button and
hard drive LED. The system
comes with the option of
mounting brackets for attach-
ing the system underneath
the table. This helps save
desktop space considerably as
there is only the flat panel
monitor, keyboard and mouse
on the desk.

This machine is pri-
marily targeted at the
corporate business user.
It is powered by a Pen-
tium 4 2.0 GHz processor
that is upgradeable to
3.06 GHz and 256 MB
DDR RAM  that can be
upgraded to 2 GB. The
other goodies include
Hitachi’s 40 GB 5,400-
rpm hard drive, a
removable and
h o t - s w a p -
pable flop-
py drive
and 8x
D V D - R O M
drive (which means that you
can plug in the floppy drive
or DVD-ROM drive without
shutting down the machine),
onboard sound, six USB ports
and an Intel Pro 1000 Gigabit
Ethernet card. It also has Intel
Extreme Graphics, which is
not only sufficent for most
business applications such as
3dsmax and Autocad, but will
also satisfy the casual gamers

who don’t mind sacrificing
on features to get higher
frames per second.  

The OptiPlex performed
well for its configuration. It
managed to encode a 50 MB
WAV file to MP3 using Audio-
Catalyst in just 29 seconds.

For video encoding, this
system took 2 minutes 54 sec-
onds, which is on par with
any similarly configured sys-
tem. However, inspite of hav-
ing a 5,400-rpm hard drive
with the 3.5-inch form factor
used in laptops, it showed
scores similar to that of a

5,400-rpm drive meant for the
desktop. This makes it a bet-
ter option as it saves on power
and space, while giving you
optimum performance. The
only place where it logged a
lower score was the 12 ms
access time, which was
around 5 ms more than what
you should expect given the
configuration. On the gaming

front, the onboard
845 graphics core
registered 96.1 fps at
a resolution of
640x480, which puts
it in league with the
GeForce MX 400.

The system is also
very easy to maintain
and is high on securi-
ty measures. It shows
an alert message if the
cover is removed, so
you can check if any of the
hardware has been tampered
with. There is a single green
knob at the back panel to
open the cover of the PC to
access the hard drive. This
makes it easy for the user to

upgrade the system memo-
ry, change the proces-

sor and even do
some cleaning. 

The PC comes
complete with Win-
dows XP (plus SP1),
drivers CD, Restore
CD, manual and a
starter’s guide. It also
comes with two extra
covers for the back

panel to isolate the con-
nectors from external shocks. 

The machine is priced at
Rs 1,10,000 which is justified
given the performance, design
and features that are packed
into such a small form factor.
The same machine, when

configured on Dell’s US-based
Web site, costs Rs 97,500. Its
looks and features make the
OptiPlex SX260 an attractive
option for executives who
would like a small, good-look-
ing and yet powerful system
capable of handling with flair
the applications available
today.

Dell OptiPlex SX260
Sleek and powerful

We test the latest and the best hardware and software products available in the market 

Price: Rs 1,10,000
Contact: Dell Computer India
Phone: 080-5068117
Fax: 080-5586107
E-mail: chiradeep_rao@dell.com
Web site: www.dell.co.in

SPECIFICATIONS

Pentium 4 2.0 GHz processor,
256 MB DDR RAM, Hitachi 40
GB 5,400-rpm hard drive,
removable and hot swappable
floppy drive and 8x DVD-ROM
drive, onboard sound, six USB
ports, Intel Pro 1000 Gigabit
Ethernet card, Intel Extreme
Graphics

Dell OptiPlex SX260

Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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The back panel of the cabinet
can be removed for easy access
to the components
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sound field from a Sound
Blaster 5.1 soundcard. 

The speakers have an aes-
thetic appeal that adds value
to the decor of the room—for
a change, the woofer doesn't
need to be hidden away. The
satellites are slightly larger
than speakers made by other
manufacturers, but can still
be managed easily. The stand
for the centre channel speak-
er is designed specially to be
placed on the monitor, so
that it won’t fall down. An
extra replacement stand has
also been provided. The satel-
lite speakers are connected to
the back of the sub-
woofer through individ-

ual cables. The connection
and setup is simple, as the
cables are of different colours,
making it easy to trace their
path while connecting. The
speaker wires are long
enough so you can spread
them out in a large room for
a true surround experience. 

We tested the speakers on
the new Audigy2 Platinum
soundcard. The six satellite
speakers offered excellent
sound quality without distor-
tion, thanks to the flexible
base, which helps dampen
oscillations, thus reducing
distortion.

The bass was of excellent
quality up to pretty high
sound levels. The higher fre-
quencies were also reproduced
faithfully. The speakers gave
refined sound output even at
60 per cent absolute maxi-
mum volume. The bass started
getting distorted at higher vol-
ume levels, but such sound
levels would rarely be reached

or needed. The bass gives a
clean booming sound that fills
the room—it is loud without
being annoying. The sound
effects in games such as Quake
III and Grand Prix 4 were
reproduced realistically. How-
ever, these games will not
exploit the full capability of
this set with its additional rear
centre speaker. The sound
effects in DVD movies that
support Dolby Digital EX for-
mat were reproduced precisely

and added an extra
dimension to the
movie experience.
The clarity of vocals

and instru-
ments is

also noteworthy.
The Creative Inspire

6600 is an ideal companion
for the Audigy2 soundcard,
producing superior accuracy
in sound separation across
the six speakers. This speak-
er set will complement  other
high-end components in
your PC (DVD-ROM drive,
large screen monitor, 6.1
channel soundcard) if you
wish to make it an entertain-
ment station.

Canon’s Digital IXUS 330
is probably the best look-

ing 2 Megapixel digital cam-
era we’ve seen. Its compact
steel-aluminium body has an
excellent metallic finish. The
package includes a USB cable,
Lithium-Ion bat-
tery, a battery
charger, user
manual and CD-
ROM with all
the drivers, and
some photo
editing software
that will help you
get started. 

A 1.5-inch LCD screen
shows a preview of the image
you are about to shoot and
allows you to browse through
the user interface to change
the camera settings. If you
turn off the screen, you can
use the optical viewfinder
equipped with a 3x zoom lens
for capturing distant objects.
The camera can also be used
to record short, 30-second
videos at the lowest resolu-
tion. The videos can be
viewed on a television screen
using an AV connector. 

The buttons on the cam-
era are well placed and easy to
operate. The dial to select the
mode of the camera is conve-
niently placed at the top and
can be rotated with the

thumb. There is also a groove
at the back for resting the
thumb, which helps to get a
good grip and take photo-
graphs with a steady hand. 

The IXUS 330 has excel-
lent features and

great com-
p a t i b i l i t y
with the PC
as well as
C a n o n ’ s
photo print-
er. However,
the camera
comes bun-

dled with just an 8 MB Com-
pact Flash (type 1) card,
which limits its memory.
Also, there is no internal
memory. Considering this
and the fact that it’s a 2
Megapixel camera, its price
(Rs 39,995) is too steep—you
can easily get a 2 Megapixel
camera for half that price. 

Canon Digital IXUS 330
A pricey deal

Price: Rs 39,995
Contact: Canon India Pvt Ltd
Phone: 011-26806572
Fax: 011-26807180
E-mail: brijesh.verma@canon
.co.in   
Web site: www.canon.co.in

Creative’s new Inspire 6600
speakers are a treat for

sound enthusiasts. The set
consists of six satellite speak-
ers and a woofer. It has an
extra rear centre speaker that
gives an amazing audio 

realism from DirectSound 3D
game titles, Dolby Digital EX
DVD movies and digital
music. There is a Creative
Multi-Surround System up-
mix control switch on the
subwoofer to create a 6.1

SPECIFICATIONS

Total wattage of 120 W RMS,
five 3-inch satellite speakers (8
W RMS each), one 4-inch front
centre speaker (20 W RMS),
one 6-inch 22 W RMS sub-
woofer, electronically con-
toured satellites with high per-
formance drivers, 6.1 positional
audio, 35 Hz-20 KHz frequency
range, 75 dB SNR, wired vol-
ume/bass control with head-
phone jack

Creative Inspire 6600 

Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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Creative Inspire 6600 6.1 speakers
Big boom!

Price: Rs 9,599
Contact: Compuage Infocom Ltd
Phone: 022-23842200
Fax: 022-23842210
E-mail: info@compuageindia.com
Web site: www.creative.com 

SPECIFICATIONS

Dimensions 95x63x32 mm,
weight 274 gm, CCD sensor, 
2 Megapixel maximum
1600x1200 resolution, 3x zoom
lens (35-105 mm), playback
zoom, 1.5-inch LCD screen, 
4:3 aspect ratio, aperture range
F2.7-F4.7, 8 MB Compact Flash
card, Canon Li-Ion NB-L1H 840
mAh Lithium-ion battery, JPEG
storage format

Canon Digital IXUS 330 

Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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subwoofer. Also, the cable for
the front channel speakers
isn’t long enough for the
speakers to be placed suffi-
ciently far apart. The cable
connecting the woofer to the
soundcard is of the same
colour, which can cause some
confusion. 

The speakers give a good
surround sound effect with
reasonable clarity for a good
home theatre experience
and can also be connected
directly to a DVD player. The
performance in the low and
mid frequencies is also good.
However, the speakers are
not built to listen at full 

volume as there is a slight
distortion.

If you are looking for a
no-frills speaker set that yet
gives you good performance,
you can put your money on
the HT-4500. 

The DeskJet 450Cbi is a
well-designed mobile

printer, weighing only 2 kg. A
flap on the top exposes the
control buttons and a
smooth moving slider on
the paper feed tray adjusts
to the paper size. A Lithi-
um Ion battery
pack at the back
gets charged when
the AC power sup-
ply is connected
through the adapter. The
supplied HP DeskJet Toolbox
monitors the battery as well
as ink level. An infrared port,
apart from parallel and USB
ports, lets you print via hand-
helds; a slot for type II Com-
pact Flash card allows for
Bluetooth connectivity. 

It produced sharp text
documents when we printed
from a Palm handheld device.

When printing via laptop, the
quality was good but took a
long 25 seconds. The clarity in
the combined text and photo-
graph document was superb

and even the
details on the
small photographs

were clearly visi-
ble. It failed to
print photo-
graphs at the

highest resolu-
tion on non-HP photo

paper. Though not as good as
other inkjets, it is a good buy
for those who need to print on
the move.

HP Deskjet 450Cbi
Mobile printing

Price: Rs 15,999
Contact: Hewlett-Packard India Ltd
Phone: 011-26826000
Fax: 011-26826053
E-mail: ashwini-k_aggarwal@hp.com
Web site: www.hpindia.com

SPECIFICATIONS

9 ppm black printouts, 8 ppm
colour printouts, fast Infrared,
parallel and USB interface, up
to 4800 dpi optimised dpi in
colour text printing

HP Deskjet 450Cbi
Performance
Build Quality
Value for money
Features
OOVVEERRAALLLL
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The Stylus C61 offers an
excellent resolution of

5760x720 dpi and some new
innovations. 

It sits pretty on your desk.
However, the body is made of
plastic and that makes one
doubt its ruggedness. It has a
parallel port as well as a USB
interface for faster and easier
connectivity. It
comes with
a setup
m a n u a l ,
driver CD, a
c u s t o m e r
c o n t a c t
book, a parallel
printer cable and power
cable. Unfortunately, a USB
cable was not included in the
package. 

We printed a test photo-
graph at the highest resolu-
tion on glossy photo paper—
the images were printed crisp
with high detail. However,
the colours were not repro-
duced accurately—the yellow
was many shades darker,
while the blue was a shade
lighter than in the original
photograph. It took almost 10

minutes to print the test pho-
tograph in A4 size and at high
resolution—normal for such
printers. 

The Stylus C61 printed a
text page in 17 seconds, but it
tended to get a bit noisy when
printing documents in the
economy mode or when the

document contained
text and graphics.

It uses Epson’s
QuickDry inks,
which means that
there are fewer
chances of docu-
ments getting

smudged. 
The printer works

on a wide variety of paper
and produces excellent
photo quality. However, you
can get printers that achieve
high levels of quality at
lower costs.

Epson Stylus C61
A clear picture

SPECIFICATIONS

Piezo printing technology, 
5670x720 maximum resolu-
tion, parallel and USB interface,
32 KB buffer, A4 size paper
capacity, 3.5 kg weight

Price: Rs 7,495
Contact: Epson India Pvt Ltd
Phone: 022-28261515
Fax: 022-28257287
E-mail: ramprasad@eid.epson.co.in  
Web site: www.epsonindia.com

Epson Stylus C61
Performance
Build quality
Value for money
Features
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Price: Rs 4,200
Contact: Kobian India Ltd
Phone: 080-5566626
Fax: 080-5566625
E-mail: rohit@kobian.com
Web site: www.kobian.com

Mercury HT-4500
Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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SPECIFICATIONS

5.1 surround, compatible 
with AC-3 and DTS, DVD 
and 5.1-channel soundcard,
4500 W PMPO, 6 W RMS for
satellites and 20 W RMS for
subwoofer, 30 Hz-20 KHz fre-
quency response, RCAx6 signal
input, RCAx5 signal output.

The HT-4500 is a 5.1-chan-
nel speaker set and each

of the five satellites pumps
out 6 watts RMS, while the
subwoofer is capable
of 20 W RMS power
output.

The black
satellite speakers
are compact and

well-designed, though a tad
heavy. The subwoofer has the
volume and fade controls on
the front, which makes it dif-
ficult to access these settings,
as subwoofers are generally
placed near the feet, with the
front face ideally facing a
reflecting surface. Another

inconvenience is the
power switch

located at
the back
of the

Mercury HT-4500
Sound speaker
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beforeSales is a software
built for sales people who

can use it to stay
updated with the latest
status, be it a cus-
tomer’s account or
new products in stock.

The software com-
prises two parts—a
server software to be
installed on one cen-
trally located comput-
er and a client soft-
ware to be installed on
other computers.

The software allows you
to manage sales campaigns,
targets, products, prospects,
accounts, etc. It also includes

features such as holiday man-
agement, faxing, making

phone calls and the like. 
The product

boasts of manage-
ment features for
each level in the
hierarchy of a typi-
cal company. For
sales representatives,
p e r s o n a l i s a t i o n
management, target
management and
marketing encyclo-

pedia features are very useful. 
At the manager level, it

offers target management and
tracking, and funnel manage-
ment, which effectively keeps

beforeSales 
For a decent sales pitch

an eye on the sales process
and helps in improving and
enhancing the sales cycle.

The software provides
security options so you can
give a separate set of privi-
leges to different members.
The Membership Manage-
ment feature allows you to
create hierarchies and estab-
lish roles and responsibilities
for each level. User-level
access is maintained by
Access Management and the
users can be linked to partic-
ular branches by the Branch
Manager.

A mail client also comes
bundled with the package
and users can send SMS and

e-mail directly through the
software—the Configuration
Management feature allows
you to link the system with
SMS providers as well as Web-
based e-mail service providers
such as Hotmail, Yahoo! and
Rediff. 

beforeSales is available for
Rs 14,900 for five users; you
pay an additional Rs 3,000 for
every extra user. 

SPECIFICATIONS

A Software CD and a sales toolkit
System Requirements: Pentium
III or above, 64 MB RAM, Win-
dows 95/98/NT/2000/Me/XP,
CD-ROM drive

Price: Rs 14,900 (for 5 users)
Contact: Questech India Ltd
Phone: 080-25524771
Fax: 080-25524772
E-mail: info@beforesales.com
Web site: www.beforesales.com

beforeSales 

Performance
Ease of Use
Value for money
Features
OOVVEERRAALLLL
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Price: Rs 2,500
Contact: J.S. Equipments
Phone: 022-23810713
Fax: 022-23860976
E-mail: jse@vsnl.com 
Web site: www.iogear.com

The GME221 is a mouse
for the mobile user. It

comes with a smart leather
carrying case, a user’s
guide and a three-year lim-
ited warranty.

The mouse looks very
attractive in its metallic blue
and silver case and 
is very light, weighing
approximately 60 grams. 

The mouse has two but-
tons and a rubber scroll wheel.
It is easy to manoeuvre but
might feel a little too small in
your hands if you are accus-
tomed to the size of the regu-
lar mice. Its small size also
means that it takes some effort
when one has to alternate
between the right and left-
click. Inspite of all these short-

comings, it
is definitely
faster than a

laptop’s touchpad.
The scroll wheel is

quite smooth—the opti-
cal sensor senses the move-

ment 1,500 times per second,
providing smooth precision
tracking on any surface. 

However, the price of 
Rs 2,500 is a big negative—
you can get a decent optical
mouse for desktop PCs for
about one-third the price.  

SPECIFICATIONS

Plug-and-play USB connectivity,
optical sensor tracks movement
1,500 times per second

The Emerald Pro boasts of
a 2.4 GHz Pentium 4

processor and 480 MB RAM.
It logged an all-time
high of 70.6 in
Content Cre-
ation 2001 and
managed a
p l a y a b l e
52 fps in Quake
III at high quali-
ty settings. 

However, it is
quite bulky, weighing
2.8 kg, but this also makes
it tough. The Pro has an easy-
to-use glide pad and a TFT
LCD screen that is clearly vis-
ible even from a wide angle.
A Web cam that serves the
purpose adequately is placed
above the LCD screen. The
software to capture video
images comes pre-loaded. 

There are three USB ports,
a parallel port, two serial
ports, an infrared port, a
FireWire port and an Ethernet

connection. It comes with
Realtek Audio’97 soundcard
which provides decent sound.

The keyboard, however,
tends to be a little tacky.

Windows XP came
bundled with the laptop
we received, but ACi offers
other OS options too.

There was no user
manual, which

m i g h t
annoy first

time users. 
Overall, Emerald Pro

is an excellent bargain. It may
not sport the style of the big
brands, but it offers superior
performance for business
applications at a very reason-
able price. 

ACi Emerald Pro
A reasonably-priced gem

SPECIFICATIONS

P4 2.4 GHz processor, 480 MB
DDR RAM, 15.1-inch LCD
screen, 20 GB hard drive, 24x
CD ROM, 2.8 kg weight

Price: Rs 99,000 
Contact: Allied Computer 
International (Asia) Pvt Ltd
Phone: 022-26733122
E-mail: sales@aci-asia.com
Web site: www.aci-asia.com 

Iogear GME221 USB 
Optical  Mini Mouse
Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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ACi Emerald Pro

Performance
Build quality
Value for money
Features
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Iogear GME221 USB Optical Mini
Mouse
Easy and fast
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In today’s data centric world,
we crave for devices which

are easy to use, fast, portable
and can hold more data. One
such device is the portable
128 MB USB storage pen
drive, named Cool Disk. 

The drive uses Flash RAM
technology
and the
package
includes
a leather cover, a neck
sling, a USB extension cable
and driver CDs. The drive gets
detected in Windows XP/2000
and the drivers are loaded
automatically, whereas for
Windows 98/Me the drivers
are provided in the accompa-
nying CD. One interesting fea-
ture of the drive is that you can
use it as a bootable disk if your
motherboard supports USB
device booting.

The drive can be pass-
word-protected for safekeep-
ing. To prevent the data from
being accidentally overwrit-
ten, it also has a write protect
switch similar to floppies. 

On the performance
front, the disk takes around 
5 minutes to transfer 128 MB
of data. However, it does seem
to be a bit slow compared to
USB drives. Being a Flash RAM
drive, data integrity and relia-
bility is quite high.

Priced at Rs 5,500, this 
128 MB drive offers good

value for money—
other such drives

cost nearly Rs 2,000
more for half the

capacity. 

This Web cam sports a very
slim design and can be

tilted to around 135 degrees
and turned on its axis, which
allows shots to be taken in
any direction. The base stand
is designed such that it can be
used with desktop PCs as
well as laptops—it
can hold on to any
laptop with a 0.5-
inch thick screen.

It has a CMOS
sensor, which has a
true resolution of
640x480 and can

be further interpolated to
1026x768 using any image
enhancing software. It can also
record video at a maximum of
15 fps at 640x480 resolution,
which is good enough quality
for sharing the clip. It supports

24-bit colour, which makes
images look sharp and
crisp. The pictures are

saved as JPEG images. 
The Web-

Cam Pro
can be connect-

ed to the PC using
the USB connection and

Creative WebCam Pro
Spot the world!

the microphone allows video
conferencing.

The camera is pretty sim-
ple to install and configure—
Windows automatically
detects it, but you will need
the driver CDs to install the
driver. It shows good response
to background lighting—the
images are clear, showing no
grains or haziness in natural
light but with low back-
ground lighting, the image

becomes a bit dark. 
Given its features and

performance, this camera is a
good buy.

SPECIFICATIONS

CMOS sensor, 640x480 true
resolution, 1028x768 maxi-
mum interpolated resolution,
maximum 30 fps video record-
ing, USB 1.1 interface

Price: Rs 4,499
Contact: Cyberstar
Phone: 022-26556178
Fax: 022-26556181
Web site: sushilb@cyberstar.net 

Creative WebCam PRO

Performance
Build quality
Value for money
Features
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Price: Rs 5,500 for 128 MB
Contact: Kunhar Peripherals Pvt Ltd
Phone: 022- 56345758
Fax: 022-56345859
E-mail: salesbom@kunhar.com

SPECIFICATIONS

128 MB capacity, Windows
98/SE/Me/2000/XP, USB 
power supply (4.5 V to 5.5 V),
USB 1.0/1.1 interface, data
retention of over 10 years,
available in capacities ranging
from 32 MB to 384 MB
System Requirements: IBM PC
or Notebook computer with
USB port, Windows 98/Me/
2000/XP

Zoltrix Cool Disk - 128 MB USB
pen drive
The pen is mighty

The CardScan Executive is a
compact colour scanner

that will scan business cards
and upload their contents into
a database on your PC. The
device fits snuggly in the palm
of your hand
and is

r u g g e d
enough to

carry to a semi-
nar. The body has an excellent
finish and does not have any
weak parts that may break off
during transportation.

The card scanner offers
quick plug-and-play operation
through the USB port. A power
adapter is provided with the
device. The installation process
is a breeze. Windows detects
the device and asks for the driv-
ers. Install the drivers and the
card management software,
CardScan Version 6, from the

CD and you’re all done.
Once the device is

installed, launch the Card-
Scan program, simply feed in
the cards one at a time and see
the software upload all the
information, field-wise in to
your database in a jiffy. 

Apart from synchronising
with handhelds and mobile

phones, CardScan offers
access to CardScan.net,
where users can access

their business card data-
base via any Web browser.

Overall, the CardScan is
an innovative product, com-
bining a colour scanner and
database management soft-
ware, however, the price is
quite steep.

Corex CardScan Executive
For a digital rolodex

SPECIFICATIONS

Windows 98/Me/2000/XP
compatible, Scans in colour
and monochrome, measures
6.75x4.75x2 inches, connects
through USB, can synchronise
with handheld devices

Price: Rs 27,490
Contact: Net Spider
Phone: 022-28633514
Fax: 011-26826053
E-mail: sales@netspiderindia.com
Web site: www.netpsiderindia.com

Zoltrix Cool Disk - 
128 MB USB pen drive
Performance
Build Quality
Value for money
Features
OOVVEERRAALLLL
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Corex CardScan 
Executive
Performance
Build quality
Value for money
Features
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The Cricket World Cup is on and
that means other modes of enter-
tainment such as playing games,

downloading music and tweak-
ing my BIOS would have to
take the back seat for a while.
But the TV was already being
put to use—tearing my family
and the other animals from
Bush’s ramblings was going to

be quite a task. But the PC
was mine, all mine and
all I needed was the

right TV Tuner card, a big
tub of buttered popcorn and a

boisterous bunch of patriotic
friends.

Adding TV to your
computer is as simple as

switching channels when
you have Windows 98. I

needed to add cable from my
TV outlet to the PC and use an

adapter to connect the TV Tuner card out-
put to my speaker’s input line. The TV
cable wasn’t long enough and I made a
mental note to get a longer cable when I

called upon my friends at Lamington
Road.

With a faint idea of the various
flavours available, I set out—matching
my cash inputs with a good quality card
was the name of the game. I could opt for
a TV-only solution in the form of an add-
on PCI TV Tuner card, or one with a
decent 3D Display Card with an extra
goodie.

At my first stop, the dealer showed me
an ‘excellent’ AGP card with a TV Tuner
onboard—the ATi All-in-Wonder Radeon
9700 with 128 MB of DDR memory—for
only Rs 38,000. The AIW 9700 Pro is just
about everybody’s dream card. You get
top-of-the-line 3D and 2D performance,
digital video capture, TV Out and PVR
capabilities. The AIW comes with output
connectors that include S-Video, 1/8-inch
stereo audio and an RCA S/PDIF digital
audio jack for Dolby Digital audio streams
to an external decoder. Audio is now rout-
ed to the soundcard through the internal
input port. It comes bundled with an
extensive software suite (that would save
me loads of money if I were to buy it sep-
arately) that includes Pinnacle Studio 8.4
SE for vdeo capture,  Matchware Mediator
7 to create presentations dripping with
rich audio, video, sounds and text, and
ATI’s own Multimedia Center, which has
PVR capabilities, players for virtually
everything (Video CDs, CDs and DVDs)
and a media cataloguing library. 

I mentally calculated how much my
kidney would fetch me and considered
the left eye too. Better sense prevailed and
I decided to save the body parts for the
next time I upgraded my processor.

His next best choice was a slightly
sober ASUS GeForce2 MX AGP card with
an onboard TV Tuner for Rs 8,900. I
shook my head and casually sauntered
out of the shop.

The next guy was more in touch with
reality and the annual income of a tech-
nology snoop—he offered me a Pix-
elView TV PCI Tuner card for Rs 2,200
and an Addcom PCI TV Tuner for 
Rs 2,300. However, I was determined to
survey all possibilities before I chose the
right one. 

The next in line tantalised me with a

Pinnacle PCTV Plus TV Tuner that cost
Rs 2,800. Looking around the shop for a
while, I asked if I could get any decent
VGA+TV solution—out came the Compro
VideoMate Cinema. This package com-
prised a GeForce4 MX AGP graphics card
with 64 MB of blaz-
ing DDR memory
and a Personal
Cinema Box—the
TV kit and a remote
control. The GeForce4

MX is no comparison
to the ATi Radeon
9700 AGP card,
but saved me
a body part 
by costing 
Rs 11,925. It was a step above my existing
SiS 6326 AGP card with a meager 8 MB
RAM. The whole solution offered pretty
good 3D graphics, along with an external
TV Tuner Box. The TV Box also offered a
nifty video capture facility and video out-
put. A slick black remote control in the
box was a very cool add-on.

The shopkeeper eagerly explained the
various features of the card, Time Shift
being the most impressive among them.
This feature allows you to watch a previ-
ously recorded program, while recording
the current live telecast in MPG format.
Considering the size of AVI files generat-
ed while recording, this is an excellent
feature for those with budget hard drives.

Weighing all the pros and cons care-
fully, I decided to buy the Compro
VideoMate Cinema solution costing 
Rs 11,995. It gave me a good 3D card and
brought the World Cup to my PC. It did
turn out to be slightly steeper than what
I had bargained for, but the combination
package price made the deal seem wor-
thy. I could finally play all 3D games on
a bigger screen area such as my 21-inch
TV, and watch and record TV programs.
Content with the proceedings, I left with
my pocket lighter but my heart soaring.
Time to watch the World Cup! 

Tune In
World Cup Fever puts Agent 001 in dire need of a TV Tuner card

■ A TV Tuner card comes in two
varieties—a stand-alone PCI
‘daughter card’ or as a full-

flegged AGP video card. 
■ If you already have an AGP video
card, then you need to purchase a PCI
daughter card. This daughter card
should also be a consideration if budget
is of importance.
■ External plug-and-play TV Tuner
boxes are also available that connect to
the PC’s Universal Serial Bus (USB) port,
though these cards lack some of the
features of the internal cards. 
■ Select a TV Ttuner card with a fre-
quency rate equal to or greater than
your monitor. Most new monitors are
compatible with 75 to 85 Hz TV Tuners. 
■ Choose a model with a remote con-
trol for greater comfort.
■ If you intend on using your TV Tuner
card as a Personal Video Recorder (PVR)
solution, ensure that you have ade-
quate storage space.

ILLUSTRATION: Mahesh Benkar
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The average Joe has a small home but
a very big appetite for entertain-
ment. All of us would want to zap

video images from digital camcorders to
our hard drives or personal video recorders
without tripping over the cables that con-
nect them. As home entertainment sys-
tems become more sophisticated, you will
have flat-panel video displays. You would
want to hang them like pictures on your
wall. Who would then want connector
wires to dangle from those beauties?

You must be thinking that we already
have Bluetooth and 802.11 wireless tech-
nologies to do this. They do a decent job
of linking our computers and digital gadg-
ets in the home and office. However, more
bandwidth and speed and a low cost is
always welcome. It’s here that another
wireless technology—ultra wideband or
UWB—is making waves.

UWB can handle more bandwidth-
intensive applications—such as streaming
video—than either 802.11 or Bluetooth
because it can transmit data about 10
times faster than the typical DSL line,
cable modem or 802.11b. It has a data rate

of roughly 100 Mbps, with speeds up to
500 Mbps. Compare that with the maxi-
mum speeds of 11 Mbps for 802.11b,
called WiFi, which is the technology cur-
rently used in most wireless LANs; and 54
Mbps for 802.11a and 802.11g (although
both exist on different spectrums). Blue-
tooth has a data rate of about 1 Mbps.

UWB gives us these extremely high
data rates at a lower cost and
lower levels of power con-
sumption (making it ideally
suited for handhelds and
mobiles). But due to Federal
Communications Commission
(FCC) restrictions, UWB will be
used in the home or office over
a short distance—up to about
30 feet (10 metres)—and oper-
ate at rates of around 100 Mbps.
Most UWB devices should operate
between 3.1 and 10.6 GHz. 

There has been a lot of opposition to
UWB on grounds that it would interfere
with navigational-guidance systems, radar
and satellite transmissions. Big mobile-
phone companies even warned the FCC

that UWB transmissions would block tele-
phone calls. Companies developing UWB
networking technology maintain that
UWB emissions are too low-powered to
interfere with other radio signals. It took
the FCC three years to approve the use of
the technology for commercial wireless
networking applications.

At one point, regulators feared that
mobile gadgets would interfere
with sensitive communica-
tions at airports or military
installations. What would stop
consumers using UWB tech-
nology in MP3 players from
swapping thousands of music
tracks in seconds instead of
minutes or even hours?

Eric Boll, senior applications
engineer, XtremeSpectrum,

explains: “Actually, the FCC didn’t limit the
distance, but limited the power spectral
density in the rules approved in February
2002 for commercial use. Under the FCC
rules, 10 meters is about the distance that
today’s UWB technology can operate while
staying within the spectral mask.” 

A look at ultra wideband, a wireless technology that’s faster than Bluetooth and WiFi, has the potential
to transmit huge amounts of data very rapidly and can pass through walls, floors and even steel

We anticipate commercial applications emerging in the consumer market
by Christmas 2003. The first products will be display-centric in nature, such

as large screen displays, DVD players, DVRs and set-top boxes that have a 
wireless capability. In 2004, you will have consumer electronics products
with embedded UWB capability 
“

—Eric Boll, senior applications engineer, 
XtremeSpectrum”

The wireless
portion of the

home networking
market is forecast
to be $2.5 billion
in 2004, growing
to $3.7 billion 
in 2006.
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Bruce W. Watkins, Pulse~LINK Presi-
dent and Chief Operating Officer, corrob-
orates: “There is no FCC limiting factor of
10 meters—this is a very common mis-
conception.  Nothing in the FCC ruling or
the world of physics limits the technolo-
gy to 10 metres.” It is the wireless UWB
signal modulation techniques used that
limits a company’s particular implemen-
tations of UWB to 10 metres, he adds.

How UWB works
UWB technology has its origins in espi-
onage agencies in both the US and the for-
mer Soviet Union. In the late 1970s, the
research of military radar technicians led
to the ‘ultra wideband synthetic aperture
radar’, used by spy planes and satellites to
see through dense ground cover to locate
enemy troops and camouflaged equip-
ment on the ground. It works by shower-
ing the target with rapid pulses of broad,
low-frequency signals that punch their
way through solid objects. 

UWB works in a similar fashion.
Rather than broadcasting on separate gov-
ernment-auctioned frequencies, UWB
blasts signals across the entire radio spec-
trum. The typical long radio wave is
replaced by rapid fire Morse code-like
bursts, sending hundreds of low-power
(around 50 to 70 milliwatts of power—

ten-thousandth the power of a cellphone)
electrical pulses each second, each lasting
under a nanosecond.

By varying the pulse timing (see box,
‘Catching the UWB Pulse’) according to a
complex code, a pulse can represent
either a zero or a one: the basis of digital
communications. Because the signal is so
low power and so broadly spread, it is
both subject to, and subjects other
devices to, little or no interference. Only
a UWB receiver that knows the exact
pulse sequence generated by the trans-
mitted signal can make use of the infor-
mation in the signal. To the rest of the
world it is just more background noise.

UWB energy pulses operate in the
same frequency spectrum as electronic
‘noise’ emitted by Pentium chips, TV
monitors, electric razors, automobile igni-
tions and fans. This is a huge swath of the
spectrum, regulated only by FCC rules on
how much power these devices can use.

Low power and the characteristic wide
spread of the pulses means the pulses don’t
use up already crowded chunks of the radio
spectrum, today occupied by 802.11b wire-
less LANs and Bluetooth devices. Hence,
UWB would allow a whole new class and
volume of voice and data communications
that, in effect, wouldn’t take up any more
‘space’ in the crowded radio spectrum.

UWB transmitters and receivers are
also said to be simpler to build, run and
maintain than those in use today. For
UWB, you don’t need complex radio fre-
quency converters and modulators. You
only need a digital method to construct
the pulses and modulate them. This can
all go on a single chip. 

How secure is UWB?
UWB promises to be highly secure. It’s
very difficult to filter a pulse signal out of
the flood of background electronic noise
with traditional RF scanners. Besides, ven-
dors such as Time Domain are encrypting
the zeros and ones being transmitted by
the pulses.

Watkins maintains that even if an
‘intruder’ could find the signal in the
noise floor, maintaining precise synchro-
nisation with a series of pseudo-random
pulses of energy present less than 10 per
cent of the time and less than 500
picoseconds in duration is a monumental
engineering challenge. 

Applications
Now that the FCC has given its blessing
to the use of UWB technology for wireless
networking, companies such as Time
Domain and XtremeSpectrum are trying
to bring consumer electronics manufac-
turers on board. Time Domain is already
working with more than 24 companies to
develop applications for its UWB chipsets.

Leading consumer-electronics firms
are expected to begin embedding UWB
chipsets into DVD players, VCRs, video-
game consoles and home-theatre equip-
ment in the coming years. The home-net-
working market is expected to reach $4
billion by 2006. 

Last July, XtremeSpectrum demon-
strated the extreme bandwidth and ‘wire-
like’ video quality of its new Trinity
chipset, a wireless semiconductor solution
suited for applications in the consumer
connectivity market. Using the popular
MPEG2 video format, the company broad-
cast six video streams to six separate flat
panel displays simultaneously across the
room using a single UWB connection. 

Philips and General Atomic teamed up
to produce UWB chipsets that could help
the home network run 40 times faster than
today’s IEEE 802.11b networks. Philips envi-
sions the chipsets that transfer digital con-
tent at 480 Mbps between clusters of enter-
tainment or computing devices in the
home. These could include digital video
recorders, set-top boxes, TVs, and PCs. Last

Ultra Wideband, as the wireless transmission technology used in this architecture, allows for
very low-cost and low-power access points within the home. Existing wireless solutions simply
cannot meet the cost and data rate requirements of such an access point
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year, Intel demonstrated a prototype UWB
system that can send data at 100 Mbps and
says it plans to push the technology to 
200 Mbps and then 400 Mbps, and finally
to 500 Mbps. At that speed, it will be 500
times faster than Bluetooth and nine times
the speed of next-generation wireless LAN
systems.

UWB has enough bandwidth to wire-
lessly network every consumer electron-
ics device in a home from a single access
point. This could include the wireless 
distribution of TV signals (removing the
need for cables between set-top boxes
around the home), data networking for
PCs, PDAs and peripheral devices, home
entertainment center components, white
appliances, home robotics, home securi-
ty, baby monitors and more.  

Future applications, says Boll, include
embedding UWB into battery-powered
products such as camcorders, digital cam-
eras, phones, etc so that consumers can
wirelessly link images to the UWB-enabled
display of their choice, such as a large screen
plasma/DLP/LCD, a PC or an actual TV. The
ability to embed UWB into a battery-pow-
ered device goes back to the low power con-
sumption inherent in ultra wideband.

There will also be UWB-based track-
ing systems to pinpoint the location of
equipment on huge factory floors, find
equipment inside hospitals, or locate ship-
ping containers on a dock, among other
tasks that are hard for industry to handle
now. UWB tracking devices might also be
used to guide rescue robots, or even direct
lawn mowers.

What will it lead to?
Comparisons with Bluetooth and 802.11
technologies are inevitable. However,
some analysts believe that UWB is actual-
ly complementary to these technologies.
Bluetooth was originally designed as a
technology for wireless headsets and was
never intended for multimedia applica-
tions that require a high data rate.

Watkins believes WiFi is a great technolo-
gy for data-centric applications, and that
it will continue to be very successful. Ultra
wideband, by contrast, is ideal for multi-
media, due to its high data rate, low cost
and low power consumption, and thus, is
intended to serve a portion of the market
that is today unserved: wireless multime-
dia connectivity in the home. 

Other analysts feel that Bluetooth is a

low-power option for transmitting data
over short distances, but is very slow at
less than 1 Mbps. All three members of
the 802.11 family consume too much
power and are too expensive for battery-
powered devices.  With UWB having the
raw speed to swap video and audio files,
Bluetooth would be restricted to a handy
wireless-form of ‘wiring’ for low-data-rate
connections between computers and their
peripherals. And 802.11b, also called
WiFi, is becoming popular for wireless
computer networks in homes, offices and
public spaces.

UWB technology consumes much less
power than 802.11, making it ideal for use
in battery-powered devices such as cam-
eras and cell phones. WiFi, in contrast, is
limited to PCs and things that you can
plug into a wall.

UWB’s future will include tracking
devices for personal items such as keys and
eyeglasses; smarter air bags that precisely
locate a seat occupant in order to reduce
the risk of injury; dual-mode cellphones
that improve efficiency and capacity
indoors; hospital communications systems
that can locate and transmit data between
medical devices; and security nets that
spread out like an invisible dome over a
home or a car, warning of intruders.

UWB products are expected to hit the
shelves in the fourth quarter of 2003. This
could include systems to transfer audio
and video from a stereo or DVD player or
camcorder to other devices. Now that will
be an entertaining watch.

LESLIE D’MONTE

The short duration of UWB waveforms lend
them some unique properties. In communi-
cations, for example, UWB pulses can be
used to provide extremely high data rate
performance in multi-user network applica-
tions. For radar applications, these same
pulses can provide very fine range resolution
and precision distance and/or positioning
measurement capabilities. 

These short duration waveforms are rela-
tively immune to multipath cancellation
effects as observed in mobile and in-build-
ing environments. Multipath cancellation
occurs when a strong reflected wave—for
example, off of a wall, ceiling, vehicle, etc—
arrives partially or totally out of phase with
the direct path signal, causing a reduced
amplitude response in the receiver. With
very short pulses, the direct path has come

and gone before the reflected path arrives
and no cancellation occurs. As a conse-
quence, UWB systems are particularly well
suited for high-speed, mobile wireless appli-
cations. Also, because of the extremely short
duration waveforms, we can implement
packet burst and time division multiple
access (TDMA) protocols for multi-user com-
munications.

As bandwidth is inversely related to pulse
duration, the spectral extent of these wave-
forms can be made quite large. With proper
engineering design, the resultant energy
densities (that is, transmitted Watts of power
per unit Hertz of bandwidth) can be quite
low. This low energy density translates into a
low probability of detection (LPD) RF signa-
ture. An LPD signature is of particular inter-
est for military applications (example, for

covert communications and radar), howev-
er, an LPD signature also produces minimal
interference to proximity systems and mini-
mal RF health hazards, significant for both
military and commercial applications.

Among the most important advantages
of UWB technology, however, are those of
low system complexity and low cost. UWB
systems can be made nearly ‘all-digital’,
with minimal RF or microwave electronics.
Because of the inherent RF simplicity of UWB
designs, these systems are highly frequency
adaptive, enabling them to be positioned
anywhere within the RF spectrum. This fea-
ture avoids interference to existing services,
while fully utilising the available spectrum.

According to one estimate, 20,000 peo-
ple could talk on UWB cellphones within
one square block with no interference.

Catching the UWB Pulse
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Hold virtual meetings across cubicles and verify, edit and pass
documents to others without taking your eyes off the monitor!

together
Getting 

it

In a world where you need to keep run-
ning just to stay in position, and where
everything is governed by one catch-
word—‘faster’, technology has given

us some nifty tools that make it easier to
communicate with others and manage
work across the office more efficiently and
with precision. Here are some tried and
tested tricks of the trade that any office of
the New Millennium cannot afford to miss.

Coordinate with Outlook
Outlook offers some neat collab-
oration features—apart from 
e-mail, of course—that will help

you share information and work together
with your colleagues more efficiently. 

You can use the Task and Calendar
features in Outlook to coordinate work
with others in the organisation. To set a
task for a particular day, go to Task and
double-click on ‘Click here to add new
task’. In the window that opens up, you
can set the job, its due date and priority,
and also gauge its progress. You can even
set a reminder. To forward the task-sheet
to others, all you have to do is press [Ctrl]
+ [F] and address it to the individuals con-
cerned or groups.

If you need to delegate a job, set the
task as described above and then send it to
the person concerned by clicking ‘Assign
task’. You can keep track of the progress by
opting to keep a copy with you by click-
ing ‘Keep an updated copy of this task on
my task list’ and by choosing ‘Send me a
status report when this task is complete’.

The Notes facility helps you jot down
things in the manner of a sticky note and
they can be coloured individually to
denote different subjects. You can cate-
gorise these notes by the subject such as
holiday, business and even forward them
to others. 

Spread the word with Microsoft
Word

Microsoft Word too has some
inbuilt capabilities to aid collab-
oration. When different people

work on a document, you often end up
with as many versions as the number of
people involved. However, Word offers
several features that help reduce the clut-
ter and confusion.  
Track changes: One of the easiest ways
to keep track of the changes made to a
document is through change tracking.
Share the document so others can have
access to it, or route it through e-mail (see
box, ‘Routing a Document for Review’). If
you’ve shared the document, click on Tools
> Track Changes > Highlight changes and

Assign tasks through Outlook
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select ‘Track changes while editing’. Now
any change made to the document will
show up as revision marks. Changes made
by different users will be marked in dif-
ferent colours and under the name of the
machine they make the changes from.

You can even jot down comments on
a particular line or portion of the text
without actually changing the text. Click
on Insert > Comment and type your obser-
vations. When you are done, the portion
of text will remain highlighted and your
comment will show up as a little note
when the mouse is pointed to the high-
lighted area. To delete a note made by
another user, simply right-click on the
comment and choose Delete Comment.

Once all the changes have been done,
you can review the final copy and accept
or reject the changes (Tools > Track Changes
> Accept or Reject Changes). 

In case you sent separate
copies to the people who
need to work on a docu-
ment, you can merge all
their changes into one docu-
ment rather than going
through each one separately.
Open the original document
and in the Tools menu, click
Merge Documents. Now
open the reviewed copies
one by one to merge them. 

Thus, multiple users can
make changes to the same
document, while the final control over
what changes get implemented still rests
with you. Even if you forgot to enable
change tracking, you can still view what
changes have been made and accept or
reject them. Simply open the edited ver-
sion of the document and then, under
Tools > Track Changes, select Compare 
Documents.
Versioning: You can save on disk space
and clutter by saving multiple versions of
a document in one file. Here Word auto-
matically saves a ‘snapshot’ of just the
changes when you close a file, with a
record of the date, time and the name of
the person making the changes. 

You can manually save versions of the
file by clicking on File > Versions > Save Now,
or you can set Word to automatically save
a version when you close the file. For this,
click on File > Versions and select ‘Automati-
cally save a version on close’; click on Close. 

Versioning helps you keep track of all
the changes and stages the document has
been through. To view an earlier version,
in File > Versions, simply click on the 

version of the document you want to view
and it will be displayed in a separate win-
dow. You can even make changes in an
earlier version by saving it as a separate
file. You may also want to save a multi-

versioned file as a separate
file so that viewers can
access only the final version.
Saving as a separate file also
aids in comparing it with an
earlier version.
Document properties:
You can also track a docu-
ment within the organisa-
tion through the Document
Properties. This feature
allows you to store addi-
tional information about a
document, other than the

default properties. These include the date
of completion, project, publisher, refer-
ence, source, status and other details that
would aid you in tracking the document.
To modify the custom file property, click
on File > Properties and then click the Cus-
tom tab. Next, select the custom property
you want to modify, select the type and
enter a new value in the Value box. Click
on Add to finish.

Stay in touch with NetMeeting
Meetings are an integral part
of any working day, but you
can confer with others right

through your desktop,
thanks to the Internet and
instant messengers. To send
a file through MSN Messen-
ger, all one has to do is go to
Action > Send a File or Photo…
and attach the file and click
Send.

In addition, you have
free utilities such as NetMeet-
ing, an excellent office pro-

ductivity tool that lets you hold virtual
meetings, and share ideas and resources
across different computers and networks.
You can use NetMeeting along with a Web
cam to hold a video meeting, or just chat
with the people at the other end. The
whiteboarding function makes it very easy
to share ideas across the network. One
remarkable feature in NetMeeting is the
ability to share and control programs. This

way, you can securely control applications
and even the desktop of a remote comput-
er. NetMeeting also lets you securely trans-
fer files to the recipients. Obviously, both
parties must have NetMeeting started.

Start NetMeeting, go to Call > New Call
and enter the IP address of the person you

want to hold a meeting
with. Next, from Using,
select Automatic, which will
set the default values, so
connecting will be hassle-
free. Click Call. In case your
meeting revolves around a
particular report or docu-
ment, use the Share Pro-
gram icon—to do this, open
the document on your 

If you need several people to work on a
Word document sequentially, so that each
person gets to see the comments made
by those who have reviewed it before,
you can route it through e-mail. Under
File > Send To, click Routing Recipient
and click Address to select the people you
want it sent to; click OK. The document
will be mailed as an attachment to the
first person on the list. After he or she has
finished editing it, he or she simply needs
to point to File > Send To and click Next

Routing Recipient. In this manner, the file
will be mailed to people in the order in
which their e-mail address has been list-
ed; click Route document to recipient
name. The document is automatically
returned to you after all recipients have
finished with it.

Remember that when routing a docu-
ment for review, if you add a group
address rather than individual addresses,
it will be routed to all members of the
group simultaneously.

Routing a Document for Review 

Since the tracked
changes can be

quite distracting as you
read the document on
screen, you can turn off
the option of viewing
the changes on screen.
Click on Tools > Track
Changes > Highlight
changes. Select ‘Track
changes while editing’,
but unselect ‘highlight
changes on screen’.

NetMeeting is tight-
ly integrated into

MSN Messenger too, so
if you have NetMeeting
installed, you can start it
from MSN from Actions
> Start NetMeeting—
this allows you to
directly switch from the
IM to NetMeeting.

The Whiteboard function in NetMeeting opens
a separate window where the online meeting
participants can type text, draw shapes, copy,
paste and delete objects, and highlight or
point to text and graphics
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toolbar and click Share Program. Now
choose the document, click Share and
Allow Control. Doing this allows the per-
son at the other end to make changes to
the document. (For more tips, refer the Tips
and Tricks section.)

Sharepoint
A virtual office needs a virtual
information pool and that’s
where Microsoft Sharepoint Team

Services comes to the rescue. Consider it as
a huge room of records where information
can be shared, documented, collaborated
and collected by the members of the team
over the Internet or corporate network.
Users can log on, collaborate and use team
services through a browser interface for
which the administrator has to create
accounts for each user on the Sharepoint
Team Services server. 

Sharepoint Team Services requires
Windows XP Professional, 2000 Profes-
sional, 2000 Server, 2000 Advanced Serv-
er, or 2000 Datacenter Server with Inter-
net Information Services (IIS) 5.0 or later,
including Internet service and Service
Pack 2 (SP2), Microsoft Data Engine
(MSDE) or Microsoft SQL Server 7.0. It

requires Microsoft Internet Explorer 5.0 or
Netscape Communicator 4.75. In case it
does not detect Microsoft SQL Server, it
will automatically install MSDE. All you
have to do is create an account in
Microsoft SQL Server 7.0 using the
installers from the Sharept folder found
in your Office XP Professional CD and
click on setupse.exe. 

The SharePoint Team Services have a
mine of features—not only are all your
team’s resources and work stored in one
place using the Document Library feature,
but the team can also share ideas and the
Subscribe feature alerts the members
when the Web site is updated. Inline doc-
ument discussions make it easy to collab-
orate on specific deliverables without
altering the original documents and dis-
cussion boards that serve as a central
forum for specific topics and surveys. 

Sounds like a complex operation? Not
really. All you have to do is create an
intranet team Web site while installing.
Once you start on this setup page, click
Extend, which will direct you to where
you set up the virtual server. Here you set
up the administrator account and enter
the necessary account details with data-
base server name/IP address, a user
account and password. Click on Submit
to create the Web site, which can be
accessed as http://(name of the computer,
which can be changed later to a desired
name).

Then create user accounts for every-
one by clicking on Site Settings and set
their access levels here. You can set
Sharepoint access based on the usage.
For example, the basic Browser access
level on default installation lets you
view all the files. A Contributor can par-

ticipate in the discussion list, the Author
level access lets you add and delete pages
within the intranet site, while the
Advanced Author access can change the
intranet URLs.

The members can also vote on a par-
ticular topic. Click on Create and choose
Survey and create the Survey Options 
as required. You can then get the other
members to respond to that survey and
thus take a collective decision on any topic. 

And if you want to find if anyone
has changed and uploaded new docu-
ments, simply go to Documents > Shared
Documents > Subscribe and under ‘Notify
me when…’, choose ‘Anything changes’.
Fill in the e-mail address and under
Time, choose ‘When a change occurs’.

This feature can be used for lists or doc-
ument libraries. To upload a new docu-
ment, go to Document > New Document and
enter the username and password in the
network window that pops up. You can
also make changes to someone else’s
document. Say it is a word file, all you
have to do is click on Tools > Track changes
> Highlight changes and selects ‘Track
changes while editing’. 

All together
With increasingly more casual corporate
environments, the offices of the future
may exist only in our virtual worlds. Col-
laboration techniques bring us one step
closer to this possibility, allowing teams
to function outside the concrete boxes of
conference rooms and workstations.
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Microsoft Excel
To be able to share an Excel workbook
between multiple users, go to Tools > Share
Workbook and then click on the Editing tab.
Check ‘Allow changes by more than one
user at the same time’ and then click OK.
When prompted, save the workbook on a
network location accessible to the intended
users. Remember to use a shared network
folder and not a Web server.

Just as in a Word document, com-
ments can also be added to an Excel file.
Right-click on the cell you want to insert a
comment in and choose Insert Comment.
If you don’t want your name in the 

comment box, select and delete it. When
you are done typing the comment, click
outside.

Windows PowerPoint
The comment facilities are available in Pow-
erPoint too. Select the slide you want to
add your comment to, go to Insert > Com-
ment and type your little note. However,
you can edit or delete only the discussion
comments that you write. To do so, click
‘Show a menu of actions’ at the end of the
discussion comment, click Reply, Edit or
Delete and proceed with typing your
response to the comment.

Wise Comments

Fill the server settings in Sharepoint

You can share your favourite bookmarks
with others by clicking on File > Import
and Export in your browser. This will
start a wizard that will ask you whether
you want to import or export your
Favorites. Next it will ask for the location
from where it has to be exchanged.
Once this is provided, it will
export/import your bookmarks.

Sharing Bookmarks

Track changes in Sharepoint
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What’s the first thing that comes
to your mind when you get
your electricity, phone or credit

card bills? Pay it! Then why are we asking
you this silly question? Simply because
today you have many ways of paying bills.
You could physically go to BSES and MTNL
offices, stand in a queue and pay the bills.

Or, you could get someone else to do
it for a charge. Of course, you could
use phone banking too. The third way
is to log on to the Internet and pay
them online. And if you choose to do
this, or are doing it, then you are one
among the 100 million households
that now bank online. (See graph,
‘Seven-and-a-half years of Web Banking’)

That’s not all. You can surf for a
loan, life insurance or a home mort-
gage. You can even trade shares or
shop from the comfort of your home.
Online banking isn’t out to
change your money habits.
Instead, it uses today’s com-
puter technology to skip the
time-consuming, paper
work of traditional banking
in order to manage your
finances more quickly and
efficiently—it’s available 24-
hours, there are no queues,
convenience and the like.

If you are an account
holder at a bank which has
a Net banking facility, you
are given a Net password.
You have to fill out a form

detailing your preferences after which the
password is couriered to you. The courier
generally contains the user ID, login pass-
word and transaction password. For secu-
rity reasons, users is asked to change the
login and transaction passwords after they
first login. In some cases, you have to write
to the bank to get your user ID enabled.
On clicking the login button, your user ID
and password generally travel in a secure
SSL mode with 128-bit encryption (see box,
‘How secure is Online banking?’). 

What’s on offer?
While many banks offer online banking
facilities, most of them do not offer up-to-
the-second account information. This
means that if a cheque issued by you has
been debited from your account in the
morning, your account status will not
reflect this when you login to your account
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Do you still pay your bills by mail, deposit checks at your bank
branch, and prefer a personal visit to your banker, much the way

your parents did? If yes, then you’ve either not heard about online
finance services and online banking, or probably never tried it.

Guess what? It’s worth a try

Your 24-hour
finance manager
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in the afternoon. That’s because the
account is updated at the end of each day.

The features include credit card pay-
ment and account statement download.
You can update your mailing address and
transfer funds between your accounts, even
if they are in different branches/cities. You
can also open a fixed deposit account
online and access its details such as princi-
pal balance, term of deposit, rate of inter-
est, maturity date, maturity amount and
instructions for payment.

You can issue a Demand Draft (DD) or
a banker’s cheque from your account at

special rates. DDs, however,
will generally be issued
only where the bank has a
branch or an arrangement
with a local bank. You can
access information on the
tax deducted at source
(TDS) for all your deposits
for the current or previous
financial year. If you have a
doubt, you can request Stop
Payment on a cheque or
series of cheques by just
entering the cheque num-
ber and the reason for stop-

ping payment.
You can view the status of a cheque

issued on any of your accounts, and also
request for a new cheque book. If you hold
a Demat Account (it is now mandatory that
shares be dematerialised, for which you
need to open a Demat account) with the
bank, you can access your account online.
You can thus see your holdings as on the
close of the last business day, view your
transactions for the last seven days, and
check the status of the shares submitted for
Demat in the last one month. 

Banks such as HDFC and ICICI also

offer the option to purchase goods online.
You can shop at Web sites which offer the
facility, such as Sify.com, Fabmart.com,
VSNL.com. If you purchase any goods online,
your account would be debited and the
merchant’s/Web site’s account credited
instantaneously (as with Debit cards).

Online trading
Many of those customers who have cho-
sen to trade shares online today, had at
one point of time been trading through
offline brokers. For instance, ICICIdirect.com
claims that more than 1 lakh customers
have already opened an account with
them for online trading.

There are a few advantages of online
trading. In systems where the brokering,
banking and Demat accounts are com-
pletely integrated, your money remains in
your own bank account, and does not get
transferred to the broker's pool account.
The experience of trading through Internet
depends a great deal on the type of product
offered by the site. 

In the case of ICICIdirect.com, your bro-
kering account, bank account and Demat
account are linked electronically. So when
you punch in a buy or sell order, the system
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Net banking demo
Account balance inquiry
Account statement inquiry
Cheque status inquiry 
Stop payment request
DD/bankers cheque request
Funds transfer
Cheque book request
FD inquiry 
New FD requests
TDS inquiry
Leave us an Instruction
Utility bills payment
Depository inquiry
Credit card bills
Term loan details
128 bit SSL encryption
Help Line (24 Hours)

American
Express

✖

✔

✔

✔

✖

✔

✔

✖

✖

✖

✔

✔

✖

✔

✖

✔

✔

✖

HSBC

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✔

✔

✖

✔

✖

✔

✔

HDFC

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✔

✔

Bank of
India

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✔

✖

✔

✖

✖

✖

✖

A model bank should familiarise the customer to the new Web environment by a demo version of software on its Web site. The demo should
contain a tour of the features included. It will enable users to give suggestions for improvements, which can be incorporated in later versions
wherever feasible. That only some banks do this is evident from the table below.

The bank should provide services such as account information and balances, statement of account, transaction tracking, mail box, cheque
book issue, stop payment, and financial and customised information. In addition, it should also facilitate services such as fund transfers,
Demand Draft issue, standing instructions, opening fixed deposits, and intimation of loss of ATM cards.

The Services Offered Online

Citibank

✖

✔

✔

✖

✔

✔

✔

✔

✖

✖

✖

✔

✔

✖

✔

✖

✔

✔

Standard
Chartered

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✔

✔

✔

✔

✔

✔

✔

ICICI

✔

✔

✔

✔

✔

✖

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✔

✔

Global Trust
Bank

✖

✔

✔

✔

✖

✔

✔

✔

✔

✖

✖

✖

✖

✔

✖

✖

✖

✖

Corporation
Bank

✖

✔

✔

✔

✔

✔

✔

✔

✔

✔

✖

✖

✖

✖

✖

✖

✖

✖

OneView from HDFC offers a single-window view of your account
status in different banks
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checks the funds/shares availability and
automatically credits/debits the accounts
once the order is executed by the exchange.

A trader can trade shares on margin at
rates as low as 0.10 per cent. It’s important
to compare various online trading sites on
brokerage rates, inclusive of all sub-charges.
The tickers available on these sites provide
instantaneous updates. Also, some Web
sites can offer to transact in those shares
instantaneously and with convenience.

Online trade confirmations reach ICICI
customers within 4 minutes, while contract
notes are dispatched at the end of the day
and reach within 24 to 36 hours.

Investors trading online can also do
their technical analysis, know what other
brokers are recommending—buy or a sell,

access live news from international agen-
cies such as Reuters and CNBC, and find
out what the leading CEOs think about the
state of the economy and the capital mar-
ket.

Are you buying yet?
In India, while the population runs into bil-
lions, Internet surfers amount to a very
miniscule percentage. An IDC report states
that there are almost a million active Net
banking users—that might just be 0.01 per
cent of the total population, but they rep-
resent 15 per cent of the Net user populace.

One expects banks to woo customers to
logon and mutually save time and money.
In the US, for instance, banks encourage
customers to transact online by crediting

around Rs 1,250 to them. Paying
you money to transact online is a
remote thought in India. Just look
at the terms of agreement (the small
print as usual). They generally read:
“…the user hereby fully indemnifies
and holds the (Bank) and its affili-
ates harmless against any action,
suit, proceeding initiated against it
or any loss, cost or damage incurred
by it as a result thereof…”

You will notice that any possi-
ble risk (see box, ‘How Secure is Online

banking?’) connected to online banking is
passed on to you. If a hacker manages to
crack the password or commit any breach,
the customer has to pay even if he was not
at fault. In the US, it's not so. Banks cover
the risk of hacking and the customer is
encouraged to perform online financial
transactions.

There are quite a few services missing
in the best of online banks in India. They
include Online PPF accounts. Many
nationalised banks have PPF accounts. If
only these were made available online.
One would also love to pay taxes online.

Fully functional online banking will
take a long time to become as common-
place as automated teller machines
(ATMs). And then, virtual banks can’t give
you cash for which you have to go to an
ATM. Also, some banking Web sites can
be difficult to navigate at first. Besides, a
lot of fine print needs to be checked. 

However, for many people, the biggest
hurdle to online banking is learning to
trust it. Did my transaction go through?
Did I push the transfer button once or
twice? While the government, banks and
financial institutions can do their bit in
educating the public, on our part, we need
to take a first step-that is, get an Internet
banking facility.
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In a survey conducted by the Online Bank-
ing Association, member institutions rated
security as the most important issue of
online banking. There is a dual requirement
to protect customers’ privacy and protect
against fraud. The software generally used
by banks for online banking is secure, tried
and tested. Browsers offer from 40-bit to
128-bit encryption. Indian cyber laws too
have given legitimacy to digital signatures.

In Netscape versions 3.x and earlier, you
can tell what kind of encryption is in use for a
particular document by looking at the ‘docu-
ment information’ screen accessible from the
file menu. The little key in the lower left-hand
corner of the Netscape window also indicates
this information. A solid key with three teeth
means 128-bit encryption, a solid key with
two teeth means 40-bit encryption, and a
broken key means no encryption. 

Even if your browser supports 128-bit
encryption, it may use 40-bit encryption when
talking to other servers or to servers outside
the US and Canada. In Netscape versions 4.x
and higher, click on the ‘Security’ button to

determine whether the current page is
encrypted and, if so, what level of encryption
is in use. 

In the Microsoft Net Explorer, a solid
padlock will appear on the bottom right of
the screen when encryption is in use. To
determine whether 40-bit or 128-bit encryp-
tion is in effect, open the document infor-
mation page using File > Properties. This will
indicate whether ‘weak’ or ‘strong’ encryp-
tion is in use.

SSL uses public-key encryption to
exchange a session key between the client
and server. This session key is used to encrypt
the http transaction (both request and
response). Each transaction uses a session key
so that even if someone did manage to
decrypt a transaction, they cannot find the
server’s secret key. If they wanted to decrypt
another transaction, they’d need to spend as
much time and effort on the second transac-
tion as they did on the first. 

Servers and browsers do encryption
ranging from a 40-bit secret key to a 128-bit
secret key, that is to say ‘2 to the 40th

power’ or ‘2 to the 128th power’.  In a 40-
bit key, you will have to keep on trying each
of the 2^40 possible keys until you find the
one that decrypts the message. This was in
fact demonstrated when a French researcher
used a network of fast workstations to crack
a 40-bit encrypted message in a little over a
week. An online credit card transaction is
completed in a few moments, not giving
enough time to crack your password. 

Of course, using a 128-bit key makes it
more difficult because there are 2^128 instead
of 2^40 possible keys. Using the same method
(a networke of fast workstations) to crack a
message encrypted with such a key would
take significantly longer than the age of the
universe using conventional technology. 128-
bit is not just ‘three times’ as powerful as 40-
bit encryption.  2^128 is ‘two times two,
times two, times two...’ with 128 two’s. That
is two, doubled on itself 128 times. 2^40 is
already a huge number, about a trillion (that’s
a million, million!). Therefore, 2^128 is that
number (a trillion), doubled over and over on
itself another 88 times.

How Secure is Online Banking?

You can trade online at Sharekhan.com
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We know that Windows 98 isn’t
exactly Fort Knox when it
comes to security. But even

today, it continues to power the majority
of desktop computers. However, it does
offer a crude one-stop defence mechanism
in the form of the Screen Saver password.
With a few simple tweaks, it can be used
quite effectively to cover up some of Win-
dows 98’s inherent security flaws.

Setting the screen saver
password

Right-click on an empty area of the Desk-
top and select Properties from the drop
down menu. Now choose the Screen
Saver tab and select a screen saver of your
choice. Click the ‘Password protected’ tick
box and then click on ‘Change…’. This
will open up a dialog box where you will
be prompted to enter a new password.
Remember to follow the usual safety
guidelines while picking a screen saver
password: don’t use simple keywords such
as your name or initials. This is important
as the Screen Saver password allows for an
infinite number of retries and an easy
password has a higher probability of
being ‘guessed’ out. You will see a ‘The
password has been successfully changed.’
message after you’ve typed in your new
password. Click OK to finish.

Activating the screen
saver on demand

A screen saver only starts up if the com-
puter is idle for a predefined period of
time. But you can also invoke the screen

saver on demand by creating a shortcut
for it and then assigning it a hotkey.

Right-click on an empty area of the
Desktop and select New and then
Shortcut. This will open the Create
Shortcut dialog box. Click on Browse
and navigate to the System subfolder
under the folder where Windows is
installed (typically C:\Windows). Now
click on the ‘Files of type’ drop down
list box and select All Files. Double-click
on your screen saver, click on Next to
assign a name for the shortcut, type
something simple like ScrSvr and click
on Finish. A shortcut will be placed on
the Desktop. You can now invoke the
screen saver by double-clicking on the
ScrSvr icon.

To make it even easier to invoke the
screen saver, assign it a hotkey. Right-
click on the ScrSvr icon on the Desktop
and select Properties. Now click on the
‘Shortcut key’ field under the Shortcut
tab. Any shortcut key combination will
include the [Ctrl] and [Alt] keys by
default; choose any key, say [S], as your
shortcut key. Finally, click OK. You can
now launch the screen saver by simply
pressing [Ctrl] + [Alt] + [S].

Screen saver as your Win-
dows lock 

In Windows 98, the default guest login
offers full access to all system resources.
Thus, it only takes a simple reboot to
override the security measures provided
by the screen saver password. A registry
hack can remedy this and in turn provide
some semblance of a login control system
(actually it will only prevent unautho-
rised access, but in a single user environ-
ment, that’s just as effective).

Click on Start > Run and type reged-
it. Remember to back up the Registry

files (the system.dat and user.dat files in
your Windows folder) to avoid acci-
dents. Now navigate to HKEY_LOCAL_
MACHINE\Software\Microsoft\Windows
\CurrentVersion\Run.

Click on the Edit menu and select
New then String Value’. Give this string
value any name such as ‘SSLock’. Right-
click the newly created String Value and
choose Modify. This will open up the
Edit String dialog box. Enter the path to
the Screen Saver shortcut file that you
created earlier in the ‘Value data’ field.
Finally close the Registry Editor.

Now Windows will automatically
load the screen saver whenever it starts
up. And as we’ve enabled the Screen
Saver Password feature, you will always
be prompted for a password upon boot-
up. This ensures that only someone who
knows your Screen Saver password will
be able to use the machine. 

Your screen saver is now configured to
provide on-demand security at the press of
a shortcut key and will also prevent unau-
thorised use of the machine upon boot-up.
Simple, yet highly effective.

Assign a Shortcut key to your screen saver

Create a shortcut to your screen saver

Fortify that Screen Saver

Auto start the screen saver with Windows bootup
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The right to write 
I own a PC with a P4 processor, 

128 MB RAM and a 40 GB hard disk. For
quite some time I’ve been unable to
delete some of my files from my hard disk
and I get the message, ‘cannot delete file.
Check whether the disk is write protected
or not in use.’ This is extremely frustrating.
Please help.
Anand Kumar
Via e-mail

You haven’t mentioned which OS you
use or the kind of file system adopted by
you; we are assuming you use Windows
2000 or Windows XP with NTFS partition. 

First, you will need to check the per-

mission of the files you want to delete.
Right-click on the file and select Proper-
ties. On the window that appears, select
the Security tab. You will now be able to
see the names of the users and the per-
missions granted to each. Check if there
is an entry such as ‘Everyone’. If yes, click
on it and select Full Control.

If you can’t find Everyone, check if
there exists an entry by your username
(login name) and click on the entry to view
the permissions. If this is also not present,
then enter your username or ‘Everyone’ by
clicking on the Add button and then click
Everyone or your login/username. Finally,
add the required set of users and then click
OK. Now activate the ‘Full control’ rights
box for Everyone. Press the OK button to
close the window. You will now be able to
delete the file since you have the rights to
access the file. 

However, if you are using FAT32 file
system, check whether the files are being
used by any other program running in the
memory. If not, ensure that you have no
file protection software or any such utili-
ty installed on your computer. If you have
software installed on your machine that
gives you the facility to password-protect
certain files, then check the permissions
of the file using the software. Remove all
protection, then delete the files.

XP autodials to the Net
My system has a P4 2.4 GHz proces-

sor, an Intel 845 GBV motherboard, 
256 MB DDR RAM and a 40 GB hard disk.

I have Windows XP as the operating sys-
tem. My problem is that whenever I start
Windows XP, the dialup connection starts
automatically. The same thing happens
when I start a program. What could be
the problem?
Kumash Desai
Via e-mail

To solve your problem, go to Control
Panel and double-click on Internet
Options. In the pop-up window, click the
Connections tab and select ‘Never Dial a
Connection’. Click OK to save and close
the window. This will solve your problem,
but now whenever you wish to get on the
Internet you would have to manually dial
a connection.

Blank screen while loading games, missing data, floppies that don’t work,
problems with qudraphonic speakers—the doctor will see you now…

Stop your Internet connection from auto
diallingRight Access to users in Windows 2000
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I draw a blank!
I have a Pentium III processor with a

Compaq Presario 5000 installed with
Windows Me. The problem I am facing is
that some games, after being loaded to
play, show a blank screen, but the sound
works fine without any disturbances. The
busy light on my CPU remains on through-
out. In a few other games, the graphics
appear on screen gradually. Please help.
Aditya Bajaj
Via e-mail

The problem pertains to the display
drivers (VGA drivers). In the Control
Panel, double-click on System and then on
the Device Manager button. Click on the
plus (+) sign next to the display adapters—
it should not be showing a yellow icon on
it. If it does show an error icon on the dis-
play adapter, then you need to load the
updated set of VGA drivers.

However, if the adapter is configured
properly then the problem could be
because you are using a low-end VGA
card. In this case, the only option would
be to upgrade the VGA card to the level
required by the game. A GeForce MX or
above should be more than adequate for
most games.

Invisible Data
A few days ago I had taken my home

hard disk (a 40 GB, 7,200-rpm drive) to my
college to copy some data. I had connect-
ed my home hard disk as Slave (CL) and
copied around 2 GB of data to it, but when
I checked the hard disk at home (connect-
ed as Primary), it didn’t show the copied
files, though the used up space reflected
the size of those files. What should I do?
Should I format my C drive and reinstall the
OS? Or is there another way out?

There’s another problem with my C
drive: when I run Disk Cleanup, it doesn’t
clean the disk properly. It stops in between,
at ‘Compress old files’. CPU usage reaches
the 100 per cent mark and it doesn’t come
down even when I cancel it—it remains in
the ‘Tasks Running’, so I have to manually
end cleanmgr.exe to make things stable.
Any ideas about these strange problems?
Deep Ganatra
Via e-mail

Problems while copying from hard
disk to hard disk usually happen while
performing Drag-N-Drop copy. It is very
easy to drag the files to the wrong folder.
So if you remember some of the filenames
that you had copied, search for them in

your hard disk. Also ensure that the ‘Show
hidden files and folders’ option is checked
(Click on Tools > Folder Options or View >
Folder Options depending upon the operat-
ing system installed).

As for your second problem, as time
passes a lot of temporary files are created
in the system, so it takes time to prepare
a list of the unwanted files. If you feel that
the machine hangs, run Scandisk with the
Thorough option checked. The Thorough
option checks the hard disk surface for
physical damage. It would take some time
to check but after the test is complete, the
problem should be solved.

Cannot playback audio stream
I have a Celeron 633 with 64 MB RAM

and a 20 GB hard disk with four partitions.
The primary partition (C:) has Windows
XP Professional and Windows 98SE
installed (in different folders); the last par-
tition (F:) has Mandrake Linux installed.

In XP and Linux, video and audio files
run well, but Windows 98 shows an error,
‘Cannot playback the audio stream, no
audio hardware is available or the hardware
is not responding (Error =80040256)’; a 
little later the video starts without audio.
How can I fix this?
Anoop Kumar Vaidya
Via e-mail

You are facing this problem in Win-
dows 98SE because its Windows Media
Player (version 6.4) cannot play videos
encoded with the newer codecs. To solve
this, you need to install the appropriate
codecs. The DivX codec is available at
www.divx.com and the Nimo codec at
http://nimo.titanesk.com/modules/mydown-
loads/. You can even download the latest
version of Windows Media Player from
the Microsoft Web site.

Ruling the messages
My company receives around 200-

300 messages a day, which are distributed
to the employees concerned through
Postmaster. In case a virus in a message
damages a system, we have to run
Windows setup again on that PC. This
obviously erases all the Message Rules set
in Outlook Express.

Is there some way to back up Message
Rules in Outlook Express so that they don’t
have to be recreated in case of a Windows
reinstallation? Also, can one rule be applied
to all the terminals on the network?
Sarita Sawant
Via e-mail

Outlook Express does not provide any
mechanism to export/import Message
Rules. So there’s no option but to 

Scandisk scans tirelessly
My PC has a P4 1.5 GHz processor, a

20 GB Samsung hard disk and an Intel
845 motherboard. My problem is that
when I start the machine, it automati-
cally runs Scandisk and also shows a
message that the hard disk contains
bad sectors. This is
despite the fact that I
shutdown the
machine properly. But
after completing the
surface test, no bad
sectors are found.
Why is this happen-
ing? Please help me
solve this problem.
Shubha Nambiar
Via e-mail

Anytime a problem occurs while
accessing the hard drive, Windows
makes some entries in the registry. The
next time you boot up the machine,
Windows recognises the entries and
takes preventative/corrective steps to

ensure less damage. Scandisk tries to
detect the problem and update the reg-
istry entry properly. In your case, Scan-
disk, even after successful completion,
is unable to remove the entry, hence
Scandisk appears every time you boot

up. 
You could try dis-

abling Scandisk
manually in the
msdos.sys file, but
this would perma-
nently disable Scan-
disk. It will not run
automatically even
in case of an error. So
the safest bet is to
reinstall the operat-

ing system.
Alternately, since you have a Sam-

sung hard drive, you can download a
diagnostic utility, SHDiag.exe, provided
by Samsung on its Web site. In case this
utility detects an error it can't repair,
you should take your hard disk to the
RMA centre for repairs.

ILLUSTRATIONS: Mahesh Benkar
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re-enter each rule once you reinstall your
operating system. There is also no way
to implement these rules over the 
network.

What you could possibly do is switch
to Microsoft Outlook which does allow
you to export as well as import rules. 

You can do this through the Tools >
Rules Wizard Options in Microsoft Outlook.
To export the rules, press ‘Export Rules’,
type the filename and press Save. To
import the rules, press ‘Import Rules’,
select the filename and press Open to
browse previously saved rules. 

System hangs the first time
I am facing a rather strange problem.

If I boot my system after a fairly long inter-
val, say 4 hours or so, it always hangs the
first time. I have a Pentium III 800 MHz
system with 128 MB RAM and 500 VA
UPS. I leave the UPS charging all the time.
R.B. Rajesh
Via e-mail 

The problem seems to be with the
SMPS of the system. If you have access to
a spare SMPS, try changing to it. If this
fixes your problem, then you should 
get the original SMPS checked by a 
professional.

A halting response
Whenever I run any applications or

games, they stop responding for a few
seconds. Even after ending tasks of other
applications (expect Explorer, System
Tray), the problem persists. Is this due to a
virus? I have an Intel 810E motherboard, a
Pentium III processor at 1.0B GHz, a 40 GB
hard disk and 128 MB RAM with Windows
Me and XP installed. Please tell me what
to do.
Rohit Yadav
Via e-mail

It all depends on the games you are
trying to play. Every game has its own
minimum hardware requirement, so do
check in the manuals and/or documents
of the game. You can analyse the RAM
requirement from the Task Manager win-
dow in the status bar. It shows the Mem-
ory Usage as current/maximum.
Remember that the maximum includes
the virtual memory, so check your current
usage value relative to the 128 MB RAM
that your machine has. If it falls short,
you need to upgrade to more RAM.
Another factor to check is the VGA sup-
port required for the game. If the game

needs 3D and OpenGL, whereas the VGA
card in your system does not support
these, then you need to upgrade the VGA
card too.

Afflicted by virus
I have a Pentium III based system run-

ning Windows 98SE. It is connected with
10 other systems on the LAN. The prob-
lem is that the system is affected by virus-
es—alevir.exe, scrsvr.exe, marco.scr,
brasil.pif, brasil.exe. I am using Norton
2002 and AVG AntiVirus, and I update
these regularly. Even though I’ve deleted
the virus-affected folders from the
Windows directory, they reappear after
some time. Please give me a solution.
Sibasis Das
Via e-mail

Your system is infected with the Klez
virus. Norton or for that matter any
other anti-virus software can only
clean/remove infected files from the sys-
tem. They do not clean the registry
entries and Klez is a virus that makes
some entries in the registry, which
makes it possible to re-infect the system.
To eliminate the Klez virus, download

FixKlez from http://securityresponse.syman-
tec.com/avcenter/tools.list.html to clean the
registry entries.

Of keyboards and handycams
I have installed both Windows 98 and

Windows XP in my computer. In MS Word
(Office XP), the numeric keys and other
special symbol keys were not working
properly—they seem to have become
jumbled up. For example, when I press
[#], I get the symbol £. Everything is work-
ing properly in Windows 98 and DOS.
Please suggest a solution. 

My second problem relates to the fact
that I have a handy cam that is non-com-
patible with PC. Is there some way to con-
nect it to my PC so I can view recordings on
my computer, and store and burn the
recordings onto CDs?
Hemant Dwivedi
Via e-mail

Regarding the problem with your key-
board, go to Control Panel and select Key-
board. Here, set your default keyboard to
US instead of UK or any other. 

As for how you can connect your
handy cam to your PC, buying a TV Tuner
card would solve your problem, but first
check whether your handy cam has a
Video Out jack. You can then connect the
Video Out of your handy cam to the
Video In of your TV Tuner card. Finally,
using the software that came with the TV
Tuner card, you can record the movie on
the computer while simultaneously play-
ing the movie on the handy cam.

No scrolling
I have a P-III 500 MHz system, Intel 810 motherboard, 128 MB RAM, a 10.2 GB

hard disk, with Windows 98SE installed. I use Internet Explorer 6. The problem is that
often when I want to scroll through Web pages or even scroll in Word or Excel files,
my computer freezes and I have no other way than to do a warm reboot. I even for-
matted the hard disk, but it doesn't work. Please help.
Kaushik Dutta
Via e-mail

You need to check whether the
problem occurs when you scroll using
your mouse or keyboard. Generally,
the problem will be with your mouse,
so just check the drivers for the
mouse. For a Logitech compatible
mouse, use Logitech drivers only. If
the problem persists, try changing the mouse. If this doesn’t work either, there could
be a problem with the PS/2 port on your motherboard. As an alternative, if 
you have a free USB port, you could try using a USB mouse or even a serial port 
capable mouse. 

FixKlez from Symantec cleans the registry
entries made by the virus
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Floppies don’t work
I have a P-III processor and 128 MB

RAM. Of late, I've been facing a problem
with my floppy drive—whenever I put in
a floppy, it returns a message saying the
floppy is not formatted, and then the
computer stops responding. I have tried
formatting the hard disk. When I scanned
the floppy drive with an anti-virus soft-
ware, it said that the boot record has
changed. I checked the BIOS settings, but
couldn't figure it out. Please help me.
Rocky Smith
Via e-mail

Try using a brand new IBM formatted
floppy diskette in the drive. If the floppy
functions properly, then your previous
floppies are either damaged or are infect-
ed by virus. However, if the new floppy
gives the same error message, then your
floppy drive needs professional servicing.

As for the ‘boot record has changed’
message, it appears if you have enabled
the ‘virus warning’ options in the BIOS.
To get rid of it, you will have to disable
this option in the BIOS.

Missing boot.ini 
By mistake I deleted a file named

boot.ini from my hard disk. I tried to
recover the file with the help of a recov-
ery software, but it was too late. Now
when I boot my PC, I get an error saying
‘invalid boot.ini file. Booting from
c:winnt\’ and then the PC boots nor-
mally. Is this a serious problem? So far I
haven’t faced any problem. I also tried
to search for the missing file in the
Windows 2000 Professional CD but in
vain. Please help me with my problem.
Hitesh Boricha
Via e-mail

To solve your problem, create a text
file in Notepad (or any text editor). Type
the following five lines

[boot loader]
Timeout=1
Default=multi(0)disk(0)rdisk(0)parti-

tion(1)\WINNT
[operating systems]
multi(0)disk(0)rdisk(0)partition(1)\WINN

T="Microsoft Windows 2000 Professional"
/fastdetect

Save the file by the name, ‘boot.ini’
in the C: drive. Now you won’t face this
error anymore.

Problem multibooting
I have an assembled computer with a

P-III 700 MHz processor and 20 GB hard
disk. I had seven partitions—C, D, E, F, G,
H and I, plus J as the CD-ROM drive and
K as the CD-RW drive. C drive runs
Windows 98 and D runs Windows 2000
Professional. I also had Visual Studio.NET
and SQL Server 2000 installed in G under
Windows 2000 and everything was work-
ing fine. The problem began when I
installed Red Hat Linux 7.3. 

Now, booting into Windows 2000
takes about 5 minutes. After booting,
whatever I do, whether it is opening My
Documents or an application, the machine
hangs. It is working fine in the case of Win-
dows 98 and Linux.

I had deleted the H and I partitions to
install Linux (creating Linux native and
swap partitions), but these drives are still
displayed when I open My Computer in
Windows 2000—they are not displayed
in Windows 98 though. 
Bhaskar 
Via e-mail

The reason your system performance
has slowed in Windows 2000 is because
Explorer is trying to access the deleted H
and I drives in the background. 

Check whether the drive types of H
and I are Swap and Ext or FAT or FAT32.
If these partitions use the Swap and Ext
file system, then you need to format
them through Windows 2000 and rein-
stall Linux. This time, be careful about
the type of partition you create through
Linux (it should be FAT or FAT32) and
don’t forget to delete the partitions
before Linux makes new ones for itself.

Here are the steps you need to follow
to install Linux the right way: Select
‘Manually partition with Disk Druid’,
then click Next. Select ‘/dev/hda6’, click
Delete and confirm by pressing Yes
again. Select ‘/dev/hda7’, click Delete
and confirm by pressing Yes. Click New
and type ‘/’ for Mount Point. Select ext3
for File System Type and enter the size
of the partition. Select the ‘Forced to be
a primary partition’ checkbox.

Select the ‘Check for bad sectors’
checkbox, click OK. Under New, select
Swap as File System Type and enter the
size of the partition. Click OK and then
continue with the rest of the installa-
tion process.

FAQs Rear speakers do not work
I have a P4-based system with 

256 MB RAM and an ASUS SL133 moth-
erboard. I also have an ADCOM four-
channel support soundcard. My speakers
are Creative Cambridge 4.1. The speak-
ers work fine with Windows 98. The
problem is with Windows XP—when I
use Winamp and Jukebox 7.0, the two
rear speakers do not function and pro-
duce only a light buzzing sound. With
other software such as Samsung’s media
player or Windows Media Player, there is
no problem. I have tried changing the
advanced settings in the control panel to
quadraphonic speakers and have even
reinstalled Windows XP, but to no avail.
Please give me a solution. 
S. Ragunath
Via e-mail

Since you are facing problems using
Winamp in Windows XP, you should
install the A3D plugin. Installing 
the plugin would enable all the speakers
and you can hear from all of them. 
The plug-in is available at http:// clas-
sic.winamp.com/plugins/browse.jhtml. Simi-
larly you could try this for Jukebox 
7.0 also.

Send your comput-
ing problems to
sos@jasubhai.com or
write to Digit, 

D-222/2, Om Sagar, MIDC, Nerul-400
706, and we may answer it here!

Set the keyboard to US
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Bloodshed Dev-C++ 4
Smaller EXE files
You can ensure smaller file
sizes for your EXE files com-
plied from the C/C++ code.
Go to Options > Compiler
Options. Under the Linker
page, make sure the ‘Generate
debug information’ box is left
unchecked. Also, under Code
Generation/Optimization,
select Best Optimization.

Setup Creator
To create a setup package
which will let others install
your executables, click Tools
> Setup Creator or press [F11]
to  open the Setup Creator
menu. Fill in the details such
as the software title and
organisation name; set other
options such as the back-
ground colour scheme. You
can set the license details
and add the files you intend
to distribute along with their
final location. Finally, click
on Build to create the setup
EXE file. 

Package Manager
When you install additional
Dev-C++ packages such as
extra libraries, you can man-
age them using the Package
Manager utility. The Package
Manager gives you detailed
information at a glance
about the contents of the
package, including file list-
ings, descriptions and ver-
sion details. It also lets you
remove any packages. To
access the Package Manager
within the main window, go
to Tools > Package Manager, or
press [Ctrl] + [F12].

■ tips and tricks

Optimise your EXE files

Setting Classpaths in JCreator v2.50
JCreator is a fast IDE for Java, offering you all the functionality
within commercial IDEs. With JCreator you don’t need to head
off for the command prompt while working with Java—with a
powerful GUI-based interface, everything is a mouse-click away. 
When working with multiple libraries scattered across different

folders, adding all the paths to
the Autoexec file makes it
rather unwieldy. Also, you run
the risk of the program refer-
ring back to an older library,
which is located on the class-
path. In JCreator, you can set
up custom classpaths and pro-
files by clicking on Configure >

Options and selecting JDK Profiles from the list at the left side.
Clicking on New lets you select the directory where the JDK is
located. Then, you can add additional paths and libraries by
clicking on Add > Add Path... or Add > Add Archive... This lets
you define custom paths and libraries, unique to that profile. 

If you work across several versions of the JDK or would like to
create unique profiles of the JDK for different uses, click on the
New button to add in another profile. Remember that the first
profile listed will be the
default. 

You can choose a specific
profile or add a library class-
path for a project without
opening the Options menu.
Click on Project > Project Set-
tings and select a JDK profile.
You can also set up the
required Libraries and JDK Tool
options specific to that project.

Create custom setup files with
this tool

Set the profiles and classpaths

Set project-specific profiles and
classpaths

ClickTray Calendar
Setting alarms
To set alarms, select
Alarms from the list on
the right in the main
window. Under the
Data Input tab, enter
the time of the alarm
and choose between dis-
playing an alarm mes-
sage or starting or
closing a program. If
you choose to display a
message, you can enter the
message in the message field.
If you choose to start or end
a program you will need to
enter the program’s location

or name in the field. Flip
through the other tabs to set
even more detailed prefer-
ences. 

Finally, from the list at the

DEVELOPER TOOLS

HOME
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OpenOffice.org
Turning off AutoFormat
and AutoCorrect in Writer
Writer, the word processor
within the OpenOffice.org
suite, comes with automa-
tisms, namely the auto for-
mat and auto correct
facilities. While these may be
useful, they can also be irri-
tating especially when text is
being corrected or formatted
wrongly. For example, with
the default settings it will
capitalise the first letter of
every sentence, or every URL
is recognised and is coloured
to mark it out as a hyperlink.
To turn off such auto format
and auto correct options, go
to Tools > AutoCorrect/AutoFor-
mat. Under the Options tab,
uncheck the specific options
that you don’t want. You can
choose not to have it auto
correct and auto format while
you modify the text or while
you enter the text on to the
page. To turn back the auto
correct and auto format
options, select the options
that you want enabled. 

Inserting special charac-
ters in Writer
To insert special characters
such as the ® or © or ™ sym-
bols within the document,
bring the cursor to the place
where you want the character
or symbol inserted, and then

go to Insert > Special Character.
Choose Symbol from the Font
list and click on the symbol
you want inserted. 

Locking text in Writer
Writer also has the option
where you can lock in a sec-
tion of the text to prevent it
from being edited or changed.
Select the portion of text that

you want protected, go to
Insert > Section and under the
entry for Write protection,
select the Protect option.
Finally, select Insert. The
selected text is now locked;
you cannot overwrite the text. 

If you would like to safe-
guard the section with a
password, choose the With
Password option, provide a
password and click OK. 

Freezing the panes in Calc
If you would like to see row or
column captions for a longAdding special characters

Lock up your text from here
bottom of the Data Input tab,
select Insert Alarm (this is the
first button from the right).
You should see the alarm 
listed in the alarm text list 
on top. You can then min-
imise ClickTray Calendar
back to the system tray, and
continue working. 

To Do lists
ClickTray Calendar will help
you maintain a comprehen-
sive To Do list, which you
could sort separately by cate-
gory. In the main window,
choose To Do List and set the
categories and tasks. First, 

create a new category by click-
ing on the Add New Category
button on the bottom left. You
can choose an existing catego-
ry by highlighting and check-
ing it. To add a task to the
category, enter the text into
the Text Enter Area window
and click on Add Entry. Final-
ly, click on the OK button. 

If you have finished your
To Do tasks, just click on
Done!

Countdown Clock
If you are driven by time and
would like to have a count-
down clock ticking away on
your desktop, select Count-
down Clock from the list at
the right side in ClickTray
Calendar. In the window that
comes up, you can set the
countdown time under the
Settings tab. Once the time is
set, click on the display tab
and click on Start Clock. Your
time starts now!

Create your own Multimedia Card with FreeCard 2.0
FreeCard 2.0 will give you a
great multimedia card in a
jiffy. To create the card, first
start the FreeCard application.
You can add pictures by click-
ing on the Select Graphic or
Video button (the first button
to the left). You can add
Bitmaps (BMP) or videos (AVI
format). If you choose a

Bitmap, then you can set the way the presentation opens, by
selecting it from the drop down list. To add music, click on the
Select Music button. You can use MIDI or WAVE files. You can
write a personalised message on the text field to the right.
Finally, preview the card by clicking on Run. You can now see
the card that you have created. To send the card, click Send.
You can choose to have it sent by e-mail or through Windows
Messaging or make a standalone EXE file.

Set your daily alarms here

Create colourful multimedia
files instantly

OFFICE
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spreadsheet as you work
through it, you can freeze the
fields that hold the caption. If
it is a single row or column
caption that has to be frozen,
click on the cell just below or
to the right of the row or col-
umn that will contain the cap-
tion. Select Windows > Freeze. If
you have either column cap-
tions or row captions, you can
create a cross freezing by click-
ing on the uppermost left side
cell that does not contain a
caption. For example, in a
sheet with single row and col-
umn captions, you should
choose the B2 cell. 

If you have multiple row
and column captions to be
frozen, you can split the sheet
window. Click on the cell just
below or to the right of the
row or column where you
want to insert your caption,
and select Windows > Split. The
sheet window will be split.
Now you can scroll both parts
of the split window, display-
ing the caption as per your
requirements.

Cell protection in Calc
All the cells in Calc are pro-
tected by default. However,
you can turn off this feature.
To do so, select all the cells in
the spreadsheet. Go to Format
> Cells and select the Cell Pro-
tection tab. To turn off protec-
tion for all the cells, uncheck
the Protected option. Click on
OK to finish.

If you would like to enable
the option, just select the 
Protected option. 

To selectively enable the
protected option, select the
cells you want protected, go to
Format > Cells and select the

Protected option under the
Cell Protection tab. You will
need to turn on the protection
at the sheet level. Select Tools >
Protect Document > Document.
You can provide a password
here to ensure that those fields
cannot be edited.

###….?
You may see ### in a cell
where you have entered some
data value in Calc. This hap-
pens if the value is too large
to be displayed—Calc will clip
it and display ‘###’. To read
the value, you can resize that
particular cell. If the cell con-
tent is text, you can double-
click on the cell. This will

show a red triangle that indi-
cates that the field is over-
flowing.

Saving as text files
You can output the Calc
spreadsheet into an ASCII
delimited text file. Go to File >
Save As and select Text CSV as
the File type. Enable the Edit
filter settings box. Set the
delimiters that you need.

Finally, click on Save and the
text file is generated.

Saving Draw documents as
standard formats in Draw
Draw is the OpenOffice.org
application that lets you work
with the images in your doc-
uments. It saves the images in
the SXD format, which is a
document format. To save the
Draw document as a standard
graphics format, go to File >
Export and from the dialog
box that appears, choose the
graphics format you want the
files saved as; click Save.

Cropping images in
OpenOffice.org Draw
Once the image is inserted
into your drawing file, click
on the image to open the
image toolbar. Within the

image toolbar, select Crop
(the right-most button). This
will open up the Crop menu.
You can add the exact meas-
urements of the canvas that
you want cropped. Finally,
click on OK. 

Microsoft NetMeeting
3.01
Sharing it all
Microsoft NetMeeting also lets
you share entire programs,
which you can access as
though you were at the
remote computer. Go to Tools >
Sharing and select the pro-
grams you want shared. You

can enable total sharing by
selecting Allow Control under
Control. This will allow peo-
ple to access the remote appli-
cation and make changes to it.

Transferring files 
To send a file to another com-
puter on NetMeeting, go to
Tools > File Transfer. This will
open the file transfer menu.
Go to File > Add Files and add
the file that you want sent.
Then click on the File > Send A
File to send the file to the
other computer or highlight
and right-click the file and
select Send A File. To send
multiple files at the same
time, first add all of them to
the menu, then go to File and
select Send All. This will send
all the files to the other 
computer.

Whiteboarding
To create an area for all the
parties to interact, you can set
up a common whiteboard
through Tools > Whiteboard in
NetMeeting 3.01. This will
open the Whiteboard, which
can be viewed and used by all
the parties in the meeting.

Protecting the data within your
cells 

Unhashing the hashes

Share your programs from here

Cropping the image in Draw
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AI RoboForm
Adding your vital stats 
With AI RoboForm you can
save a lot of your confidential
personal data. Click on AI
RoboForm in the system tray
and go to Edit Identities. Here
you can flip through the tabs
to enter details for the current
identity, such as name,
address, password, e-mail
address, credit card informa-
tion, bank account informa-
tion and so on. Since all this
data is encrypted and stored
locally on the disk, it is safe.
Use it for accessing pages that
require registrations and pass-
words, shopping sites and
even for logging into your
Hotmail account!

Protect Your Identity
Since you may tend to entrust
quite a lot of confidential and
personal data to AI Robo-
Form, it makes sense to pro-
tect your identities and
passcards. To do so, choose
Options from AI RoboForm

on the system tray and
then flip over to the User
Data on the Options
menu. Select Set Master
Password and enter a mas-
ter password. This will be
used to protect your iden-
tities and passcards.

Auto filling forms
To auto fill a form, click on
AI RoboForm in the system
tray; go to More on the
toolbar and choose
Options. Under the Form
Filling tab, select Auto Fill
Without Asking. It will fill

forms from a passcard if a pass-
card matches the current Web
page. If no passcards match the
current page, it will fill forms
from the Current Identity. 

Opera 7
Google within Opera
If you are a heavy search
engine user, you will find this
very handy. To run a Google
search on say, SETI, just type

‘g SETI’ in the address bar and
you will immediately link up
to the search result page at
Google.com. To access other
search engine options, go to
File > Preferences and select
Search from the list. You 
can choose from Google,
AllTheWeb, Lycos, Down-
load.com and other search
engines. For each there is a
keyword to be entered before
adding the search term.

Customise and disguise
If you would like to stop open-
ing (or start opening) pop-up
windows or access other
options on the fly, you can do
so by pressing [F12] while in
Opera and set options such as
accepting or refusing pop-up
windows or enabling/dis-
abling Java and cookies as well
as identifying your browser as
IE or Mozilla. You could access
all these options from the
Quick Preferences option from
the File menu.

Mouse Gestures
One really useful feature with-
in Opera is the Mouse Ges-
tures feature—it allows you to
do common tasks within the
browser without clicking but-
tons on the toolbar. For exam-
ple, to access the previous page
in the history, you need to
keep the right button pressed
as you move the mouse to the

left. To close a page, just hold
down the right mouse button
and move down, and then to
the right, tracing an ‘L’. There
are mouse gestures for nearly
all commonly done tasks
within Opera—you wouldn’t
really need to press the but-
tons on the toolbar!

Zoom and full screen views
To zoom in and out of a Web
page, don’t look around for
an option within the toolbar-
just press [+] to zoom into a
Web page and [-] to zoom out
of a Web page. 

Full screen views in Opera
are accessed by pressing [F11],
but here is where the differ-
ence lies: within Opera you
get a totally ‘full’ screen view.
Unlike IE, there are no tool-
bars on top.

Remembering where you
went last
If you abruptly stopped your
last browsing session, Opera
remembers where you went
last. When you restart Opera,
you will be prompted to start

from where you stopped and
resume what you did last.

Netscape 7
Tabbed Browsing
With tabbed browsing being

AI RoboForm’s AutoFill stands by

Set search keywords here

Crashed? Resume effortlessly

INTERNET
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one of Netscape’s better fea-
tures, this is how you can
enable it in case it hasn’t
been enabled. Click on Edit >
Preferences to access the Pref-
erences window. Expand the
Navigator tree and select
Tabbed Browsing. Select the
options you want. You can
open a new tab by pressing
[Ctrl] + [T] and cycle through
all the opened tabs by press-
ing [Ctrl] + [PgUp] or [Ctrl] +
[PgDn]. 

Searching from Netscape
The default search engine 
for searching from within
Netscape is Google, but you
can set another search engine.
Go to Edit > Preferences and
select Internet Search. You can
specify the search engine that
you want to work with from
within the drop down list.
Finally, click on OK to set the
preference. If you enter a term
on the Address bar that cannot
be resolved into a Web page,
Netscape will now automati-

cally search for it in the default
search engine.

Enabling Quick Launch
If you have not configured
Netscape to load at startup,
then enabling the Quick
Launch option will give you
fast loading times. To enable
Quick Launch, click on 
Edit > Preferences and select
Advanced from the list at the
left. In the Advanced menu,
under ‘Enable features that
increase performance’, select
Enable Quick Launch and
select OK. After a reboot, you
should see Netscape loading
faster. 

Set in the search preferences

VirtualDub
Compressing Video
If you have large MPEG files
and would like to see them
converted into smaller sizes,
you can choose to re-
encode them into the AVI
(Audio Video Interleave)
format. The best AVI codec
is the DivX codec series.
However, you would need
to have the DivX codec
installed in your computer.
You can also use the Indeo
codecs, which give good
results.

Open the file in Virtual-

Dub and go to Video > Com-
pression. The options listed will
be the ones for which the
codecs are present in your
machine. Choose the DivX
codec, which gives the ideal
balance between file size and
quality. Click on OK; this
brings you back to the main
screen. Click on File > Save as
AVI and save the output file.
The conversion then starts and
you can monitor the progress
of the encoding from the Vir-
tualDub Status indicator.

If you are using the Indeo
AVI codecs, then in the Video
> Compression screen, you will
need to specify the video
compression quality—choos-
ing a value between 80 to 90
per cent should give you
good file sizes with little loss
in quality. Lower settings will
affect the quality, but will
give you lower file sizes. You
will also need to enter the
value for a keyframe inter-
val—this will ensure quick
fast-forwards and rewinds
within the video file. A lower
value here is recommended.
Select a value of 85, which
will give you good results.

Filters
VirtualDub comes with some
very useful filters. You can use
these to resize or realign your
video files, crop or integrate

special effects such as motion
blur or smoothing into the
video files. The filters are
accessed from Video > Filters.
For example, if you would like
to have still smaller file sizes,
you can resize the video. To
resize the video, open the
source file. Then click on Video
> Filters and then click on Add.
This will open a list of avail-
able filters. Choose 2:1 Reduc-
tion (High Quality) and click
OK. You can add more filters
to the list in the same way.
Then choose your compres-
sion settings and save as an
AVI file. You select the order
in which you want the effects
applied.

dBpower AMP Music
Converter
Right-click!
To start using dBpower AMP,
all you need is to have the plu-
gins for the format into which
you need to encode your
audio files. Once you have

Encoding with the Indeo codecs

Using the filters in VirtualDub

MULTIMEDIA
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them installed, you can start
right away. Within Explorer,
locate the file that you want
encoded. Then right-click and
choose Convert To. You
should see the listed options
for the audio formats support-
ed. Select the format of your
choice and click on it. This
will bring forth the Options
menu where you can set
parameters such as encoding
quality and type. When you
have entered the options,
click on Convert to start con-
verting the file.

Audacity 
Removing noise
To remove excess noise or
hiss from the audio file, first
select a few seconds of hiss
(at the beginning or the end
of the clip) and then click on
Effects > Noise Removal. Click
on Get a Noise Profile. This
will generate a profile of the
frequencies you need

removed from the file. Final-
ly, select the audio section
from which you want the
unwanted sound artefacts
removed, go to Effects > Noise
removal, and select the
amount of audio you want
filtered. Experiment with
how much sound you want
removed—too little and the
artefacts remain, too much
and the audio portions may
be lost. Finally, click on
Remove Noise. That is it.
Audacity will start cleaning
the audio file.

ZoneAlarm
Program control
Clicking on Program Con-
trol lets you set security
levels for programs that
may access the Internet
from your computer. Click-
ing on the Main tab lets
you set broad-based rules;
set Medium here. 

To set specific rules for
each program, open the
Program tab—here you will
find listed all the programs
that have tried to connect.
You can also add any pro-
grams here that you would
like to allow access to. 

These could be your brows-

er, mail client, or any other
specialised programs. For
example, if you use file-shar-
ing programs over the Inter-
net, you can add the file name
here through the Add option,

and set the parameters for it.
You can choose between
denying access, to allowing
outright access or settle on the
program asking for permis-

sion every time it wants to
connect.  

Server rights
ZoneAlarm may alert you
about granting server rights
to certain programs—this is
the case with chat and file
transfer software that allow
for real time conversations,

such as Yahoo! or MSN or
mIRC. You can assign these
rights from Programs Control
under the Programs tab
panel. ZoneAlarm continu-
ously monitors the activity of
the programs and hence pre-
vents unauthorised access.

Alerts
If you have chosen to view
alerts while installing Zone
Alarm, you will be alerted as
soon as a program tries to con-
nect to the Internet or net-
work. The alert will specify
which program is trying to
connect, and you can choose
to allow or disallow it. You can
ensure that programs that you
frequently use, such as your
browser or mail client, can be
allowed to establish such con-
nections. There may be other
programs that may try to

PC Inspector File Recovery
This is an indispensable tool for those times when you delete a
file, only to realise that you need it back! Relax, you are forgiv-
en—you can use this excellent file recovery tool

First, start PC Inspector File Recovery. You can choose
between recovering lost files, finding lost data, and finding a
lost or inaccessible drive. Select Recover Deleted File. Then,
within Select Drive, click on the Logical Drive tab and choose
the drive on which your data was located, then click OK. Within
the Explorer-like interface, choose Deleted and locate the folder
where the file was located. The deleted file will be indicated in
green and alongside you would be able to view the status of
the deleted file. Right-click
on the file and choose to
Save To… to save it. You
would need to save it on
another drive (physical or
logical). Choose the loca-
tion and click OK.
Depending on the disk
and the deleted file, you
should have a working file
recovered.

Cleaning up scratchy audio files

Recover those deleted files

Set Program Control from here

SYSTEM TOOLS
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access the Internet—some
may be legitimate, but there
may also be some spyware
programs. Use your discre-
tion before allowing them to
connect. Clicking on the
More Info button at the 
AlertAdvisor connects to
ZoneLabs online, and gives
more information regarding
the alert.

Full stop
If you would like to stop all
Internet connections, except
inbound and outbound, click
on the red Stop button—this
will stop all connections at
once. The Internet lock can be
configured from the Program
Control screen, in the Main
tab. This is obviously a drastic
measure—you would need to
use this in the event that you
are certain that a Trojan or
some major security loophole
exists within your computer. 

Temporarily stepping
down security
You can step down the secu-
rity if your programs tend to
conflict with ZoneAlarm.
This may happen if you use
software such as VNC or
PCAnywhere that let you

control a remote computer.
But be sure to restore it later!

PGP Freeware
Creating your key pair
Encryption with PGP requires
that you generate a public and
a private key. The public key is
distributed to everyone so that
they can encrypt and send you
secure messages. The private
key is kept confidential and is
used to decrypt the messages.
After installation, PGP will
prompt you to create your key
pair. To create additional keys,
click on PGP on the system
tray and choose PGPKeys. To
create a new key pair, go to

Keys and select New Keys. This
will open the Key Generation
Wizard. Choose Expert if you
wamt to specify additional
parameters such as the key size
and key type. Clicking on Next
will prompt you for a
passphrase, and finally, you
can generate the key pair.

Distributing the public key
You should distribute your
public key so that people can
send you securely encrypted
messages. Simply right-click
on the key and choose Send To
> Domain Server to send your
key. To send your key by 
e-mail, choose Send To > Mail
Recipient. 

Internet 
Explorer 6
Image toolbar
The Image toolbar
pops up when you
hover your mouse
over certain Web
page images. It lets
you save/print/
e-mail pictures and
also opens up the
My Pictures folder. If
you find the toolbar to be a
nuisance, you can disable it
by right-clicking on the tool-
bar and selecting Disable
Image Toolbar. 

You can later restore the
Image Toolbar through Tools >
Internet Options > Advanced.
Scroll down to the Multimedia
section and select the Enable
Image Toolbar option. The
next time you launch IE, you
will get the Image Toolbar.

Enabling/disabling auto
resize
The Auto Resize function in
IE 6 resizes large images to fit
into the browser window so
you no longer need to scroll
horizontally or vertically to
view the file. This is enabled
with the default install, but
you can can enable/disable
the function from Tools > Inter-
net Options > Advanced. Within
the list, scroll down to the
Multimedia section and

select (or deselect) the Enable
Automatic Image Resizing
option. 

Deleting cookies and 
personal information
You can get rid of tiresome
cookies through Tools > Inter-
net Options. Under the Gener-
al tab, locate Temporary
Internet Files and click on
Delete Cookies. 

If you use IE6’s AutoCom-
plete feature you may end up
with IE hanging on to much

of your confidential informa-
tion. To erase this informa-
tion, go to Tools > Internet
Options and click on the Con-
tent tab. Click on Clear Forms
and Clear Passwordst

Alerts warn you about inbound
and outbound connections

Creating the key pair

IE6’s Image Toolbar

Clearing out personal data from
the AutoComplete feature
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Let’s face it. As game technology currently stands, artificial intel-
ligence (AI) is an oxymoron. Small wonder then, that avid
gamers are forced to seek greater challenges in the online

world. Once you’ve mastered the single-player experience, the only
option left is to test your mettle against human opponents.

However, there is a catch—playing resource-hungry games
online requires a fast connection (read broadband). Let’s glance at
the most critical factors that affect any network connection—ping,
latency, and bandwidth. Ping (often confused with latency) is the
amount of time it takes for a packet of data to travel to the server
and back to your computer. Lower the ping time, faster the con-
nection. Latency is defined as the response time, that is, the time it
takes between you giving a command (pressing the trigger) and its
execution (firing the gun). It’s possible to have high latencies even
with very low pings (if the server is overloaded with intensive appli-
cations). Finally, higher the bandwidth, faster the connection. How-
ever, if you try and connect to a server overloaded with network
traffic, you’ll still get very low pings.

So where does that leave us poor souls in India? Broadband  is
still a distant gleam on the horizon. The only course of action is to
hunt for local servers where the lag (the time between giving a
command and seeing it executed) won’t be crippling, or use the
LAN provided by the cablewalla to host multiplayer sessions.

Indian Communities
As far as the gaming scene in India is concerned, the only Internet
server we have is at www.kawabonka.com. This lone server satisfies the
needs of our desi hardcore gamers. Kawabonka runs Quake III Arena
and Counter Strike servers on a regular basis. Relatively obscure games
such as Unreal Tournament 2003 or Battlefield 1942 are set up on
demand. The main hurdle in hosting more games is their complete
lack of availability and gamers’ reluctance to buy legal copies of
games. As Ricky Kapur, who manages the Kawabonka server, says,
“The problem is mainly that enough users don’t own legal copies of
the games, usually required to play online. Therefore, setting up a
server is quite pointless if only four to five people have a legal copy
of a game! Add to this the fact that a lot of games don’t arrive at all
in India!” Bleak, indeed.

Since Kawabonka has a very limited online presence, it’s up to the
local cybercafes to encourage multiplayer gaming and hopefully make
gamers move on to Internet gameplay. Two notable examples are
Skirmish in Mumbai, and Surf’s Up in Pune. These cybercafes hold
tournaments on a regular basis and are breeding grounds for multi-
player talent in India.

The popularity of team-based games such as Counter-Strike has led
to the formation of groups or ‘clans’, as they’re called in gaming parl-
ance. Clan members always stick together and take part
as a team in all games that allow it. Although
meeting in real-life is pretty hard to do
because of the geographical 
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separation between players, online
meetings occur on a regular basis.

If you were to attend one such
clam meeting, you’d probably find
that the population is exclusively
male—barely 0.5 per cent of the
registered members on Kawabon-
ka. com are female, out of which
only a couple might have actually
played a game online. Ricky knows
a grand total of one female who
plays multiplayer regularly.

Hard Facts
The hardware required for hosting
a multiplayer game varies accord-

ing to the game that is played, the
geographical distance between
users, and the number of players
expected to join. This last factor is
the most important one to consid-
er when you’ll host a multiplayer
session. As an example, a typical
Quake III Arena game involves
around eight players over a LAN. In
such a case, the player with the
fastest PC hosts the server and plays
the game. There’s no need for a
dedicated server (a machine that
only hosts a game and does not
play it), as the connection type
(LAN) and small number of players

are good
enough for
the server to
handle frags
with no lags!

There are vari-
ous connection meth-
ods, and each of them
can be used to play multi-
player games, provided that the
specific game supports such 
connections:
LAN: This is probably the most
widely used method of playing
multiplayer games. Internet
providers have begun to offer 24x7
connectivity to users through the
means of a LAN controlled by a
server. This has brought networks
to residential areas—hotspots for
gaming.

A LAN is located in a geo-
graphically small area, a few
square kilometres at the most, but
typically inside a building or
group of buildings. This not only
provides  great access speeds (up
to 100 Mbps) but also increases
the social interaction. A great way
to play multiplayer and have bus-
loads of fun is to host a BYOCLP
(Bring Your Own Computer LAN
Party). The idea is simple: call
everybody you know who has a
PC—more the merrier. Get hold of
a few network cards, an 8-port
hub, and you have a LAN inside
your own home. 
The Internet: Next to LANs, this
is the most popular multiplayer
game type. You need to have an
Internet connection to be able to
join online servers, and a fast con-
nection, at that. This rules out
most of the gaming public
in our country. The only
way that people with
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Click on the Multiplayer menu in
Quake III and click on Create to go
to the server setup screen.
Choose a map to play in. Scroll
down to a map of your choice and
click on it. Next, choose the game
type and click Next.

In the next
screen, select the
number and type of
players that will join
your game. Open
indicates that the slot
is reserved for a
human player, while
selecting Bot will
make a computer-
controlled oppo-
nent join the battle.
You can adjust the difficulty of the
AI through the Bot Skill option.

The list on the right sets the
server parameters. Frag Limit and
Time Limit set the conditions for
ending each round. A Frag Limit of
20 tells the server to end the game
once a player achieves 20 kills,
while a Time Limit of 20 will end
the game after 20 minutes. Setting

any field to zero removes that limit.
The Dedicated flag controls

whether the server can take part in
the game. A dedicated server, once
started, switches off the graphical
display and merely hosts the game.
This method greatly increases the

performance of
servers running on
slow machines, but
you’ll have one less
PC to play with. Set

Pure Server to off to ensure com-
patibility with all machines, then
choose a name for your server in
the Hostname field. If you are play-
ing in version 1.32, disable the
anti-cheat program, Punkbuster. It's
not required for LAN games. Click
on Fight, and you’re ready to 
rumble!

Set up your own Quake III Arena server
over a LAN

You can either set up a
dedicated server (above)

or otherwise enjoy a
normal CTF game (right)

IMAGING: Atul Deshmukh, PHOTOGRAPH: Jiten Gandhi



modems can hope to
get workable speeds is to

connect late at night to an
Indian server (such as

Kawabonka), or a high-speed
server based in Singapore or Hong

Kong.
To play Internet games, you need to

be online before you fire up your game.
Once inside the game of your choice, select

the Multiplayer option, then choose TCP\IP and
then Internet. Quite a few games also offer an Inter-
net option straight from the Multiplayer menu, so
you’ll need to select that instead. It’ll take a while to
search for online servers and connect to them, so be
patient. 
Dial-up Connection: This method is almost dead
now. It’s limited to two
players and is also the slow-
est method, and often ends
in failure. The procedure
involves setting up a dial-
up server via the Game
Type in the Multiplayer

menu of the game. The
game in the second
machine then dials

the server and estab-
lishes the connection. The
speed is directly dependent
on the geographical dis-
tance between the players;
with increasing distance, the quality of the connec-
tion will fall.

The Software Aspect
Once you have the hardware in place, there are quite
a few tools available that make life a lot easier as far as
setting up and joining game servers is concerned. One
such program is GameHost. It specialises in supporting
the most popular First Person Shooters, and makes set-
ting up servers for these games a snap. It takes care of
all the command-line parameters and complex con-

sole commands, presenting them in a graphical for-
mat that’s easy to understand. The latest version

adds support for Return To Castle Wolfenstein, in
addition to the ones it already supports—

Quake, QuakeWorld, Quake II, Quake III
Arena, Hexen II, Half-Life, Sin, Starsiege

Tribes and Unreal Tournament.

The server component of GameHost requires at
least Windows 2000, due to its improved network
handling over previous versions of the OS. The pro-
gram runs as a service, which means that it starts
automatically with Windows, without requiring you
to log on to the machine.

On the client side, the most popular software
used for connecting to game servers on the Internet
is GameSpy Arcade and GameSpy 3D, which
between them, support dozens of the most popular
games. The tools, offered by the GameSpy Network,
take upon themselves the job of scouring the Inter-
net for all servers that are currently hosting the game
of your choice, presenting the results by number of
players, server ping time (lesser the ping, faster the
server), game type, and game map. You can also chat
and exchange files with other users, add them to

your buddy list and invite
them for game sessions, pro-
viding the full functionality
of an instant messenger.

Users of the GameSpy
software can even perform
voice chats with each other,
although this requires you to
pay a small fee and subscribe
to the service. The software
can also act as a download
manager. 

Another tool that multi-
player gamers will find useful
in the course of their online

exploits is a Log Analyser. Applications such as
Q3Log provide a stylish interface to analyse the logs
created by the game server and create an HTML page
with player rankings. It supports just Quake III Arena
and Return To Castle Wolfenstein, but is very good at
what it does.

Futurama
Practically every game released nowadays features

extensive multiplayer support. In developed coun-
tries, multiplayer gaming has begun to assume even
more importance than the single-player experience.
In India though, we still have a long way to go. Until
we have broadband, it looks like the only platform
avid gamers without high-speed access will have to
display their talents would be at competitions hosted
at college fests and cybercafes.

BADRI NARAYAN
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If we ran it 
(kawabonka.com) 
to make money, we
would have been
forced to shut it down
in the first three
months itself  
RICKY KAPUR

KAWABONKA.COM ”
“
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Flip a coin enough times, it is said, and
it is likely to land on its edge. What-
ever. Grand Theft Auto III (GTAIII) is a

great game and we want you to enjoy it to
its fullest. Read on to find out how.

Most Wanted
You can customise the game to your
music—in your GTAIII game folder, look
for a subfolder called MP3 and place your
favourite tunes within. Start the game and
scroll through the radio stations until you
get to the last one. This one will play your
personal MP3 numbers.

Flambé
To get a flame thrower at your hideout,
complete at least 20 fire-fighting missions
on an island.

A runaway
secret
Go to the airport
and go down the
runway that the
airplanes do not use.
Walk or drive until you
get to the cliff, then drop
down the cliff to find your-
self a speeder!

Easy money
Get yourself two tanks; either by means
nefarious or by cheating. Then simply ram
one tank with the other and watch your
funds go through the roof.

Scream fire
Steal a fire truck to begin the Firefighter
mode. When the game offers you a fire to
put out, press [F1] to start a replay and press
the key again to cancel the replay. The fire
will be immediately extinguished, no skin
off your back!

Mad Max
A Vigilante mission will start when you
have acquired a law enforcement vehicle.
To make your targets much easy to subdue,
drive close to the vehicle in question, and
press [Esc] to bring up the Options menu.
Then choose Resume Game and your tar-
get will stop its vehicle and get out, making
it much easier to kill.

Nursing a home
Complete 35 ambulance missions to get a
heart at your hideout, 70 such missions
will award you with an adrenaline pill at
your pad, while reaching level 12 during
an ambulance mission will get you the
infinite run cheat.

Taxi driver
To unlock The Borgine Taxi, a new faster
vehicle, complete at least 100 taxi missions.

Game with a view
Drive a 4x4 up to the highest land point in
the game, the mountains in North Shore-
side Vale, for a breathtaking view of the
entire city. Sunset and sunrise escapades
are especially rewarding.

Glide to be of service
Use the Dodo to get an aerial perspective
on Liberty City. The Dodo is a small air-
craft with stripped wings; it acts as a glid-
er and is the only means of getting
airborne within the game. It can be found
at the airport hangar in Shoreside.

arcade ■
■ tactics

MARCH 2003

■ tactics

A criminal guide to having a good time

GUNSGUNSGUNS 
IFIWEREARICHMAN 
GESUNDHEIT 
TURTOISE/TORTOISE
ITSALLGOINGMAAAD
NOBODYLIKESME

WEAPONSFORALL

CHITTYCHITTYBB
MOREPOLICEPLEASE

NOPOLICEPLEASE
GIVEUSATANK
ILIKEDRESSINGUP

BANGBANGBANG

Gets you weapons 
Gets you money 
Gets you health 
Gets you armour 
Pedestrians go crazy 
Pedestrians are out to
kill you
Pedestrians carry
weapons
Cars fly around 
Your wanted level rises 
Your wanted level falls 
A tank is spawned 
You can change your
avatar
Cars blow up around
you

Modus Cheats 
(when operandi fails) 

To enter these codes, pause the game by 
hitting [Esc] and then type them out

150



151

arcade ■
■ reviews

MARCH 2003

➜

Life is a drag. You rob a bank, make a
clean getaway and are promptly shot by

the hitherto love of your life. Money comes
first, honey. Life then reveals its Janus face,
arranges an accident and offers a chance to
reprieve your days of sin in the big city. 

And sinning is such sweet sorrow: break
into vehicles, more than 50 of them, rang-
ing from sports cars to ice-cream trucks,
from boats to buses. Listen to some 3 hours
of great music (from classics to rap; you can
even import your own MP3 collection into
the game), as you take on the cops, clean
out the lesser, wannabe-scum, perform
stunts, rob old ladies at gun point and

harass girl scouts.
Ok, so no girl-scout-
teasing, but you get
the drift—if it’s
naughty and nasty,
you can do it. All in a
days work.

Grand Theft Auto
III is set in Liberty
City, a sprawling
hive of no-goods
that offers a narra-
tive at once both lin-
ear and open-ended. Follow the central
story to its logical end or shrug it off to take

on missions that call on you
as a vigilante cop, a fire-
fighter, a cab driver, a hit-
man or just cruise around
for hidden bonuses and
packages. The music and
voice-acting is top-notch,
the AI lets you have a good
time and the missions—
more than you can shake a
very large stick at—are
always a blast. If you have
nothing better to do for the

next few weeks, pick up this game. Strike
that, just pick up this game, life can wait!

Grand Theft Auto III 
Everything mommy wouldn’t approve of

MEET INTERESTING PEOPLE: and
then rearrange their faces

Genre: Action ■■  Developer: Rockstar Games ■■  Distributor: e-xpress Interactive Software Pvt Ltd ■■  Phone: 022-28870017 ■■  Web site: www.rock-
stargames.com/grandtheftauto3/pc/main.html ■■ Price: Rs 1,499 ■■  System requirements: Pentium 450 MHz, 96 MB RAM, 16 MB T&L AGP/PCI
video card ■■ Rating: ★★★★ ✩✩

Hitman 2: Silent Assassin
Nice shot

There is nothing like a few days, close to
God, to get an assassin back into busi-

ness. Hitman 2 sees Agent 47, our angel of
death, give up cosy living as a gardener in
a monastery and retake the streets and a
life of crime. A born again. 

The game is an immensely satisfying
stealth-shooter that eliminates many a
problem that plagued the first part. The
sequel comes packed with a gorgeous
engine, well-designed levels, better AI
and controls (although you still cannot
jump), and tools aplenty to get your dirty
job done. The ingame music merits a spe-
cial mention—rendered by the Budapest
Symphony Orchestra, it integrates with
great effect, gelling with both, the locale
you are in and the pace of action you are

facing. The gameplay is not all stealth,
you can Rambo your way through
most of the missions, finishing in
minutes what stealth would have
required hours to do. The cherry on
the pudding lies in sneaking though—
guns-a-blazing kills the essence of the
title reducing it to an ordinary first-
person shooter. Another reason to
sneak is the AI: while enemies are
morons once you enter a gun fest,
they are excellent watchdogs. It is
almost as if the action elements were
added as an after-thought to the
stealth layer to make the game more
accessible to casual gamers. Consider
this title if stealth gets you high. The
action elements might disappoint.

Genre: Action ■■ Developer: Io Interactive ■■  Distributor: Milestone Interactive Software Ltd ■■  Phone: 022-28381614 ■■  Web site: www.hitman2.com
Price: Rs 999 ■■  System requirements: Pentium III 550 MHz or equivalent, 128 MB RAM, 16 MB DirectX 8.1 compatible video card
Rating: ★★★ ✩✩ ✩✩

BATHING WITH THE FISHES: The game has some
very interesting, beautifully crafted locales
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‘Afirewall system is more than just a
product’, so goes the title of Chap-

ter 11. This line holds particular rele-
vance for the general masses who tend to
think of firewalls as a one-stop security
solution against intrusions, viruses and
what-have-you.

Firewall Systems is a thorough book. It
begins with a chapter explaining why IT
security is imperative and how firewalls
help. This is quite important to under-
stand where exactly a firewall reaches its
limitations and needs to be supplemented
by other means. ‘TCP/IP Technology for
Internet and Intranet’, an excellent chap-
ter, makes good reading even for those not
necessarily interested in the nitty gritties of
firewalls. It covers TCP/IP architecture,
addressing, routing and common proto-
cols—things anyone in the IT business can

ill-afford to ignore.
The reasonably clued-in

will find much familiar materi-
al in this book. Chapter 5, ‘Ele-
ments of a Firewall System’
contains information on all
common types of firewalls,
including packet filters and
proxies. The book also explains
the applications of different
kinds of firewalls and how they
can be made to work for vari-
ous environments. Firewalls
are intrinsically tied into TCP/IP and by
association, to everything else, including
applications. While it would be beyond
the scope of a single book to cover all
these topics, this one goes some way to
bridge the gaps.

The latter half of the book gets quite

technology and process-heavy.
Chapter 13, ‘Secondary Issues
Relating to Firewall Systems’
stretches a full 86 pages and covers
everything from Loggin, evalua-
tion and certification and auditing
to Denial of Service attacks, virus
scanners and personal firewalls.
The final chapter covers theoreti-
cal topics that define the very
basis of a firewall system or prod-
uct. While not an easy read, it

does go on to explain where defects
can show up in a system and how.

Firewall Systems is a very complete
book, with much theory as well as practi-
cal usage. It is, however, not for the faint
of heart and should be considered essen-
tial reading only if one is serious about
enterprise-class firewall implementations.

Publisher: IDG India ■■     Author: Norbert Pohlmann ■■     Distributor: MITP-Verlag ■■  E-mail: info@vmi-buch.de ■■  Web site: www.vmi-buch.com
■■  Price: Available by order (approx Rs 1,951)
Rating: ★★★★ ✩✩

Firewall Systems
More than meets the eye

You know the story. The Great Depres-
sion, hand-to-mouth existence. Along

comes an offer you can’t refuse and of
course, you don’t. So what if it involves
working for the Mafia with a baseball bat in
hand and a Colt in your waist pocket? Peo-
ple die everyday, the trick is to ensure that
you are not one of them. Mafia excels in
bringing a coherent and intriguing narra-
tive of Tommy Angelo: a taxi driver’s rise to
fame and fortune, though gory.

Set in the late 1930s and played
through a series of flashbacks, the game is
set in the believable city of Lost Heaven—
lost between the violent acts of rival mob
bosses, Salieri and Morelli. Lost Heaven also
plays host to a living ecosystem of cars,
rival gangs, petty thugs and a bought police
force. Chalking your meteoric rise to the
ranks of the respected are some 60 authen-
tic cars that you can drive and shelter in
Salieri’s backyard—the den you call home.

Missions range from playing the cab
driver and ferrying passengers, collecting
protection money, assassinating, getting
out of hairy shootouts and taking part in a
vintage car-race. The experience offered by
the variety of missions is always intriguing:
forcing you to retry a scenario ‘just once
more’, even though the process involved
can be a drag. This is due largely to scripted

events—a certain party will rise from the
dead to shoot you just because it was so pro-
grammed. A car will burn rubber at more
than 60 kmph even though you have shot
all of its four wheels, since the mission calls
for a car chase. This leaves little room for
improvisation and imparts a feeling of
being led around the game by its designers.
Two more negatives remove from an enjoy-
able experience—cops will stop and fine
you for running red lights and speeding
with irritating regularity and fellow gang
members (not too bright, god bless them)
will frequently walk into a shower of bullets
and promptly die of too many holes.

But these issues are just passing clouds
under the fresh canopy of blue and light
that Mafia brings to the PC. In the end the
game draws from its superlative narrative,
surpasses its flaws and comes out as tri-
umphantly fun, captivating, and a must-
play experience.

KILLROY WAS HERE: And he left his mark

Genre: Action ■■  Developer: Illusion Softworks ■■  Distributor: e-xpress Interactive Software Pvt Ltd ■■  Phone: 022-28870017 
■■  Web site: www.mafia-game.com ■■  Price: Rs 999 ■■  System requirements: Pentium 500 MHz, 128 MB RAM, 16 MB T&L AGP/PCI video card
Rating: ★★★★ ✩✩

Mafia
Goes ahead and makes our day
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Everyone earns themselves a sobri-
quet at one point or the other in
their life. Tony Blair has lately

earned the unflattering US Foreign Min-
ister tag and Billy Bob Thornton is serial
groom in waiting after his fifth divorce.
Jiten Gandhi, our in-house photographer
earned himself the nickname Jiten Jholer
during his recent trip to the north. [Jholer,
Mumbaiya Hindi, from Jhol karma: manip-
ulate the situation to your advantage.]

Now don’t get us wrong, Jiten Bhai, as
we call him, is as sweet and unassuming
as they come. But he is also a wandering
trader—pick up some candy from some-
one’s table on the way to the
Photo Studio, exchange it with
someone for a cigarette which in
turn will serve as rental for the
headphones he borrows as a
prop from someone else. He is
known to pull out the most
amazing things from his multi-
pocketed photographer’s jacket.
But on the trip to the capital to
distribute the Zero1 trophies, he
astonished his fellow travellers
Bhavesh Thakor, the Digit mar-
keting manager and Shubendu
Nath, our brand manager, with
his tricks. 

Now travelling with Jiten
Bhai is not easy, the man keeps
disappearing for short periods at
the sniff of a photo opportunity. On the
Rajdhani Express that was carrying the
trio to the capital, food was a problem.
Shubendu, is referred to as the black
hole—any food within a 5 feet diameter
is promptly sucked into his central grav-
ity. Bhavesh, a newly married weight
watcher was more than glad to place his
food in Shubendu’s orbit to watch it dis-
appear. A little later, they realised that
Jiten Bhai had done the disappearing act
again. He returned a while later with a
friendly waiter and asked them if they
needed anything extra and within a few
minutes, there were extra bowls of dahi,
ice cream, soup and what have you. 

Around tea-time, pangs of hunger
struck Shubhendu again. When asked
what he would like to eat, he replied,

chicken tandoori. It seemed unlikely that
he could get the bird, considering that
this was a train and it was around tea-
time. But Jiten bhai, as usual, did his van-
ishing act and appeared a few moments
later with a waiter and chicken tandoori
in tow!

But the best trick that Jiten bhai
pulled was after the trio reached Delhi.
After the round of visiting the Zero1
award winners and distributing the tro-
phies, Bhavesh decided to catch up with
some friends in Delhi. He made plans to
meet Jiten and Shubhendu back at the
guest house and go for dinner—what

Bhavesh had forgotten was that he had
the keys to the guest house. So our in-
house photographer and the brand man-
ager sat outside the guest house in 6
degrees of the Northern winter waiting
for Bhavesh to return. Bhavesh, on the
other hand was being forced by his
friends to stay for dinner, so he calls up
the guesthouse, still unaware of the fate
of his colleagues and obviously, no one
picked up the phone. Thinking that
they’d left for dinner without him, he
proceeded to dine with his friends. Mean-
while, Shubhendu was making calls to his
friends from the local PCO as Jiten Bhai
wandered around the area. When Shub-
hendu was done, Jiten Bhai led him to an
open ground where a table was spread
out and laid with chopped fruit and

drink. Apparently, Jiten had befriended
the local fruit vendor and coaxed him to
lay out the spread from his own stock of
fruits. After satisfying their pangs, the
vendor invited them over for the next
day and promised to cook them some
mutton! How Jiten Bhai pulled this off,
remains a secret! But it sure earned him
the nickname!

IIT Techfest
This year at the IIT Mumbai Techfest, of
which Digit was the official Techfest
magazine, our writer Srinivasan Ramakr-
ishanan and copy editor Mitali Parekh

were sent out to cover the event.
Now IIT is the place where all
the engineering students want
to go—its lush lawns, spacious
lecture halls and ultra-cool labs
are stuff that engineering dreams
are made off. Now Srini and
Mitali aren’t really the best of
tag-team duo. One is a verbose
chronicler of technology; the
other is scissor-happy with
words. One is a technology
enthusiast, the other a nature
lover. One is speaks in garbled
gigahertz, the other in… you get
the point!

According to reports, Srini
was like a wide-eyed six-year-old
in Disneyland, running to each

event, cheering the robots at Yantriki,
dropping his jaw at the workshops and
guest lecturers. Mitali, on the other hand,
sat in the lawn and wondered how much
of the countries cerebral resources was
going to be exported to the United States
come June-July. Meeting the IIT faculty
was no less than meeting an A-list
celebrity for Srini, Mitali couldn’t under-
stand why he was making all the fuss
over a science/math teacher—subjects
she didn’t particularly take to in her aca-
demic years. 

But the Aibo Soccer match had both
techno-geek Srini and dog-lover Mitali
clapping in glee. Stranger things have
bonded people together—we didn’t par-
ticularly mind as long as they got the
Firsthand story out on time! 

FFiieelldd  ddaayy
Of hidden talents and uncommon interests

ILLUSTRATION: Mahesh Benkar
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Charge it! Submitted by: Rahul Garg

Taken from the Net

Oops! Taken from the Net

Wonder what
Linus Torvalds
thinks of this
Submitted by:
Vivek Gite

Highlight the lighter side of computing. Mail your contributions to: Backbyte Digit, Plot 
D-222/2, TTC Industrial Area, MIDC, Shirvane, Nerul, Navi Mumbai 400 706 or e-mail us at
backbyte@jasubhai.com

Your chance to
bite back!

Taken from the Net
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